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Welcome
The CPHYXpress application is used to create signals as per C-PHY standards.

 

 

■ Generates waveform as per C-PHY standard.

■ Programmable signal generation.

■ Generates different types of waveforms like Low Power (LP), Hugh Speed
(HS), and Low Power- High Speed (LP-HS).

■ Programmable Rise-time and Fall-time values.

■ Easily insert periodic jitter and random jitter to CPHY HS waveforms.

■ Embed the channel effect using S-Parameter and Filter files.

■ Configure different HS burst timing configuration.

■ Adds Sine noise in waveform using LP mode impairments.

■ Waveform creation using Batch mode for stress testing.

■ Enables Master-Slave configuration of AWG to support three waveforms
simultaneously.

■ Enhanced waveform generation for receiver margin testing.

■ Generate three levels of signal from AWG.
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This software can be run in the following ways:

■ Install CPHYXpress on a PC (through SourceXpress) and connect to
AWG70002A series arbitrary waveform generator via LAN connection.

■ CPHYXpress integrated with AWG70002A series arbitrary waveform
generator (CPHYXpress installed in the AWG).

Welcome  

x



Introduction

Related Documentation
The following information is available as part of the CPHYXpress documentation
set.

Item Purpose Location
Help Application operation and User

Interface help
Application Help menu

PDF of the help Printable version of the
compiled help

PDF file that ships with
CPHYXpress software.
Downloadable from
www.tek.com

Abbreviation and Conventions
The online help uses the following conventions:

■ When steps require a sequence of selections using the software interface, the
">" delimiter marks each transition between a menu and an option. For
example, File > Save.

■ DUT refers to the Device Under Test.

■ The terms "waveform" and "signal" are used interchangeably.

■ The term AWG refers to a Tektronix Arbitrary Waveform Generator.

Table 1: Text Conventions and abbreviation

Icon Meaning
Bold Used to indicate selections on the user interface (such as options, buttons, and

command names). For example,

■ Click OK.

Italics Used to note emphasized definitions, messages, file names, and paths.
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Feedback
Tektronix, Inc.

14200 SW Karl Braun Drive

P.O. Box 500

Beaverton, OR 97077

USA

For product information, sales, service, and technical support:

■ In North America, call 1-800-833-9200.

■ Worldwide, visit www.tektronix.com to find contacts in your area.
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Getting started

Instruments and accessories
Supported instruments required for CPHY setup.

Supported Instrument Description
Tektronix Arbitrary Waveform Generators
(AWG)

Two 70002A instruments

Sync hub One instrument
Real-time oscilloscope Tektronix DPO70804C, 71254C, 71604C,

72004C, 72304DX, 72504D, 72504DX, 73304D,
73304DX, 73304SX oscilloscopes
Tektronix DSA72504D and 73304D
oscilloscopes.
Tektronix MSO70804C, 71254C, 71604C,
72004C, 72304DX, 72504DX, 73304DX
oscilloscopes

MDC box One instrument MDC4500-4B
Matched pair SMA cables Two pairs
TCA-SMA connector Minimum Three pairs
MIPI CPHY Terminattion board One instrument

3



Minimum system requirements
The minimum requirements of the CPHYXpress application are listed in the
following table:

Table 2: Minimum system requirements

Supported OS Windows 7 Professional
Operating Systems Same as the oscilloscope
Firmware AWG 5.0.0178 or later
Software ■ CPHYXpress - 1.0.0 

■ Microsoft Internet Explorer 7.0 or later
■ Adobe Reader 7.0 or equivalent software

for viewing portable document format (PDF)
files

Other Devices ■ Matched pair of SMA cables, minimum two
sets for single lane

■ Microsoft compatible mouse or compatible
pointing device

Prerequisites TekVisa version 4.0.4.2 or above to communicate with the AWG70002A signal
generators (or other test instruments) over a LAN. If TekVisa is not already
installed in your system, you can download the software from
www.tektronix.com/software.

Getting started  
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Installing the software

NOTE. Use the following steps to instal the software on either a PC or an AWG.
The procedure is identical.

From the Tektronix website, select the latest version of the software and follow
the instructions to download.

 Getting started
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Follow the steps to install the latest CPHYXpress software.

1. Double click the executable file. An installation wizard initiates installation
of CPHYXpress.
 

 

NOTE.

If you have not installed MATLAB Compile Runtime version 8.0, the installer
will detect and install it.

You can download the TekVISA software from www.tektronix.com/software.

2. A popup appears stating that the MATLAB runtime R2012b is present in the
system.
 

 

■ Click Yes to re-install the MATLAB again.

■ Click No to Proceed with CPHYXpress installation.
 

Getting started  
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3. Click Next to continue the installation.
 

 

Select 'I agree the terms of the licence agreement', and click Next.
 

 

Getting started  
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4. Click Next.
 

 

5. Click Finish to finish the installation.

See also Minimum system requirements

Instruments and accessories

 Getting started
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Activate the license
To activate the license:

On a PC (SourceXpress application):

Figure 1: License activation from PC (SourceXpress)

1. Select Tools > Licenses; License Management window opens.

2. Click Install License.

3. Browse to the license file location and select it.

Getting started  
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On an AWG:

Figure 2: License activation from AWG

1. Select Utilities > About my AWG.

2. Click Install License.

3. Browse to the license file location and select it.

View software version and license information

 Getting started
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To view version details:

1. From PC, click Help > About SourceXpress and view the version
information in the System Information group box.
 

 

2. From AWG, click Utilities > About my AWG and view version information
in the System Information group box.

NOTE. Host id for every PC is unique. CPHYXpress installed on PC will have a
unique license.

To view license information:

Getting started  

12



1. From a PC, click Tools > Licenses. View license information from License
Management window, Installed Licenses group box.
 

 

2. From AWG, click Utilities > About my AWG. View version details in the
Installed Licenses group box.

 Getting started
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Application directories and license information
The following table lists the default application directory names and their usage:

Directory names Contains
C:\Program Files\Tektronix\SourceXpress
\SourceXpress

Path to the root application directory.

C:\Users\Public\tektronix\CPHYXpress
\DataFiles

Filter files, S-parameter files, setup files, and
pattern files.

Ordering Information
Contact your Tektronix representative to learn more about ordering C-
PHYXpress.

Connection setup

CPHY setup back panel

Figure 3: Set-up back panel with MDC box

Getting started  
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CPHY receiver test setup

Figure 4: CPHY - with MDC box

 Getting started
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Operating basics

About CPHYXpress
The following figure displays the CPHYXpress screen, the menu, the toolbar, and
other elements of the display. This section describes these elements. 
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Overview of the software
CPHYxpress is an application for the AWG which enables the generation of
various kinds of stimuli for CPHY Receiver testing. The application takes input
as bit stream, encoded it to CPHY signal scheme, adds impairments such as Jitter,
cable effect and generates the trio signal.

Key Features Key features supported are:

■ High Speed Mode, Low Power Mode, and Low Power - High Speed mode
signaling

■ Voltage and Rise/Fall time control
■ Jitter insertion and Channel embedding

Run the application
Run the CPHYXpress from a PC (SourceXpress)

To run the application, open SourceXpress from the Waveform Plug-in menu,
select CPHYXpress from Plug-in field.

It displays the CPHYXpress application.
 

 

Run the CPHYXpress from AWG

Operating basics  
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To run the application, open AWG application and from the Plug-in menu, select
Waveform Modules > CPHYXpress.

The AWG application opens the CPHYXpress.
 

 

 Operating basics
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Starting the software
From the Start menu, click All Programs > Tektronix > SourceXpress > select
SourceXpress. From the waveform plug-in tab, select CPHYXpress.
 

 

You can also double-click the SourceXpress application shortcut on the desktop.
From the waveform plug-in tab, select CPHYXpress
 

 
.
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Exiting the software
Exiting CPHYXpress from the PC: Select File > Exit to exit the application. If
you have not saved the waveforms, you are prompted to do so. This option is
always enabled.

NOTE. Using other methods to exit the application results in abnormal
termination of the application.

Exiting CPHYXpress from the AWG: Select  button to exit the
application.

File name extensions and directories
The application uses the following file name extensions: 

Table 3: File name extensions

File name extension Description
.txt Text file with ASCII text with no formatting. This file format may

be read by any ascii text editor (such as Microsoft Notepad,
Wordpad).

.wfm Binary file containing an AWG waveform record in a recallable,
proprietary format.

.flt Files containing the inverse filter co-efficient.

.awgx Saved session files for AWG and SourceXpress.

The following table lists the default application directory names and their usage:

Table 4: Directory names

Directory Description
Application installation path\Tektronix
\SourceXpress

Path to the root application directory.

Tektronix\SourceXpress\AWG\Plugins
\CPHYXpress

Contains CPHYXpress software executables
along with the required dlls are deployed.

C:Users\Public\Tektronix\CPHYXpress Contains AWGSetups, DataFiles, Setups,
Waveforms.

C:Users\Public\Tektronix\CPHYXpress\Datafiles Contains Filter files, S-Parameter files, Setup
files and pattern files.

C:Users\Public\Tektronix\CPHYXpress
\Waveforms

Waveform files.
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Toolbar options and dialog boxes

Playing
Displays  when the waveform is transferring from the AWG to
the oscilloscope.

Stop
Displays the  button before or after the waveform is transferred
to the oscilloscope. By default, the AWG displays this button.

Signal Mode CPHYXpress operates in three modes: High Speed, Low Power, and Low Power
- High Speed. By default, High Speed mode is selected.
 

 

■ High Speed (HS): In High Speed mode you can create a high speed signal
using a set of patterns and compile jitter waveforms. The waveforms created
using the High Speed tab, High Speed Burst tab, High Speed Jitter tab, and
High Speed Batch mode tab are independent.

■ Low Power (LP): In Low Power signal mode you can create low power
signal using a set of patterns.

■ Low Power - High Speed (LP-HS): In Low Power High Speed signal mode
you can create a complete CPHY burst, that is a low power high speed
waveform.
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Plug-in To use the plug-in menu, select Plug-in > CPHYXpress.

Compile Click Compile to compile currently active waveform.

The compiled waveform is displayed in the Waveform List. You can save the
waveform data in .wfm file format using the Waveform list shortcut menu. This
option is not enabled when the compilation is in progress.

Reset module Resets the present settings into default settings.

Help Click Help > select:

■ User Manual to view the CPHYXpress user manual.

■ MOI to view the CPHYXpress method of implementation manual.

■ About to view information about the plug-in.

Busy Displays Busy button, before the waveform transfer starts.

Click Run to turn on or turn off the run state of the AWG. 
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User interface feature
This section describes the user interface.

Docking and undocking
tabs

Any tab can be undocked from the GUI. This allows you to reposition a tab to a
new location or completely separate it from the main GUI.

■ Touch and hold the touchscreen (or right mouse click) to grab a tab and slide
it to a new area. The docking icon shows that you can dock (reposition) the
tab by releasing it at the new location.

Use Reset Window Layout  to return the display to the default
(docked) settings.

■ Right click and select Float, for the selected window to float.

Right click and select Dock to dock the window.

Splittering or resizing the
application window

The window panes can be adjusted in size wherever the panels are divided. Select
the three-dot-indicator and slide horizontally or vertically to increase or decrease
the size of the grid.
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Small or large font You can change the font size using Utilities > Preferences.

Save log feature The log file details the results of the created waveform. You can save the log file
from the Log View tab, right mouse click and select Save log as.

In the Save log as window, the log file will be saved with the .log extension.

The factory location is C:\Users\Public\Tektronix\CPHYXpress\Temp.

Slave and master features Master feature:

To enable the master feature select Compile and assign to in the Compile
Settings tab.
 

 

Select Append to the waveform sequence in AWG to append the waveform
with a previously saved waveform in the waveform list.

Select the waveforms to be assigned to the respective channels.

Slave feature:
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To enable slave feature select Compile and assign to in Compile Settings tab.
 

 

1. Select Enable Slave to enable slave specific controls.

2. Provide the IP Address of the slave

3. Click Connect.

NOTE.
■ Enter valid Slave IP Address.
■ Slave should be online.
■ The control channels is enabled.

4. Select the waveforms to be assigned to the respective channels.

Log View Log view provides the information log of the waveform creation and also
displays the information about the waveform compilation. 
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You can save the log by right-click -> Save log as. The created log will be saved
in the below location:

C:\Users\Public\Tektronix\CPHYXpress\Temp

You can clear the created log by right-click > Clear.
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Encoder log After a waveform is compiled, the intermediate details of the encoder bits,
symbols and wire states is available in a text file labeled
'CPHYEncoder_Data.txt'. The encoder log is saved to this location, C:\Users
\Public\Tektronix\CPHYXpress.

Below is the example of the encoder log.
 

 

The encoder log is created when:

■ The signal mode is either HS or LP_HS mode.

■ The base pattern is any of the PRBS patterns.

■ The base pattern 'Text file' is selected.
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Creating a signal

Selecting signal mode
By default the High Speed (HS) signal mode is selected.

High Speed (HS) High Speed (HS) signal mode allows you to create a high speed signal using a set
of patterns. 
 

 

The parameters to create high speed signal are configured using these tabs:

■ High speed
■ High speed jitter
■ High speed burst
■ High speed batch

29



Low Power (LP) Low Power (LP) signal mode allows you to create a low power signal. 
 

 

The parameters to create low power signal are configured in these tabs:

■ Low power
■ Low power noise

Low Power - High Speed
(LP-HS)

Low Power-High Speed signal mode allows you to create a complete low-power,
high-speed CPHY Burst waveform.
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The parameters to create low power - high speed signal are configured in these
tabs:

■ High speed
■ High speed jitter
■ High speed burst
■ High Speed Batch
■ Preferences
■ Low Power Noise
■ Low power
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CPHY signal parameters

High speed Use this tab to configure the basic parameters of the High Speed signal.

Yow can select a set of patterns and compile waveforms using these patterns.
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The following table describes High speed signal parameters:

Parameter Description Range Default value
Base Pattern Select the base pattern file from the list.
Pattern Select the input Base

Pattern / Bit Pattern for
waveform generation.

PRBS7
PRBS9_CPHY
PRBS11_CPHY
PRBS18_CPHY
Text file
Symbol file
Wire state file

PRBS9_CPHY

Repeat to a 16 bit
boundary

Sets option to repeat to
16 bit boundary.

NA Selected

Previous Wire State Select the previous
wire state

+x
-x
+y
-y
+z
-z

+x

PRBS Seed Specify the 16-bit seed
value for all the PRBS
CPHY patterns.

0x0000 to 0xFFFF 0x789A

Symbol
Symbol Rate

Specify the signal rate
of the signal.

50 MS/s to 5 GS/s 1.5 GS/s

Rise / Fall:
Rise / Fall Time

Specify the rise/fall
times of the signal.

0 to 0.5 UI 0 UI

Line Levels
Line Levels-High Specify the high-level

voltage of the
waveform for lines A, B,
and C.

NOTE. High line value
or level should be more
than or equal to the
sum of Low line value
or level and 20 mV.

0 to 600 mV 400 mV

Line Levels-Low Specify the low-level
voltage of the
waveform for the lines
A, B, and C.

NOTE. High line value
or level should be more
than or equal to the
sum of Low line value
or level and 20 mV.

-100 to 400 mV. This
value depends on the
value of high line level.

0 
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Parameter Description Range Default value
Use Line A levels for
Line B and Line C

When selected,
considers the voltage
levels of line A for line
B and line C.

NA Selected

NOTE.
1. Maximum and minimum values are displayed when you right click a field.
2. Mid level is computed as the average of High and Low levels.
3. The high line value/level should be more than or equal to the sum of the Low

line value/level plus 20 mV.
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Selecting file types. Supported Base Pattern file types for upload are:

■ Text file

■ Symbol file

■ Wire State file

Text file. The Text files use the *.txt extension. The range of elements for a text
file is [0, 1].

Figure 5: Example of Text file

Symbol file. HS files use the *.sym extension. The range of elements for a symbol
file is [0, 1, 2, 3, 4].

Figure 6: Example of Symbol file

Wire State file. Wire State files uses *.wstate extension. The range of elements for
a wire state file is [+z, -z, +y, -y, +x, -x].
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Figure 7: Example of Wire State file
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Selecting previous wire state file. Select Previous Wire State from the drop-down.
 

 

Example:

The initial symbol is 1 and the previous Wire State is +z. The current wire state is
defined to be -y as shown below.

Symbol
Input
Value

Previous Wire State, interval N-1 What
Happens+x -x +y -y +z -z

000 +z -z +x -x +y -y Rotate
CCW,
polarity is
Same

001 -z +z -x +x -y +y Rotate
CCW,
polarity is
Opposite

010 +y -y +z -z +x -x Rotate
CCW,
polarity is
Same

011 -y +y -z +z -x +x Rotate
CCW,
polarity is
Opposite

1xx -x +x -y +y -z +z Same
phase,
polarity is
Opposite

With the Wire State set to -y, the line-levels should be middle for Line A, low for
Line B and high for Line C as shown in the table below.
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Table 5: Definition of Wire State

Wire State Name High-Speed State
Code Name

Line Signal Levels
A B C

+x HS_+x High Low Middle
-x HS_-x Low High Middle
+y HS_+y Middle High Low
-y HS_-y Middle Low High
+z HS_+z Low Middle High
-z HS_-z High Middle Low

High speed jitter This tab allows you to configure jitter and noise parameters for the high speed
signal. 

Figure 8: High speed jitter

You can select a set of patterns and compile waveforms using these patterns.

The following table describes the High speed jitter parameters:

Table 6: High speed jitter tab settings

Controls Description Range Default Value
Jitter
Periodic Jitter (pk-pk) Select to set the

magnitude of periodic
jitter (pk-pk).

Min: 0 UI
Max: 1 UI

0 UI

Frequency Enter the amplitude in
volts to generate
desired sine noise.

Min: 100 kHz
Max: 300 MHz

10 MHz

Random Jitter (RMS) Select to set the
magnitude of random
jitter (in UI).

Min: 0 UI
Max: 0.3 UI

0 UI
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Controls Description Range Default Value
Duty Cycle Distortion
(DCD)

Enter the required
value for DCD
Line A: Select to apply
DCD to Line A.
Line B: Select to apply
DCD to Line B.
Line C: Select to apply
DCD to Line C.

Min: 0 
Max: 40 

0 %

Apply to All lines are enabled when Duty Cycle Distortion is selected.
Line A Enables the Duty Cycle

Distortion for line A.
NA Selected

Line B Enables the Duty Cycle
Distortion for line B.

NA Selected

Line C Enables the Duty Cycle
Distortion for line C.

NA Selected

Random Distortion Select to generate
varied distortion
randomly, for each
symbol interval.

NOTE. When the check
box is deselected the
distortion is fixed over
time.

NA Not selected

Sine Noise Amplitude
(pk)

Select to generate
noise in the waveform.
When selected,
activates Frequency.
Specify the amplitude
in volts to generate the
desired sine noise.

Min: 0 V
Max: 50 mV

0 V

Frequency Enter the frequency in
Hz to generate the
desired sine noise.

Min: 100 kHz
Max: 2* Symbol Rate
GHz

NOTE. Frequency
value depends on the
value of Symbol rate in
the High speed tab.

Min 10 MHz

NOTE. All the parameters have a checkbox, allowing you to select or clear the
stress.

 Creating a signal

39



Figure 9: High speed jitter - Embed Channel - FLT file

Table 7: High speed jitter tab settings - Embed Channel - FLT files

Controls Description Range Default Value
Embed Channel Enables you to embed or emulate the channel effect either by using FLT

files or S-parameter files.
FLT Files It refers to line A, line

B, and line C.
NA Selected, when Embed

Channel is selected.
Line A Enter the location of the

saved line A FLT files
or browse to the
location.

NA NA

Line B Enter the location of the
saved line B signal FLT
files or browse to the
location.

NA NA

Line C Enter the location of the
saved line C signal FLT
files or browse to the
location.

NA NA

Apply Line A filter file to
Line B and Line C

Select to apply the filter
file of Line A to Line B
and Line C.

NA Selected, when Embed
Channel is selected.

Figure 10: High speed jitter - Embed Channel - S-Parameter file

Table 8: High speed jitter tab settings - Embed Channel - S-Parameter file

Controls Description Range Default Value
S-Parameter File Emulate channel using various S-Parameter files.
Embed Select to embed the S-

Parameter file.
NA Selected by default.
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Controls Description Range Default Value
Bandwidth Limit Enables the bandwidth of computed channel filter.
None If you select None, the

cutoff frequency of the
filter is Fs/2 (where Fs
is the sampling
frequency).

NA Selected by default

Auto If you select Auto, the
cutoff frequency is –
14 dB of the channel
response.

NA NA

Custom If you select Custom,
the cutoff frequency is
the frequency that you
specify.

Min: Sample rate/100 
Max: Sample rate/2.5 

9.6 GHz

Figure 11: High speed jitter - Embed Channel - S-Parameter file type - S2P

Table 9: High speed tab settings - Embed Channel - S-Parameter file type -S2P

Controls Description Default Value
S2P File type Select the S-Parameter file type

from the drop-down.
S2P

S2P Two port S parameter file.
Line A Selects the two ports for Line A.

Port selection will not be the
same.

NA

Port 1 Select to define the port. NA
Port 2 Select to define the port. NA
Browse Browse to select the S2P file for Line A.
Line B Selects the two ports for Line B.

Port selection will not be the
same.

NA

Port 1 Select to define the port. NA
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Controls Description Default Value
Port 2 Select to define the port. NA
Browse Browse to select the S2P file for Line B.
Line C Selects the two ports for Line C.

Port selection will not be the
same.

NA

Port 1 Select to define the port. NA
Port 2 Select to define the port. NA
Browse Browse to select the S2P file for Line C.
Apply Line A S-Parameter file to
Line B and Line C

When selected, uses the S-
Parameter file of Line A to Line
B and Line C.

Selected
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Figure 12: High speed jitter - Embed Channel - S-Parameter file type - S4P - Single Ended

Table 10: High speed jitter tab settings - Embed Channel - S-Parameter file type -
S4P Single Ended

Controls Description Default Value
S4P Single Ended Four port single ended S parameter file.
Line A Line B Selects the four ports for Line A Line B.
Port1 Select to define the port. NA
Port2 Select to define the port. NA
Port3 Select to define the port. NA
Port4 Select to define the port. NA
Browse Browse to select the S4P Single Ended file.
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Controls Description Default Value
Line B Line C Selects the four ports for Line B Line C.
Port1 Select to define the port. NA
Port2 Select to define the port. NA
Port3 Select to define the port. NA
Port4 Select to define the port. NA
Browse Browse to select the S4P Single Ended file.
Line C Line A Selects the four ports for Line C Line A.
Port1 Select to define the port. NA
Port2 Select to define the port. NA
Port3 Select to define the port. NA
Port4 Select to define the port. NA
Browse Browse to select the S4P Single Ended file.
Apply LineAB S-Parameter file
to LineBC and LineCA

When selected, uses the S-
Parameter file of Line AB to
Line BC and Line CA.

Selected

Figure 13: High speed jitter - Embed Channel - S-Parameter file type - S6P Single Ended

Table 11: High Speed tab settings - Embed Channel - S-Parameter file type - S6P
Single Ended

Controls Description Default Value
S6P Single Ended Six port single ended S parameter file.
Port1 Select to define the port. NA
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Controls Description Default Value
Port2 Select to define the port. NA
Port3 Select to define the port. NA
Port4 Select to define the port. NA
Port5 Select to define the port. NA
Port6 Select to define the port. NA
Browse Browse to select the S6P Single Ended file.

High speed burst This tab allows you to configure the protocol data - Preamble, Sync, and Post
Pattern. When selected, this check box inserts the protocol data into the
waveform along with the payload specified in HS tab.
 

 

You can select a set of patterns and compile waveforms using these patterns.

The table below describes the High speed burst parameters:
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Table 12: High speed burst

Parameter Description Range Default value
Create Burst Enable this option to additional insert the burst

constituents to the waveform along with the
payload specified in HS tab.

Not selected

Include High Speed
Base Pattern

Enable this option to include High Speed Base pattern.

Previous Wire State Select the wire state. +x
-x
+y
-y
+z
-z

+x

Preamble Pattern Specify the preamble with 7 symbols.
PreBegin Select to include PreBegin.
Preamble PreBegin
Pattern

Specify the preamble
PreBegin pattern, with
7 symbols.

0,1,2,3,4 symbols 3333333 

Preamble PreBegin
Repeat

Specify the number of
times to repeat the
preamble PreBegin
pattern.
Specify the preamble
with 7 symbols.

0 to 2000 symbols 63 

ProgSeq Select to include ProgSeq.
ProgSeq Pattern Specify the ProgSeq

pattern, with 7 symbols.
Disabled by default.

0,1,2,3,4 symbols 33333333333333 

ProgSeq Repeat
Pattern

Specify the number of
times to repeat the
ProgSeq pattern.

0 to 16 symbols 1 

PreEnd Select to include PreEnd.
Preamble PreEnd
Pattern

Specify the preamble
PreEnd pattern, with
7 symbols.
Specify the 7 symbols.

0,1,2,3,4 symbols 3333333 

Preamble PreEnd
Repeat Pattern

Specify the number of
times to repeat the
preamble PreEnd
pattern.

0 to 10 Symbols 1 

Preamble Length Specify the preamble
length.
Preamble length is the
sum of PreBegin
Repeat, ProgSeq
Repeat and PreEnd
Repeat.

Preamble length =
[(PreBegin Repeat*7) +
(ProgSeq Repeat * 14)
+ (PreEnd Repeat * 7)]

By default preamble
length shows
448 symbols
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Parameter Description Range Default value
Sync Word Select this option to

include the 7 symbols.
0,1,2,3,4 symbols 3444443 

Sync Word Repeat Specify the number of
times to repeat sync
word.

0 to 10 1 repeat that is
7 Symbols

Post Pattern Select this option to
include the 7 Post
Pattern symbols.

0,1,2,3,4 symbols 4444444 

Post Pattern Repeat Specify the number of
times to repeat the Post
Pattern.

0 to 2000 32 repeat that is
224 Symbols.

Low power This tab allows you to configure the basic parameters of the Low Power signal.
 

 

Yow can select a set of patterns and compile waveforms using these patterns.

The table below describes the parameters:
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Table 13: Low power

Parameter Description Range Default value
Base Pattern Select the base pattern file from the list.
Pattern Select the input Base

Pattern / Bit Pattern for
waveform generation.

NOTE. The Low Power
state file allows to
browse a LP file, Test
file allows to browse
to .txt file.

ULPS
Low power state file
Text file

ULPS

Include LP content in
Low Power - High
Speed (LP-HS) Signal
Mode

This is applicable only
when the signal mode
is Low Power-High
Speed (LP-HS). When
selected the LP content
specified by the Base
Pattern will be included
in the LP-HS signal.

NA Disabled

Symbol
Symbol Rate Specify the symbol rate

of the LP signal.
10 to 100 MHz 20 MHz

TLPX Displays the value
based on the symbol
rate entered.

Value depends on the
value of the symbol
rate.

50 ns

Rise/Fall Specifies the rise / fall time of the signal.
Rise/Fall time
(15%-85%)

Specifies the rise/fall
time of the LP signal.

0.01 to 0.5 UI 0.1 UI

Line Levels (High
Impedance)

Specify the LP line voltages for the receiver at high impedance.

High Specify the high-level
voltage (high
impedance) for LP
signals for lines A, B,
and C. High line levels
= Low line levels +
200 mV.

500 mV to 1.3 V 1 V

Low Specify the low-level
voltage (low
impedance) for lines A,
B and C.

-100 mV to 700 mV 50 mV

Use Line A levels for
Line B and Line C

When selected considers the voltage levels of line A for line B and line C.

LP-HS Entry/Exit
Timing

Specify the LP-HS entry/exit timing.
This is applicable only when the signal mode is Low Power-High Speed
(LP-HS).
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Parameter Description Range Default value
Start LP-111 duration Specify the start of

LP-111 duration.
1 to 100 Symbols 2 Symbols

LP-000 Duration
(t3_PREPARE):

Specify the
LP-000 duration.

0.5 to 100 Symbols 1 Symbol

Enable THS_Exit Enables the End LP_111 duration.
End LP_111 duration

NOTE. Displays only if
Enable THS_Exit is
enabled.

Specifies the end of
LP-111 duration.

1 to 100 Symbols 2 Symbols
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Selecting file types. Supported Base Pattern file types to browse are:

■ Bit file

■ LP file

Bit file. The Bit files use the .txt extension. The range of elements for a bit file is
[0,1].

Figure 14: Example of Bit file

LP file. The extension for LP file is .LP. The range of elements for a LP file is
[LP00, LP01, LP10, LP11].

Figure 15: Example of LP file
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Low power noise This tab allows you to configure the basic parameters of the Low power noise
signal.
 

 

Parameter Description Range Default value
Impairments
(Applicable in LP
signal mode)
Sine Noise Select to generate noise in the waveform.

Selecting this check box, activates Amplitude (Peak) and Frequency
controls.

Amplitude (Peak) Specify the amplitude
in volts to generate the
desired sine noise.

Min: 0 V
Max:300 mV

0 V

Frequency Enter the frequency in
Hz to generate the
desired sine noise.

Min:100 kHz
Max: 5 GHz

NOTE. The maximum
value depends on the
symbol rate in the LP
tab.

1 MHz

Apply to All lines are enabled when Sine Noise is enabled.
Line A Enables the sine noise

frequency for Line A.
NA Selected

Line B Enables the sine noise
frequency for Line B.

NA Selected

Line C Enables the sine noise
frequency for Line C.

NA Selected

eSpike Select to add Spike to the waveform.
Area Specify the area of the

eSpike.
100 to 400 Vps 200 Vps

Duration Specify the duration of
the eSpike.

1 to 5 ns 2 ns

Apply to Select to add eSpike to all the lines.
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Parameter Description Range Default value
Line A Enables the eSpike

area and duration for
Line A.

NA Selected

Line B Enables the eSpike
area and duration for
Line B.

NA Selected

Line C Enables the eSpike
area and duration for
Line C.

NA Selected

TMin Minimum width of the
Low power pulse.

10 ns to 100 ns

NOTE. Max value
depends on the symbol
rate of the LP signal.

20 ns

High speed batch mode Use this tab to configure the parameters of the High Speed Batch mode.
 

 

Parameter Description Default value
Enable batch waveform
creation

Enables the batch waveform
creation.

Disabled

Parameter Select the parameter to
configure the waveform.

Periodic_Jitter
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Listed is the default range of increment values for all the parameters:

Parameter Units Range
Start End Increment

Periodic Jitter UI Min: 0 
Max: 0.99 

Min: 0.01 
Max: 1 

Min: 0.01 
Max: 1 

Periodic_Jitter_Fre
quency

MHz Min: 1 
Max: 299 

Min: 2 
Max: 300 

Min: 1 
Max: 299 

Random_Jitter UI Min: 0 
Max: 0.29 

Min: 0.01 
Max: 0.3 

Min: 0.01 
Max: 0.3 

Duty_Cycle_Distor
tion

% Min: 0 
Max: 39 

Min: 1 
Max: 40 

Min: 1 
Max: 40 

PreBegin_Repeat Words Min: 0 
Max: 999 

Min: 1 
Max: 1000 

Min: 1 
Max: 1000 

Post_Repeat Words Min: 0 
Max: 63 

Min: 1 
Max: 64 

Min: 1 
Max: 64 

NOTE.
■ Increment value is depends on Start and the End value.
■ End and increment value depends on the Start value.
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Preferences This tab allows you to define the preferences for the compiled waveform.
 

 

You can select a set of parameter preferences for the waveforms.

The table below describes these parameters:

Table 14: Preferences tab

Parameter Description Range Default value
Sample Rate Specifies the sample rate of the waveform.
Auto Select to allow the

application to choose
an optimal sample rate
for the waveform.

NA Default

Manual Select to specify the sample rate for the signal
by setting the Samples per UI (SPUI).

Not selected
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Parameter Description Range Default value
Samples per UI Specify the samples

per UI (SPUI), which
dictates the sample
rate for the waveform to
be created. This is
applicable when the
Sample rate selection
is 'Manual'. The range
of values of this
depends on the HS
symbol rate.

Signal mode: High
Speed, 4 to 500 
Signal mode: Low
Power, 4 to 2500 

Signal mode: High
Speed

■ Auto mode: 16 

■ Manual mode: 16 

Signal mode: Low
Power

■ Auto mode: 100 

■ Manual mode:
100 

Sample rate The value of the
resulting sample rate is
displayed for users
information.

Signal mode: High
Speed, 6 GHz to
24 GHz
Signal mode: Low
Power, 0.08 GHz to
25 GHz

Signal mode: High
Speed

■ Auto/Manual
mode: 24 GHz

Signal mode: Low
Power

■ Auto/Manual
mode: 2 GHz

NOTE. Sample Rate =
(Symbol Rate) x
(Samples Per UI)

AWG Amplitude and
Offset control

Enable this option to include AWG Amplitude and Offset control for the
waveform.

Auto (Recommended) Automatically sets the
AWG amplitude and
offset values.

NA Selected

Manual Enables AWG
amplitude and offset.

NA Not selected

Offset Specify the offset value
manually.

-400 to 800 mV 400 mV

Amplitude Specify the AWG
amplitude value
manually.

31 mV to 1.2 V 400 mV

Apply Correction File Enables the application of correction file. Not Selected
Master Ch1 Select to apply the

correction file on
Master Ch1 waveform.

NA Not Selected. Enables
when Apply Correction
File is selected.

Master Ch2 Select to apply the
correction file on
Master Ch2 waveform.

NA Not Selected
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Parameter Description Range Default value
Slave Ch1 Select to apply the

correction file on Slave
Ch1 waveform.

NA Not selected. Enables
when the slave is
connected

Slave Ch2 Select to apply the
correction file on Slave
Ch2 waveform.

NA Not selected. Enables
when the slave is
connected

Use Master Ch1
connection file to all the
channels

Select to apply the
correction file of the
Master ch1 to all
channels.

NA Not Selected. Enables
when Apply Correction
File is selected.

Apply Gaussian filter Select to apply the
Gaussian filter to
correct the signal.

NA Not Selected

Bandwidth Enter the bandwidth of
the signal.
The available
bandwidth setting
depends on the AWG
sample rate and the
frequency resolution
setting.

Sample rate/100 to
sample rate/2 

12 GHz

Remove correction for
Sin(x)/x distortions from
correction file

Enables removal of
correction for Sin(x)/x
distortions from
correction file.

NA Not Selected

Startup Signal Select to include the start up signal.

NOTE. Applicable only for Auto mode of AWG and Amplitude offset
control in LP and LP-HS signal mode.

Line A, B, and C Select the LP-High or
LP-Low signal for line
A, B, and C.

Skew Specify the skew (of the output waveform).
Line A to Line B Specify the skew to be

introduced between line
A and B signals.

2 ns to -2 ns 0 sec

Line A to Line C Specify the skew to be
introduced between the
line A and C signals.

2 ns to -2 ns 0 sec

Correction file

When testing a Device under test, make sure that the test equipment generating
the signal is of better quality than the Device under Test. Signal Generators and
AWG's require a flat amplitude and linear phase response in the band of interest
to generate high-quality waveforms. The influence of the AWGs and the cables
on the signals which could distort the signals should be de-embedded from the
signals before sending it to the DUT.
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For a detailed procedure to create a correction file, please refer to Generic
Precompensation Plug-in Application manual.

Applying the correction to the test signal

Correction files can be applied to any waveform in the AWG waveform list. By
default, the correction file feature is disabled. To apply corrections, enable
“Apply correction file” in the Compile Settings tab. The slave correction file
controls will be enabled only if the slave is connected. You can select a
correction file for each channel using the Browse button. The correction file will
be applied only for the channels that are enabled in the application.

Compile settings This tab allows you to define the settings for the compiled waveform.
 

 

Table 15: Compile settings tab

Parameter Description Range Default value
Waveform
Sequence Name Specify the name of the sequence. CPhySequence
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Parameter Description Range Default value
Name Specify the name for

the compiled waveform.
The name will be
automatically
incremented. This
helps you to create
multiple waveforms
without the need to
change the name.

Alphanumeric without
spaces.

CPHY_Example

Override existing
waveform

Select to replace the waveform if the waveform name is the same. If the
waveform name is not the same, then the created waveform will be listed
along with the new name in the waveform list.

Compile/Assign waveforms
Compile Compiles the waveform only. Default
Compile and assign
to

Compiles and loads the waveform to the specified channel.

Append to the
waveform sequence in
AWG

Select, to append the waveform to the old sequence. Clear to create a
new sequence of waveform.

Master Select the Master AWG.

NOTE. Activates only when Compile and assign to is enabled.

CH1 Specify the waveform
line to be loaded on
Ch1, if Compile and
assign to is selected.

VA
VB

VA

CH2 Select the waveform
line to be loaded on
Ch2.

VA
VB

VB

Enable Slave Enables slave AWG specific controls. Not selected
IP Address Specify the slave IP

address.
NA Dimmed

Connect Connects to the Slave. NA Dimmed
CH1 Specify the waveform

line to be loaded on
Ch1 on the AWG, if
Compile and assign
to is selected.

VA
VB
VC

VC

CH2 Select the waveform
line to be loaded on
Ch2 on the AWG.

VA
VB
VC

VC
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Compile and transfer
signal

To compile and transfer the waveform: 

1. Click Compile in the toolbar.

You can view the details of the waveform in the Log View .

The compiled waveform is displayed in the waveform list. The waveform
name is same as the pattern selected.
 

 

2. Select the Home menu from the AWG.

3. To load the waveform into the oscilloscope, drag and drop the waveform
from Waveform list to the AWG channel (Ch1/Ch2).
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You can view the waveform in the AWG.

4. Click Channel 1 and Channel 2 to turn on the AWG channels.

NOTE.

You do not need to assign a channel if Compile and assign to is selected in
Preferences tab.

You need to manually drag the waveform to AWG channels if 'Complile' is
selected in Compile Setting tab.

5. Click Play.

The waveform is transferred to the oscilloscope: You can view the waveform
in the oscilloscope.
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Reference

Error messages
The following table lists the error codes for the application.

Table 16: Error messages for CPHYXpress

Error code Error Type Error messages
8800 Channel Filter File Error High Speed: Channel Filter file

not found or has invalid content.
8801 Base Pattern File Error High Speed: Text file not found

or has invalid content.
8802 Base Pattern File Error Low Power: Text file not found

or has invalid content.
8803 PRBS Error High Speed: All zero PRBS

seed value is invalid.
8804 Compile Error Waveform compilation failed.
8805 eSpike Error Low Power: eSpike Synthesis

Failed - Increase the Samples
per UI (SPUI), or change
eSpike Area or Duration.

8806 Channel Filter File Error High Speed: Embed Channel -
Filter file data may be invalid.
The sample rate of filter file
does not match the sample rate
of the waveform.

8807 VISA Communication Error Visa communication failed. For
more details refer to 
Troubleshooting section of the
OLH.

8808 Slave AWG Connection Error Slave AWG configuration is
incorrect. For more details refer
to the Troubleshooting section
of OLH.

8809 S-Parameter file Error S-Parameter file not found.
8810 Correction file Error Invalid Correction file.
8811 Custom Base Pattern file Error High Speed: Invalid Custom

base pattern file.
8812 Custom Base Pattern file Error Low Power: Invalid Custom

base pattern file.
8813 S-Parameter file Error Invalid S-Parameter file.
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Error code Error Type Error messages
8814 HS Pattern Error HS pattern length is zero. At

least one portion of the pattern
needs to be enabled and
configured.

8815 Base Pattern file Error Low Power - High Speed: Text
file not found or has invalid
content.

8816 Embed Channel filter file Error Invalid filter file.
8817 Amplitude and Offset Error Waveform with specified

amplitude and offset values for
the voltage levels cannot be
achieved. Try with amplitude
and offset control set to Auto.

8818 Base Pattern file Error High Speed: Symbol file not
found or has invalid content.

8819 Base Pattern file Error High Speed: Wire state file not
found or has invalid content.

8820 Base Pattern file Error Low Power: Low power state
file not found or has invalid
content.

8821 Base Pattern file Error Low Power - High Speed:
Symbol file not found or has
invalid content.

8822 Base Pattern file Error Low Power - High Speed: Wire
state file not found or has
invalid content.

8823 Base Pattern file Error Low Power - High Speed: Low
power state file not found or has
invalid content.

8824 Compile Error A trigger waveform cannot be
created for cases when LP
voltage swing is less than HS
voltage swing.

8825 Correction file Error Correction file not found or has
invalid content.

8826 Startup Signal Error Startup signal is not applicable
in High Speed mode.

8827 Correction Configuration Error Channel waveform types are
same and correction files are
different.

8829 Correction Configuration Error Correction is not enabled on the
channel.

1613 MDC4500 error Lost connection to MDC4500
(-100); Check the USB
connection between AWG and
MDC.
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How to

Enable PC to use the
software You need to configure the Master AWG from the SourceXpress installed in the

PC and configure the Slave using Remote Desktop Connection to create the
waveforms and assign it to the Master and Slave AWG.

NOTE. Enable Slave AWG configuration before configuring the Master AWG.

Steps to compile waveforms on the master AWG and transfer the waveform to
the slave AWG:

1. Configure Slave AWG.
2. Configure Master AWG.
3. Compile waveforms from PC.
4. Run the waveforms.
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1. Configure Slave AWG (Enable Sync in Slave)

■ Using Remote Desktop Connection or VNC Viewer, connect to the Slave
AWG using the IP address.
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■ Select Setup tab, and click Sync.
■ Select Enable.
■ Click OK.

 

 

The Slave AWG is configured.
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2. Configure Master AWG

■ Select the Connectivity tab.
■ Enter the IP address of the Master AWG. A popup appears displaying

that a connection is in progress.

Displays the IP address of the configured Master AWG in the Generator
list.

■ Select the Setup tab, and click Sync.
■ Select Enable.
■ Click on change configuration and select the port where the slave is

connected (Port 2, 3 or 4).
■ Click OK.

3. Compile Waveform from PC

■ Select Waveform Plug-in -> CPHYXpress -> Compile settings.
■ Select Compile and assign to.
■ Assign the waveforms to the Master channels CH1 or CH2.
■ Enable Slave.
■ Enter the slave IP Address.
■ Click Connect. The slave AWG is connected. Assign the waveforms to

the Slave channels CH1 or CH2.
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■ Click Compile to compile the waveform.
 

 
■ The waveform is generated and it is displayed in the Waveform tab.

4. Run the Waveforms

NOTE. Connect Master and Slave AWG channels to the Scope channels.

Check MCR is installed. To check whether MCR is installed, click Start > Control Panel > Programs >
click Uninstall a program. List of programs installed are populated in a window.
If MCR is installed, then it appears in the list.

Check if MCR installation
fails.

If MCR installation fails, change the UAC (User Account Control) setting as low,
in the control panel or run the application as Administrator.
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Figure 16: User Account Control Settings

Troubleshooting
Listed below are the frequently reported issues and the ways to troubleshoot
them.
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Slave AWG Connection Error and VISA Communication Error: This error
occurs because of one among the following reasons:

■ Invalid slave IP or slave is offline or AWG software is not launched in slave
or slave AWG model is not supported.

■ TekVisa LAN server has stopped. Follow the below steps on Master and
Slave AWG to fix this issue.

1. Run ServerControl.exe from C:\Program Files (x86)\IVI Foundation
\VISA\WinNT\TekVISA\Bin\.

2.
A tray icon  appears on the task bar.

3. Right click the icon and select Start VX-11 Server if it is not started.

■ Check whether the slave IP address is listed in Open Choice Instrument
Manager. If the slave IP address is not listed, then use the following steps to
check and add the instrument.

1. Run TekInstrMgr.exe from C:\Program Files (x86)\IVI Foundation\VISA
\WinNT\TekVISA\Bin.

2. Check whether the slave IP address is listed as in the below screen.
 

 

3. If the slave address is not listed, use the steps below:

a. Ensure GPIB, LAN and VXI LEDs are ON.

b. Under LAN, select Auto Discovery.

c. Enter the slave IP for Hostname, click the down arrow button, and
click Done.

d. Click Update and wait for some time to view the Slave IP in the list.
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■ The Instrument Manager is unable to recognize Virtual GPIB. The
Instrument list appears to be blank as below even after updating in
OpenChoice Instrument Manager. TekVisa needs to be re-installed to fix this
issue.
 

 

■ This could be either because of slave configuration or improper installation
of TekVisa.

■ The instrument might have got locked. Follow the steps below to unlock it.

1. Run TekInstrMgr.exe from C:\Program Files (x86)\IVI Foundation\VISA
\WinNT\TekVISA\Bin.

2. On Master/ SourceXpress, select GPIB::1::INSTR in the list and click
Properties.
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3. Click Unlock Instrument button if it is locked.
 

 

No waveforms assign to
channel

To assign waveforms to a channel:

■ Select Window > Waveform List to view the waveforms are assigned to
channel. If the waveforms are not assigned to channels, you need to assign
the channels to the waveform.

■ Select Compile Settings > select Compile and assign to and select the
Channels.

Slave configuration To configure the slave, select Compile and assign to in Preferences tab.

1. Select Enable slave to enable slave specific controls.

2. Provide the IP Address of the slave.

3. Click Connect.

NOTE.
■ Enter only the valid Slave IP Address.
■ Slave should be online.
■ The control channel is enabled.

4. Select the waveforms to be assigned to the respective channels.
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MDC error The MDC error pop-up is displayed in either of the context:

■ The MDC USB cable from AWG Master/Slave is removed or when there is a
loose connection of the cable.

■ In the process of compiling and transferring the signals to the oscilloscope.

Parameter definitions
Definitions of the jitter and time related parameters are given in the following
table:

Table 17: Jitter/Time parameters and their description

Parameters Description
Jitter
RJ Random Jitter is jitter that does not exhibit

deterministic behavior and is not bounded.
PJ Periodic Jitter is the portion of the deterministic

jitter that is periodic, but for which the period is
not correlated with any data in the waveform. It
is measured by peak-to-peak variation and
frequency.

DCD Duty Cycle Distortion is the portion of the
deterministic jitter directly correlated with
waveform polarity (the difference in the positive
edges and negative edges).

Noise This is a type of additive noise that modifies the
vertical amplitude of the serial data and
contributes to the jitter.

Time
Rise Time Elapsed time between the low reference level

crossing and the high reference level crossing
on the rising edge of the waveform. It is
measured in time units between the 10% and
90% levels or between the 20% and 80% levels.

Fall Time Elapsed time between the high reference level
crossing and the low reference level crossing on
the falling edge of the waveform. It is measured
in time units between the 10% and 90% levels or
between the 20% and 80% levels.
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Commands group

High speed group commands

Command Description
CPHY:HSPEed:PATTern Sets or returns the High Speed base pattern

type.
CPHY:HSPEed:CUSTom:FILE Sets or returns the custom base pattern file

path.
CPHY:HSPEed:SRATe Sets or returns the symbol rate for High Speed

base pattern.
CPHY:HSPEed:RTFT:VALUe Sets or returns the rise and fall time of the signal

for High Speed base pattern.
CPHY:HSPEed:RTFT:SECOnds (Query only) Sets the rise/fall times of the signal in seconds.
CPHY:HSPEed:PRBS:SEED Sets or returns the PRBS seed value.
CPHY:HSPEed:LINEA:HIGH Sets or returns the high-level voltage of line A

waveform.
CPHY:HSPEed:LINEA:LOW Sets or returns the low level voltage of the

waveform for line A.
CPHY:HSPEed:LINEA:MID (Query only) Returns the mid level voltage of Line A

waveform.
CPHY:HSPEed:LINEB:HIGH Sets or returns the high level voltage of line B

waveform.
CPHY:HSPEed:LINEB:LOW Sets or returns the low level voltage for the

waveform for Line B.
CPHY:HSPEed:LINEB:MID (Query only) Returns the mid level voltage of Line B

waveform.
CPHY:HSPEed:LINEC:HIGH Sets or returns the high level voltage of Line C

waveform.
CPHY:HSPEed:LINEC:LOW Sets or returns the low level voltage of line C

waveform.
CPHY:HSPEed:LINEC:MID? (Query only) returns the mid level voltage of Line C

waveform.
CPHY:HSPEed:USELevels Sets or returns the state of 'use line A levels for

line B and line C.
CPHY:HSPEed:REPEat16bit? Sets or returns the status of the option to repeat

the input base pattern to a 16-bit boundary or
not.

CPHY:HSPEed:WIREstate Sets or returns the wire state type.
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High speed jitter group commands

Command Description
CPHY:HSPEed:JITTer:PJ:ENABle Enables or disables the periodic jitter.
CPHY:HSPEed:JITTer:PJ:VALUe Sets or returns periodic jitter value.
CPHY:HSPEed:JITTer:PJ:FREQuency:VALUe Sets or returns the periodic jitter frequency

value.
CPHY:HSPEed:JITTer:RJ:ENABle Sets or returns the random jitter.
CPHY:HSPEed:JITTer:RJ:VALUe Sets or returns the random jitter value of high

speed jitter waveform.
CPHY:HSPEed:JITTer:DCD:ENABle Sets or returns the duty cycle distortion.
CPHY:HSPEed:JITTer:DCD:VALUe Sets or returns the value of duty cycle distortion.
CPHY:HSPEed:JITTer:DCD:LINEA:ENABle Sets or returns the duty cycle distortion for line

A.
CPHY:HSPEed:JITTer:DCD:LINEB:ENABle Sets or returns the duty cycle distortion to line B.
CPHY:HSPEed:JITTer:DCD:LINEC:ENABle Sets or returns the duty cycle distortion for line

C.
CPHY:HSPEed:JITTer:DCD:RANDomdistortion:
ENABle

Sets or returns the random distortion.

CPHY:HSPEed:JITTer:SINE:ENABle Enables or disables the sine noise.
CPHY:HSPEed:JITTer:SINE:AMPLitude Sets or returns the sine noise amplitude value.
CPHY:HSPEed:JITTer:SINE:FREQuency Sets or returns the sine noise frequency value.
CPHY:HSPEed:JITTer:EMBEd:ENABle Enables or disables channel embedding.
CPHY:HSPEed:JITTer:EMBEd:TYPE Sets or returns the type of channel embedding.
CPHY:HSPEed:JITTer:EMBEd:FILTer:LINEA Sets or returns line A channel filter file path.
CPHY:HSPEed:JITTer:EMBEd:FILTer:LINEB Sets or returns line B channel filter file path.
CPHY:HSPEed:JITTer:EMBEd:FILTer:LINEC Sets or returns line C filter file path.
CPHY:HSPEed:JITTer:EMBEd:FILTer:APPLybc Enables or disables the use of line A channel

filter file for line B and line C.
CPHY:HSPEed:JITTer:EMBEd:SPARameter:M
ODE

Sets or returns the S-Parameter mode.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:BA
NDwidth:CUST

Sets or returns the S-Parameter bandwidth
mode.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:PO
RT

Sets or returns the S-Parameter file type.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:ST
WO:LINEA:INPUt

Sets or returns the line A input port in 2 port S-
Parameter mode.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:ST
WO:LINEA:OUTPut

Sets or returns the line A output port in 2 port S-
Parameter mode.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:ST
WO:LINEB:INPUt

Sets or returns the line B input port in 2 port S-
Parameter mode.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:ST
WO:LINEB:OUTPut

Sets or returns the line B output port in 2 port S-
Parameter mode.
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Command Description
CPHY:HSPEed:JITTer:EMBEd:SPARameter:ST
WO:LINEC:INPut

Sets or returns the line C input port in 2 port S-
Parameter mode

CPHY:HSPEed:JITTer:EMBEd:SPARameter:ST
WO:LINEC:OUTPut

Sets or returns the line C output port in 2 port S-
Parameter mode.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:ST
WO:LINEA:FILE

Sets or returns line A S2P file path.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:ST
WO:LINEB:FILE

Sets or returns line B S2P file path.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:ST
WO:LINEC:FILE

Sets or returns line C S2P file path.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:ST
WOp:APPLylinebc

Sets or returns the use of line A S-Parameter file
for line B and line C.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:SF
SE:AB:INPUt:ONE

Sets or returns the line AB input one type.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:SF
SE:AB:INPUt:TWO

Sets or returns the input two type of line AB.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:SF
SE:AB:INPUt:FILE

Sets or returns the line AB S-Parameter file
path.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:SF
SE:AB:OUTPut:ONE

Sets or returns the output one type of Line AB.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:SF
SE:AB:OUTPut:TWO

Sets or returns the output two type of line AB.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:SF
SE:BC:INPUt:ONE

Sets or returns the input one type of line BC.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:SF
SE:BC:INPUt:TWO

Sets or returns input two type of line BC.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:SF
SE:BC:INPUt:FILE

Sets or returns the line BC input file path.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:SF
SE:BC:OUTPut:ONE

Sets or returns output one type of line BC.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:SF
SE:BC:OUTPut:TWO

Sets or returns output two type of line BC.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:SF
SE:CA:INPUt:ONE

Sets or returns the input one type of line CA.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:SF
SE:CA:INPUt:TWO

Sets or returns the input two type of line CA.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:SF
SE:CA:INPUt:FILE

Sets or returns line CA input file path.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:SF
SE:CA:OUTPut:ONE

Sets or returns output one type of line CA.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:SF
SE:CA:OUTPut:TWO

Sets or returns output two type of line CA.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:SS
IX:LINEA:INPUt

Sets or returns the line A input of 6-port S-
Parameter mode.
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Command Description
CPHY:HSPEed:JITTer:EMBEd:SPARameter:SS
IX:LINEA:OUTPut

Sets or returns the line A output of 6-port S-
Parameter mode.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:SS
IX:LINEB:INPUt

Sets or returns the line B input of 6-port S-
Parameter mode.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:SS
IX:LINEB:OUTPut

Sets or returns the line B output of 6-port S-
Parameter mode.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:SS
IX:LINEC:INPUt

Sets or returns the line C input of 6-port S-
Parameter mode.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:SS
IX:LINEC:OUTPut

Sets or returns the line C output of 6-port S-
Parameter mode.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:SS
IX:FILE

Sets or returns the S6P S-Parameter file path.

High speed burst group commands

Command Description
CPHY:HSPEed:BURSt:ENABle Enables or disables batch waveform creation.
CPHY:HSPEed:BURSt:HSDATA:INCLude Sets or returns to include High Speed data with

burst mode.
CPHY:HSPEed:BURSt:PREBegin:ENABle Enables or disables Prebegin with burst mode.
CPHY:HSPEed:BURSt:PREBegin:PATT Sets or returns the PreBegin pattern.
CPHY:HSPEed:BURSt:PREBegin:REPEat Sets or returns the repeat count for PreBegin.
CPHY:HSPEed:BURSt:PREAmble:LENGth
(Query only)

Returns the preamble length in terms of number
of symbols.

CPHY:HSPEed:BURSt:PROGseq:ENABle Enables or disables programmable sequence.
CPHY:HSPEed:BURSt:PROGseq:PATTern Sets or returns the for programmable sequence

pattern.
CPHY:HSPEed:BURSt:PROGseq:REPEat Sets or returns the repeat count for

programmable sequence pattern.
CPHY:HSPEed:BURSt:PREEnd:ENABle Enables or disables PreEnd with burst mode.
CPHY:HSPEed:BURSt:PREEnd:PATTern Sets or returns the PreEnd pattern.
CPHY:HSPEed:BURSt:PREEnd:REPeat Sets or returns the repeat count for PreEnd

pattern.
CPHY:HSPEed:BURSt:SYNC:ENABle Enables or disables sync with high speed burst

mode.
CPHY:HSPEed:BURSt:SYNC:WORD Sets or returns the sync word.
CPHY:HSPEed:BURSt:SYNC:REPEat Sets or returns the repeat count of sync word.
CPHY:HSPEed:BURST:SYNC:SYMBols (Query
only)

Returns the number of symbols for sync word.

CPHY:HSPEed:BURSt:POST:ENABle Enables or disables the post pattern in high
speed burst mode.
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Command Description
CPHY:HSPEed:BURSt:POST:PATTern Sets or returns the post pattern.
CPHY:HSPEed:BURSt:POST:REPEat Sets or returns the repeat count of post pattern.
CPHY:HSPEed:BURSt:POST:SYMBols (Query
only)

Returns the number of symbols of post pattern.

Low power group commands

Commands Description
CPHY:LPOWer:PATTern Sets or returns the low power base pattern.
CPHY:LPOWer:CUSTom:FILE Sets or returns custom base pattern file for low

power.
CPHY:LPOWer:CONTent:ENABle Enables or disables the option to include LP

base pattern content in the LP-HS signal.
CPHY:LPOWer:SRATe Sets or returns the low power symbol rate.
CPHY:LPOWer:TLPX (Query only) Returns the Low Power TLPX value.
CPHY:LPOWer:RTFT:VALUe Sets or returns the rise/fall time in UI.
CPHY:LPOWer:RTFT:SECOnds (Query only) Returns the rise/fall time in seconds.
CPHY:LPOWer:LINEA:HIGH Sets or returns the high level voltage for line A.
CPHY:LPOWer:LINEA:LOW Sets or returns the low level voltage for line A.
CPHY:LPOWer:LINEB:HIGH Sets or returns the high level voltage for line B.
CPHY:LPOWer:LINEB:LOW Sets or returns the low level voltage for line B.
CPHY:LPOWer:LINEC:HIGH Sets or returns the high level voltage for line C.
CPHY:LPOWer:LINEC:LOW Sets or returns the low level voltage for line C.
CPHY:LPOWer:USELINEA Enables or disables the use line level of A to line

B and line C.
CPHY:LPOWer:STARt:DURAtion:VALUe Sets or returns the start timing for LP-HS mode.
CPHY:LPOWer:STARt:DURAtion:SYMBols
(Query only)

Returns the start LP-111 duration of the LP-HS
mode in seconds.

CPHY:LPOWer:TPREpare:VALUe Sets or returns the LP-000 duration in LP
symbols.

CPHY:LPOWer:TPREpare:SYMBols? (Query
only)

Returns the LP-000 duration in seconds.

CPHY:LPOWer:THSExit:ENABle Enables or disables the option to include THS
Exit in the LP-HS waveform.

CPHY:LPOWer:END:DURAtion:VALUe Sets or returns the end duration value in LP
symbols.

CPHY:LPOWer:END:DURAtion:SYMBols?
(Query only)

Returns the end duration value in symbols.
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Low power noise group commands

Commands Description
CPHY:LPOWer:NOISe:SINE:ENABle Enables or disables the low power sine noise.
CPHY:LPOWer:NOISe:SINE:AMPLitude Sets or returns the low power sine noise

amplitude.
CPHY:LPOWer:NOISe:SINE:FREQuency Sets or returns the sine noise frequency.
CPHY:LPOWer:NOISe:ESPIke:ENABle Enables or disables the low noise eSpike.
CPHY:LPOWer:NOISe:ESPIkeAREA Sets or returns the eSpike area.
CPHY:LPOWer:NOISe:ESPIke:DURAtion Sets or returns the low power noise eSpike

duration.
CPHY:LPOWer:NOISe:SINE:LINEA Enables or disables the low power noise for line

A.
CPHY:LPOWer:NOISe:SINE:LINEB Enables or disables the low power noise for line

B.
CPHY:LPOWer:NOISe:SINE:LINEC Enables or disables the low power noise for line

C.
CPHY:LPOWer:NOISe:ESPIke:LINEA Sets or returns the low power eSpike for line A.
CPHY:LPOWer:NOISe:ESPIke:LINEB Sets or returns the low power eSpike for line B.
CPHY:LPOWer:NOISe:ESPIke:LINEC Sets or returns the low power eSpike for line C.
CPHY:LPOWer:NOISe:TMIN:ENABle Enables or disables the noise TMin.
CPHY:LPOWer:NOISe:TMIN:VALUe Enables or disables the low power noise TMin

value.
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High speed batch mode group commands

Commands Description
CPHY:HSPEed:BATCh:ENABle Enables or disables the batch waveform

creation.
CPHY:HSPEed:BATCh:PARAmeter Sets or returns the batch parameter type.
CPHY:HSPEed:BATCh:STARt Sets or returns the start value of the selected

batch mode parameter type.
CPHY:HSPEed:BATCh:END Sets or returns the end value of the selected

batch mode parameter type.
CPHY:HSPEed:BATCh:INCRement Sets or returns the increment value of the

selected batch mode parameter type.
CPHY:HSPEed:BATCh:WAVEformNo? (Query
only)

Returns the total number of waveforms that will
be generated in the batch mode.

Preferences group commands

Commands Description
CPHY:PREFerence:SRATe:MODE Sets or returns the sample rate mode.
CPHY:PREFerence:SAMPlesperui Sets or returns the value of the Samples Per

Unit Interval (SPUI).
CPHY:PREFerence:SRATe:VALUe? (Query
only)

Returns the sample rate for High Speed and
Low Power.

CPHY:PREFerence:SAMPlesperui:HIGH Sets or returns the samples per unit interval of
High speed signal.

CPHY:PREFerence:SAMPlesperui:LOW Sets or returns the samples per unit interval of
Low power signal.

CPHY:PREFerence:SRATe:HIGH:VALUe?
(Query only)

Returns the sample rate of High speed signal.

CPHY:PREFerence:SRATe:LOW:VALUe?
(Query only)

Returns the sample rate of Low power signal

CPHY:PREFerence:SKEW:ACLIne Sets or returns the skew value of Line A to Line
C.

CPHY:PREFerence:SKEW:ABLIne Sets or returns the skew value of Line A to Line
B.

CPHY:PREFerence:AWGAmplitude:MODE Sets or returns the amplitude and offset control
mode.

CPHY:PREFerence:AWGAmplitude:OFFSet:VA
LUe

Sets or returns the offset value.

CPHY:PREFerence:AWGAmplitude:AMPLitude:
VALUe

Sets or returns the amplitude value.

CPHY:PREFerence:STARtupsignal:ENABle Enables or disables the startup signal.
CPHY:PREFerence:STARtupsignal:LINEA Sets or returns the startup signal for line A.
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Commands Description
CPHY:PREFerence:STARtupsignal:LINEB Sets or returns the startup signal for line B.
CPHY:PREFerence:STARtupsignal:LINEC Sets or returns the startup signal for line C.

Compile settings group commands

Commands Description
CPHY:CSETtings:WAVEform:SEQUence Sets or returns the name of the sequence.
CPHY:CSETtings:WAVEform:NAME Sets or returns the name of the waveform.
CPHY:CSETtings:WAVEform:OVERwrite Enables or disables waveform overwrite.
CPHY:CSETtings:COMPile Sets or returns the type of compile option.
CPHY:CSETtings:SWITchlogview Enables or disables switch log view.
CPHY:CSETtings:MASTer:CHONe Sets or returns the line waveform of master

channel one.
CPHY:CSETtings:MASTer:CHTWo Sets or returns the line waveform of master

channel two.
CPHY:CSETtings:SLAVe:ENABle Enables or disables the value to enable or

disable the slave.
CPHY:CSETtings:SLAVe:IPADDress Sets or returns the slave IP address.
CPHY:CSETtings:SLAVe:CHONe Sets or returns the line waveform of slave

channel one.
CPHY:CSETtings:SLAVe:CHTWo Sets or returns the line waveform of Slave

channel two.
CPHY:CSETtings:SLAVe:ISCOnnected Sets or returns the value to connect/disconnect

the slave.
CPHY:CSETtings:WAVEform:APPEND Enables or disables the option to append the

waveform sequence in AWG.
CPHY:PREFerence:CORRection:ENABle Enables or disables the application of correction

file.
CPHY:PREFerence:CORRection:MASTer:CHO
ne:ENABle

Enables or disables the application of correction
file on master channel one.

CPHY:PREFerence:CORRection:MASTer:CHT
wo:ENABle

Enables or disables the application of correction
file on master channel two.

CPHY:PREFerence:CORRection:MASTer:CHO
ne:FILE

Sets or returns the correction file path of master
channel one.

CPHY:PREFerence:CORRection:MASTer:CHT
wo:FILE

Sets or returns the correction file path of master
channel two.

CPHY:PREFerence:CORRection:SLAVe:CHOn
e:ENABle

Sets or returns the correction file path of slave
channel one.

CPHY:PREFerence:CORRection:SLAVe:CHTW
o:ENABle

Enables or disables the application of correction
file on Master channel two.
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Commands Description
CPHY:PREFerence:CORRection:SLAVe:CHOn
e:FILE

Sets or returns the correction file path of slave
channel one.

CPHY:PREFerence:CORRection:SLAVe:CHTw
o:FILE

Sets or returns the correction file path of slave
channel two.

CPHY:PREFerence:CORRection:REMOve Enables or disables the removal of Sin(x)/x
distortions from correction file.

CPHY:PREFerence:CORRection:GAUSsian Enables or disables application of Gaussian
filter.

CPHY:PREFerence:CORRection:GAUSsian:BA
NDwidth

Sets and returns the Gaussian bandwidth.

CPHY:PREFerence:CORRection:AALL Enables or disables the application of correction
file of Master channel one to all channels.

CPHY:LOGView? Returns the log view contents.

Miscellaneous group commands

Commands Description
CPHY:SIGNal Sets or returns the signal mode.
CPHY:VERSion? (Query only) Sets or returns CPHYXpress version number.
CPHY:COMPile (No Query form) Initiates to compile the waveform.
CPHY:COMPile:CANCel (no Query form) Cancels compilation.
CPHY:RESEt (No Query only) Resets the plugin settings to default settings.
WMODUle:ACTive (No Query form) Sets or returns the active waveform plugin.

Enables to launch the application.
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Command description

CPHY:HSPEed:PATTern
This command sets or returns the High Speed base pattern type.

Condition Signal mode should be High Speed.

Group High Speed

Syntax CPHY:HSPEed:PATTern {PRBS7|PRBS9_CPHY|PRBS11_CPHY|
PRBS18_CPHY|TEXT|SYM|WSTATE}

CPHY:HSPEed:PATTern?

Related commands CPHY:HSPEed:CUSTom:FILE

Returns PRBS7

PRBS9_CPHY

PRBS11_CPHY

PRBS18_CPHY

TEXT

SYM

WSTATE
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Arguments {PRBS7|PRBS9_CPHY|PRBS11_CPHY|PRBS18_CPHY|TEXT|SYM|
WSTATE}.

Example CPHY:HSPEed:PATTern PRBS7 sets the base pattern as PRBS7 for waveform
generation.

CPHY:HSPEed:PATTern? returns the base pattern type as PRBS7 for the
waveform generation.

CPHY:HSPEed:CUSTom:FILE
This command sets or returns the custom base pattern file path.

Condition The custom base pattern file should be available.

The custom base pattern file should be in one of the format.

■ Bit File (.txt)
■ Symbol File (.sym)
■ Wire state file (.wstate)

Group High Speed

Syntax CPHY:HSPEed:CUSTom:FILE <path>

CPHY:HSPEed:CUSTom:FILE?

Related commands CPHY:HSPEed:PATTern

Arguments <path of the file>
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Returns <path of the file>

Example CPHY:HSPEed:CUSTom:FILE "C:\Users\Public\Tektronix\CPHYXpress
\DataFiles\Custom.txt" sets the custom pattern file path.

CPHY:HSPEed:CUSTom:FILE? returns the custom pattern file path.

CPHY:HSPEed:SRATe
This command sets or returns the symbol rate for High Speed Base Pattern.

Condition Signal mode should be High Speed.

Group High Speed

Syntax CPHY:HSPEed:SRATe <NR2>

CPHY:HSPEed:SRATe?

Arguments A single <NR2> value.

Range: {0.05 to 5 GS/s}.

Returns A single <NR2> value, {0.05 to 5 GS/s}.

Related commands CPHY:HSPEed:RTFT:VALUe

Example CPHY:HSPEed:SRATe 2.5E+9 sets the high speed symbol rate to 2.5 Gsps.

CPHY:HSPEed:SRATe? returns 2.5 Gsps as high speed symbol rate.
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CPHY:HSPEed:RTFT:VALUe
This command sets or returns the rise and fall time of the signal for High Speed
base pattern.

Condition Signal mode should be High Speed.

Group High Speed

Syntax CPHY:HSPEed:RTFT:VALUe <NR2>

CPHY:HSPEed:RTFT:VALUe?

Arguments A single <NR2> value.

Range: 0 to 0.5 

Returns A single <NR2> value, {0 to 0.5}

Related commands CPHY:HSPEed:RTFT:SECOnds

Example CPHY:HSPEed:RTFT:VALUe 0.5 sets the rise and fall time of the signal to
0.5 UI.

CPHY:HSPEed:RTFT:VALUe? returns 0.5 as rise and fall time of the signal.
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CPHY:HSPEed:RTFT:SECOnds? (Query only)
This command gets the rise/fall time of the signal in seconds.

Condition Signal mode should be High Speed.

Group High Speed

Syntax CPHY:HSPEed:RTFT:SECOnds?

Returns A single <NRf> value.

Related commands CPHY:HSPEed:RTFT:VALUe

Example CPHY:HSPEed:RTFT:SECOnds? returns the rise/fall time of the signal in
seconds.

CPHY:HSPEed:PRBS:SEED
This command sets or returns the PRBS seed value.

Condition Applicable only for PRBS9_CPHY, PRBS11_CPHY,PRBS18_CPHY.

A seed value set as "0000" is invalid.

Group High Speed
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Syntax CPHY:HSPEed:PRBS:SEED <seed>

CPHY:HSPEed:PRBS:SEED?

Arguments <seed>::= <string>

{"0000" to "FFFF"}

Returns A string value indicating the seed value.

Returns a seed value between {"0000" to "FFFF"} as a hexadecimal string.

Related commands CPHY:HSPEed:PATTern

Example CPHY:HSPEed:PRBS:SEED "F27A" sets the PRBS value to 0xF27A.

CPHY:HSPEed:PRBS:SEED? returns the PRBS value.

CPHY:HSPEed:LINEA:HIGH
This command sets or returns the high-level voltage of line A waveform.

Condition Signal mode should be High Speed.

Group High Speed

Syntax CPHY:HSPEed:LINEA:HIGH <NR1>

CPHY:HSPEed:LINEA:HIGH?
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Arguments A single <NR1> value.

Range: {0 to 600 mV}.

Range depends on the Low value of line A.

Returns A single <NR1> value.

Related commands CPHY:HSPEed:LINEA:LOW

Example CPHY:HSPEed:LINEA:HIGH 400E-3 sets the line A high level voltage for the
waveform to 400 mV.

CPHY:HSPEed:LINEA:HIGH? returns 400 mV as the line A high level voltage
for the waveform.

CPHY:HSPEed:LINEA:LOW
This command sets or returns the low level voltage of the waveform for line A.

Condition Signal mode should be High Speed.

Group High Speed

Syntax CPHY:HSPEed:LINEA:LOW <NR1>

CPHY:HSPEed:LINEA:LOW?

Arguments A single <NR1> value.

Range:{-100 to 400 mV (Range depends on the High value of line A)}.
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Returns A single <NR1> value.

{-100 to 400 (Range depends on the High value of line A)}.

Related commands CPHY:HSPEed:LINEA:HIGH

Example CPHY:HSPEed:LINEA:LOW -100E-3 sets the low level voltage for line A
waveform to -100 mV.

CPHY:HSPEed:LINEA:LOW? returns -100 mV as the low level voltage for line
A waveform.

CPHY:HSPEed:LINEA:MID? (Query only)
This command returns the mid level voltage of line A waveform .

Condition Signal mode should be High Speed.

Group High Speed

Syntax CPHY:HSPEed:LINEA:MID?

Arguments A single <NR1> value.

Range: {-50 to 500 mV}.

Range depends on the High and Low voltage value of line A.

Returns A single <NR2> value, {-50 to 500 mV}.
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Related commands CPHY:HSPEed:LINEA:HIGH

CPHY:HSPEed:LINEA:LOW

Example CPHY:HSPEed:LINEA:MID? returns the mid level voltage of line A waveform.

CPHY:HSPEed:LINEB:HIGH
This command sets or returns the high level voltage of line B waveform.

Condition Signal mode should be High Speed.

Group High Speed

Syntax CPHY:HSPEed:LINEB:HIGH?

CPHY:HSPEed:LINEB:HIGH <NR1>

Arguments A single <NR1> value.

Range: {0 to 600 mV}.

Returns A single <NR1> value, {0 to 600 mV}.

Related commands CPHY:HSPEed:LINEB:LOW

Example CPHY:HSPEed:LINEB:HIGH 600E-3 sets the high level voltage of line B
waveform to 600 mV.

CPHY:HSPEed:LINEB:HIGH? returns 600 as the high level voltage of line B
waveform.
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CPHY:HSPEed:LINEB:LOW
This command sets or returns the low level voltage of line B waveform.

Condition Signal mode should be High Speed.

Group High Speed

Syntax CPHY:HSPEed:LINEB:LOW <NR1>

CPHY:HSPEed:LINEB:LOW?

Arguments A single <NR1> value.

Range: {-100 to 400 mV}.

Range depends on High value of line B.

Returns A single <NR1> value, {-100 to 400 mV (Range depends on High value of line
B)}.

Related commands CPHY:HSPEed:LINEB:HIGH

Example CPHY:HSPEed:LINEB:LOW - 100E-3 sets the low level voltage of line B
waveform to -100 mV.

CPHY:HSPEed:LINEB:LOW? returns -100 as the low level voltage for line B
waveform.
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CPHY:HSPEed:LINEB:MID? (Query only)
This command returns the mid level voltage of line B waveform.

Condition Signal mode should be High Speed.

Group High Speed

Syntax CPHY:HSPEed:LINEB:MID?

Returns A single <NR1> value.

Related commands CPHY:HSPEed:LINEB:HIGH

Example CPHY:HSPEed:LINEB:MID? returns the mid level voltage for the line B
waveform.

CPHY:HSPEed:LINEC:HIGH
This command sets or returns the high level voltage of line C waveform.

Condition Signal mode should be High Speed.

Group High Speed
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Syntax CPHY:HSPEed:LINEC:HIGH <NR1>

CPHY:HSPEed:LINEC:HIGH?

Arguments A single <NR1> value.

Range: {0 to 600 mV}.

Returns A single <NR1> value, {0 to 600 mV (High level voltage is dependent on Low
level voltage)}.

Related commands CPHY:HSPEed:LINEC:LOW

Example CPHY:HSPEed:LINEC:HIGH 600E-3 sets the high level voltage of line C
waveform to 600 mV.

CPHY:HSPEed:LINEC:HIGH? returns 600 as the high level voltage of line C
waveform.

CPHY:HSPEed:LINEC:LOW
This command sets or returns the low level voltage of line C waveform.

Condition Signal mode should be High Speed.

Group High Speed

Syntax CPHY:HSPEed:LINEC:LOW <NR1>

CPHY:HSPEed:LINEC:LOW?
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Arguments A single <NR1> value.

Range: (-100 to 400 mV).

Range depends on the High level voltage of line C.

Returns A single <NR1> value, {-100 to 400 mV}

Related commands CPHY:HSPEed:LINEC:HIGH

Example CPHY:HSPEed:LINEC:LOW -100E-3 sets the low level voltage of line C
waveform to -100 mV.

CPHY:HSPEed:LINEC:LOW? returns -100 as the low level voltage of line C
waveform.

CPHY:HSPEed:LINEC:MID? (Query only)
This command returns the mid level voltage of line C waveform.

Condition Signal mode should be High Speed.

Group High Speed

Syntax CPHY:HSPEed:LINEC:MID?

Returns A single <NR1> value.
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Related commands CPHY:HSPEed:LINEC:HIGH

Example CPHY:HSPEed:LINEC:MID? returns the mid level voltage of line C waveform.

CPHY:HSPEed:USELevels
This command sets or returns the state of use line A levels for line B and line C.

Group High Speed

Syntax CPHY:HSPEed:USELevels {0|1}

CPHY:HSPEed:USELevels?

Arguments {0|1}

1 enables the use of line A level for both line B and line C.

0 disables the use of line A level for line B and line C.

Returns A single <Boolean> value, {0|1}.

Related commands CPHY:HSPEed:LINEA:HIGH

Example CPHY:HSPEed:USELevels 1 sets the use line A level to line B and line C.

CPHY:HSPEed:USELevels? returns 1 indicating "Use Line A levels for Line B
and Line C" is enabled.
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CPHY:HSPEed:REPEat16bit
This command enables or disables the option to repeat the input base pattern to a
16-bit boundary.

Group High Speed

Syntax CPHY:HSPEed:REPEat16bit {0|1}

CPHY:HSPEed:REPEat16bit?

Arguments {0|1}

1 repeats the base pattern to a 16 bit boundary.

0 base pattern is not repeated.

Returns A single <Boolean> value, {0 or 1}.

Related commands CPHY:HSPEed:PRBS:SEED

Example CPHY:HSPEed:REPEat16bit 1 enables the option "Repeat to a 16-bit boundary".

CPHY:HSPEed:REPEat16bit? returns 1 indicating "Repeat to a 16-bit boundary"
is enabled.
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CPHY:HSPEed:WIREstate
This command sets or returns the wire state type.

Condition Signal mode should be High Speed.

Group High Speed

Syntax CPHY:HSPEed:WIREstate {PLUSX|MINUSX|PLUSY|MINUSY|PLUSZ|
MINUSZ}

CPHY:HSPEed:WIREstate?

Related commands CPHY:HSPEed:CUSTom:FILE

Returns PLUSX

MINUSX

PLUSY

MINUSY

PLUSZ

MINUSZ

Arguments {PLUSX|MINUSX|PLUSY|MINUSY|PLUSZ|MINUSZ}

Example CPHY:HSPEed:WIREstate PLUSX sets the wire state as PLUSX.

CPHY:HSPEed:WIREstate? returns the wire state as PLUSX.
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CPHY:HSPEed:JITTer:PJ:ENABle
This command enables or disables the periodic jitter.

Group High Speed Jitter

Syntax CPHY:HSPEed:JITTer:PJ:ENABle {0|1}

CPHY:HSPEed:JITTer:PJ:ENABle?

Related commands CPHY:HSPEed:JITTer:PJ:VALUe

Arguments {0|1}

0 disables the periodic jitter.

1 enables the periodic jitter.

Returns A single <Boolean> value, {0|1}

Example CPHY:HSPEed:JITTer:PJ:ENABle 1 enables the periodic jitter.

CPHY:HSPEed:JITTer:PJ:ENABle? returns 1 indicating periodic jitter is
enabled.
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CPHY:HSPEed:JITTer:PJ:VALUe
This command sets or returns periodic jitter value.

Condition Periodic Jitter should be enabled.

Group High Speed Jitter

Syntax CPHY:HSPEed:JITTer:PJ:VALUe?

CPHY:HSPEed:JITTer:PJ:VALUe <NR2>

Arguments A single <NR2> value

Range: {0 to 1}

Returns A single <NR2> value, {0 to 1}

Related commands CPHY:HSPEed:JITTer:PJ:ENABle

Example CPHY:HSPEed:JITTer:PJ:VALUe 1 sets the periodic jitter value to 1 UI.

CPHY:HSPEed:JITTer:PJ:VALUe? returns 1 as periodic jitter value.
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CPHY:HSPEed:JITTer:PJ:FREQuency:VALUe
This command sets or returns the periodic jitter frequency value.

Condition Periodic Jitter should be selected.

Group High Speed Jitter

Syntax CPHY:HSPEed:JITTer:PJ:FREQuency:VALUe <NRf>

CPHY:HSPEed:JITTer:PJ:FREQuency:VALUe?

Related commands CPHY:HSPEed:JITTer:PJ:ENABle

CPHY:HSPEed:JITTer:PJ:VALUe

Arguments A single <NRf> value.

Range: {100E3 to 300E6}

Returns A single <NRf> value, {100E3 to 300E6}.

Example CPHY:HSPEed:JITTer:PJ:FREQuency:VALUe 100E3 sets the periodic jitter
frequency value to 100 kHz.

CPHY:HSPEed:JITTer:PJ:FREQuency:VALUe? returns 100E3 as periodic jitter
frequency value.

 Command description

103



CPHY:HSPEed:JITTer:RJ:ENABle
This command sets or returns random jitter.

Group High Speed Jitter

Syntax CPHY:HSPEed:JITTer:RJ:ENABle?

CPHY:HSPEed:JITTer:RJ:ENABle {0|1}

Related commands CPHY:HSPEed:JITTer:RJ:VALUe

Arguments {0|1}

0 disables the use of random jitter.

1 enables the use of random jitter.

Returns A single <Boolean> value, {0|1}

Example CPHY:HSPEed:JITTer:RJ:ENABle 1 sets the random jitter to 1.

CPHY:HSPEed:JITTer:RJ:ENABle? returns 1 indicating random jitter is
enabled.
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CPHY:HSPEed:JITTer:RJ:VALUe
This command sets or returns the random jitter value of high speed jitter
waveform.

Condition Periodic Jitter should be enabled.

Group High Speed Jitter

Syntax CPHY:HSPEed:JITTer:RJ:VALUe?

CPHY:HSPEed:JITTer:RJ:VALUe <NR2>

Related commands CPHY:HSPEed:JITTer:RJ:ENABle

Arguments A single <NR2> value.

Range: {0 to 0.3}.

Resolution of 1E-3.

Returns A single <NR2> value, {0 to 0.3}.

Resolution of 1E-3.

Example CPHY:HSPEed:JITTer:RJ:VALUe sets the random jitter value to 0.2 UI.

CPHY:HSPEed:JITTer:RJ:VALUe? returns 200E-03 as random jitter value.

 Command description

105



CPHY:HSPEed:JITTer:DCD:ENABle
This command enables or disables the duty cycle distortion.

Group High Speed Jitter

Syntax CPHY:HSPEed:JITTer:DCD:ENABLE {0|1}

CPHY:HSPEed:JITTer:DCD:ENABle?

Related commands CPHY:HSPEed:JITTer:DCD:VALUe

Arguments {0|1}

0 disables duty cycle distortion.

1 enables duty cycle distortion.

Returns A single <Boolean> value, {0|1}.

Example CPHY:HSPEed:JITTer:DCD:ENABLE 1 enables duty cycle distortion.

CPHY:HSPEed:JITTer:DCD:ENABLE? returns 1 indicating duty cycle
distortion is enabled.
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CPHY:HSPEed:JITTer:DCD:VALUe
This command sets or returns the value of duty cycle distortion.

Condition DCD should be enabled.

Group High Speed Jitter

Syntax CPHY:HSPEed:JITTer:DCD:VALUe?

CPHY:HSPEed:JITTer:DCD:VALUe <NR1>

Related commands CPHY:HSPEed:JITTer:DCD:ENABle

Arguments A single <NR1> value.

Range: {0 % to 40 %}.

Returns A single <NR1> value, {0 to 40}.

Example CPHY:HSPEed:JITTer:DCD:VALUe 30 sets the value of duty cycle distortion to
30 %.

CPHY:HSPEed:JITTer:DCD:VALUe? returns 40 % as duty cycle distortion
value.
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CPHY:HSPEed:JITTer:DCD:LINEA:ENABle
This command sets or returns the duty cycle distortion for line A.

Condition DCD should be selected.

Group High Speed Jitter

Syntax CPHY:HSPEed:JITTer:DCD:LINEA:ENABle?

CPHY:HSPEed:JITTer:DCD:LINEA:ENABle {0|1}

Arguments {0|1}

0 disables the use of duty cycle distortion for line A.

1 enables the use of the duty cycle distortion for line A.

Returns A single <Boolean> value, {0|1}

Related commands CPHY:HSPEed:JITTer:DCD:LINEB:ENABle

CPHY:HSPEed:JITTer:DCD:LINEC:ENABle

Example CPHY:HSPEed:JITTer:DCD:LINEA:ENABle 1 sets the duty cycle distortion for
line A.

CPHY:HSPEed:JITTer:DCD:LINEA:ENABle? returns 1 as the duty cycle
distortion for line A.
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CPHY:HSPEed:JITTer:DCD:LINEB:ENABle
This command sets or returns duty cycle distortion for line B.

Condition DCD should be enabled.

Group High Speed Jitter

Syntax CPHY:HSPEed:JITTer:DCD:LINEB:ENABle {0|1}

CPHY:HSPEed:JITTer:DCD:LINEB:ENABle?

Arguments {0|1}

0 disables the use of duty cycle distortion for line B.

1 enables the use of duty cycle distortion for line B.

Returns A single <Boolean> value, {0|1}.

Related commands CPHY:HSPEed:JITTer:DCD:LINEA:ENABle
CPHY:HSPEed:JITTer:DCD:LINEC:ENABle

Example CPHY:HSPEed:JITTer:DCD:LINEB:ENABle 1 sets the duty cycle distortion for
line B.

CPHY:HSPEed:JITTer:DCD:LINEB:ENABle? returns 1 indicating duty cycle
distortion is enabled for line B.
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CPHY:HSPEed:JITTer:DCD:LINEC:ENABle
This command sets or returns the duty cycle distortion for line C.

Condition DCD should be selected.

Group High Speed Jitter

Syntax CPHY:HSPEed:JITTer:DCD:LINEC:ENABle {0|1}

CPHY:HSPEed:JITTer:DCD:LINEC:ENABle?

Arguments {0|1}

0 disables the use of duty cycle distortion for line C.

1 enables the use of duty cycle distortion for line C.

Returns A single <boolean> value, {0|1}.

Related commands CPHY:HSPEed:JITTer:DCD:LINEB:ENABle

CPHY:HSPEed:JITTer:DCD:LINEA:ENABle

Example CPHY:HSPEed:JITTer:DCD:LINEC:ENABle 1 sets the duty cycle distortion for
line C.

CPHY:HSPEed:JITTer:DCD:LINEC:ENABle? returns 1 as indicating duty cycle
distortion is enabled for line C.
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CPHY:HSPEed:JITTer:DCD:RANDomdistortion:ENABle
This command sets or returns the random distortion.

Condition DCD should be selected.

Group High Speed Jitter

Syntax CPHY:HSPEed:JITTer:DCD:RANDomdistortion:ENABle {0|1}

CPHY:HSPEed:JITTer:DCD:RANDomdistortion:ENABle?

Arguments {0|1}

0 disables the creation of random distortion.

1 enables the creation of random distortion.

Returns A single <Boolean> value, {0|1}.

Related commands CPHY:HSPEed:JITTer:DCD:ENABle

Example CPHY:HSPEed:JITTer:DCD:RANDomdistortion:ENABle 1 sets the random
distortion.

CPHY:HSPEed:JITTer:DCD:RANDomdistortion:ENABle? returns 1 indicating
that random distortion is enabled.
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CPHY:HSPEed:JITTer:SINE:ENABle
This command enables or disables the sine noise.

Group High Speed Jitter

Syntax CPHY:HSPEed:JITTer:SINE:ENABle {0|1}

CPHY:HSPEed:JITTer:SINE:ENABle?

Related commands CPHY:HSPEed:JITTer:SINE:AMPLitude

CPHY:HSPEed:JITTer:SINE:FREQuency

Arguments {0|1}

0 disables the sine noise.

1 enables the sine noise.

Returns A single <Boolean> value, {0|1}.

Example CPHY:HSPEed:JITTer:SINE:ENABle 1 enables the sine noise.

CPHY:HSPEed:JITTer:SINE:ENABle? returns 1 indicating sine noise is enabled.
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CPHY:HSPEed:JITTer:SINE:AMPLitude
This command sets or returns the sine noise amplitude value.

Condition Sine Noise should be selected.

Group High Speed Jitter

Syntax CPHY:HSPEed:JITTer:SINE:AMPLitude <NRf>

CPHY:HSPEed:JITTer:SINE:AMPLitude?

Related commands CPHY:HSPEed:JITTer:SINE:ENABle

Arguments A single <NRf> value.

Range: (0 to 50E-3).

Resolution of 1E-3.

Returns A single <NRf> value, (0 to 50E-3), resolution of 1E-3.

Example CPHY:HSPEed:JITTer:SINE:AMPLitude 50E-3 sets the sine amplitude value to
50 mV.

CPHY:HSPEed:JITTer:SINE:AMPLitude? returns 50E-03 as sine noise
amplitude value.
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CPHY:HSPEed:JITTer:SINE:FREQuency
This command sets or returns the sine noise frequency value.

Condition Sine Noise should be selected.

Group High Speed Jitter

Syntax CPHY:HSPEed:JITTer:SINE:FREQuency <NRf>

CPHY:HSPEed:JITTer:SINE:FREQuency?

Related commands CPHY:HSPEed:JITTer:SINE:ENABle

Arguments A single <NRf> value.

Range: {100E+3 to 1.5E+9}.

Returns A single <NRf> value, {100E+3 to 1.5E+9}.

Example CPHY:HSPEed:JITTer:SINE:FREQuency 100E+3 sets the sine frequency value
to 100 KHz.

CPHY:HSPEed:JITTer:SINE:FREQuency? returns 100E+3 as sine frequency
value.
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CPHY:HSPEed:JITTer:EMBEd:ENABle
This command enables or disables channel embedding.

Group High Speed Jitter

Syntax CPHY:HSPEed:JITTer:EMBEd:ENABle {0|1}

CPHY:HSPEed:JITTer:EMBEd:ENABle?

Related commands CPHY:HSPEed:JITTer:EMBEd:TYPE

Arguments {0|1}

0 disables channel embedding.

1 enables channel embedding.

Returns A single <NR1> value, {0|1}

Example CPHY:HSPEed:JITTer:EMBEd:ENABle 1 enables channel embedding.

CPHY:HSPEed:JITTer:EMBEd:ENABle? returns 1 indicating channel
embedding is enabled.
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CPHY:HSPEed:JITTer:EMBEd:TYPE
This command sets or returns the type of channel embedding.

Condition Embed Channel should be selected.

Group High Speed Jitter

Syntax CPHY:HSPEed:JITTer:EMBEd:TYPE {FLT|SPRM}

CPHY:HSPEed:JITTer:EMBEd:TYPE?

Related commands CPHY:HSPEed:JITTer:EMBEd: ENABle

Arguments FLT sets channel embed type to Filter.

SPRM sets channel embed type to S-Parameter.

Returns FLT

SPRM

Example CPHY:HSPEed:JITTer:EMBEd:TYPE FLT sets the channel embed type to
Filter.

CPHY:HSPEed:JITTer:EMBEd:TYPE? returns FLT as channel embed type.
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CPHY:HSPEed:JITTer:EMBEd:FILTer:LINEA
This command sets or returns line A channel filter file path.

Condition Embed Channel and Filter Files should be selected.

Group High Speed Jitter

Syntax CPHY:HSPEed:JITTer:EMBEd:FILTer:LINEA <file_name>

CPHY:HSPEed:JITTer:EMBEd:FILTer:LINEA?

Related commands CPHY:HSPEed:JITTer:EMBEd:TYPE

Arguments File path

Returns File path.

Example CPHY:HSPEed:JITTer:EMBEd:FILTer:LINEA "C:\Users\Public\Tektronix
\CPHYXpress\DataFiles\ ChannelFilter_A.flt" sets the line A channel filter file.

CPHY:HSPEed:JITTer:EMBEd:FILTer:LINEA? returns "C:\Users\Public
\Tektronix\CPHYXpress\DataFiles\ChannelFilter_A.flt". as line A channel filter
file.
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CPHY:HSPEed:JITTer:EMBEd:FILTer:LINEB
This command sets or returns line B channel filter file path.

Condition Embed Channel and Filter Files should be selected.

Group High Speed Jitter

Syntax CPHY:HSPEed:JITTer:EMBEd:FILTer:LINEB <file_name>

CPHY:HSPEed:JITTer:EMBEd:FILTer:LINEB?

Related commands CPHY:HSPEed:JITTer:EMBEd:TYPE

Arguments File path.

Returns File path.

Example CPHY:HSPEed:JITTer:EMBEd:FILTer:LINEB "C:\Users\Public\Tektronix
\CPHYXpress\DataFiles\ ChannelFilter_B.flt" sets the line B channel filter file.

CPHY:HSPEed:JITTer:EMBEd:FILTer:LINEB? returns "C:\Users\Public
\Tektronix\CPHYXpress\DataFiles\ChannelFilter_B.flt" as line B channel filter
file path.
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CPHY:HSPEed:JITTer:EMBEd:FILTer:LINEC
This command sets or returns line C filter file path.

Condition Embed Channel and Filter Files should be selected.

Group High Speed Jitter

Syntax CPHY:HSPEed:JITTer:EMBEd:FILTer:LINEC <file_name>

CPHY:HSPEed:JITTer:EMBEd:FILTer:LINEC?

Related commands CPHY:HSPEed:JITTer:EMBEd:TYPE

Arguments File path.

Returns File path.

Example CPHY:HSPEed:JITTer:EMBEd:FILTer:LINEC "C:\Users\Public\Tektronix
\CPHYXpress\DataFiles\ ChannelFilter_C.flt" sets the line C channel filter file.

CPHY:HSPEed:JITTer:EMBEd:FILTer:LINEC? returns "C:\Users\Public
\Tektronix\CPHYXpress\DataFiles\ChannelFilter_C.flt" as line C channel filter
file.
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CPHY:HSPEed:JITTer:EMBEd:FILTer:APPLybc
This command enables or disables the use of line A channel filter file for line B
and line C.

Condition Embed Channel and Filter Files should be enabled.

Group High Speed Jitter

Syntax CPHY:HSPEed:JITTer:EMBEd:FILTer:APPLybc {0|1}

CPHY:HSPEed:JITTer:EMBEd:FILTer:APPLybc?

Related commands CPHY:HSPEed:JITTer:EMBEd:FILTer:LINEA

Arguments {0|1}

1 enables the use of Line A filter file for line B and line C.

0 disables the use of Line A filter file for line B and line C.

Returns A single <Boolean> value, {0|1}.

Example CPHY:HSPEed:JITTer:EMBEd:FILTer:APPLybc 1 enables the use of line A
filter file for line B and line C.

CPHY:HSPEed:JITTer:EMBEd:FILTer:APPLybc? returns 1 indicating 'Apply
Line A filter file for Line B and Line C' is enabled.
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CPHY:HSPEed:JITTer:EMBEd:SPARameter:MODE
This command sets or returns the S-parameter type.

Condition Embed channel and S-Parameter File should be selected.

Group High Speed Jitter

Syntax CPHY:HSPEed:JITTer:EMBEd:SPARameter:MODE {EMBD or embd}

CPHY:HSPEed:JITTer:EMBEd:SPARameter:MODE?

Related commands CPHY:HSPEed:JITTer:EMBEd: ENABle

Arguments EMBD or embd.

Returns EMBD.

Example CPHY:HSPEed:JITTer:EMBEd:SPARameter:MODE EMBD sets S-Parameter
type to Embed.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:MODE? returns EMBD as S-
Parameter type.
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CPHY:HSPEed:JITTer:EMBEd:SPARameter:BANDwidth:MODE
This command sets or returns the S-Parameter bandwidth mode.

Condition Embed Channel and S-Parameter File should be selected.

Group High Speed Jitter

Syntax CPHY:HSPEed:JITTer:EMBEd:SPARameter:BANDwidth:MODE {NONE|
AUTO|CUST}

CPHY:HSPEed:JITTer:EMBEd:SPARameter:BANDwidth:MODE?

Related commands CPHY:HSPEed:JITTer:EMBEd:SPARameter:MODE

Arguments NONE sets S Parameter bandwidth type to None.

AUTO sets S Parameter bandwidth type to Auto.

CUST sets S Parameter bandwidth type to Custom.

Returns NONE

AUTO

CUST

Example CPHY:HSPEed:JITTer:EMBEd:SPARameter:BANDwidth:MODE CUST sets
the S-Parameter bandwidth type to Custom.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:BANDwidth:MODE? returns Cust
as S-Parameter bandwidth type.
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CPHY:HSPEed:JITTer:EMBEd:SPARameter:BANDwidth:CUST
This command sets or returns the custom value for S-Parameter bandwidth.

Condition Embed Channel and FLT Files should be selected.

Group High Speed Jitter

Syntax CPHY:HSPEed:JITTer:EMBEd:SPARameter:BANDwidth:CUST <NRf>

CPHY:HSPEed:JITTer:EMBEd:SPARameter:BANDwidth:CUST?

Related commands CPHY:HSPEed:JITTer:EMBEd:SPARameter:BANDwidth:MODE

Arguments A single <NRf> value.

Range is dependent on Sample Rate.

Returns A single <NRf> value.

Example CPHY:HSPEed:JITTer:EMBEd:SPARameter:BANDwidth:CUST sets the
custom value for S-Parameter bandwidth.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:BANDwidth:CUST? returns the
custom value for S-Parameter bandwidth.
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CPHY:HSPEed:JITTer:EMBEd:SPARameter:PORT
This command sets or returns the S-Parameter file type.

Condition Embed Channel and S-Parameter file should be selected.

Group High Speed Jitter

Syntax CPHY:HSPEed:JITTer:EMBEd:SPARameter:PORT {S2P|S4SE|S6P}

CPHY:HSPEed:JITTer:EMBEd:SPARameter:PORT?

Related commands CPHY:HSPEed:JITTer:EMBEd:SPARameter:MODE

Arguments S2P sets S-parameter file type to 2 port S-Parameter file type.

S4SE sets S-parameter file type to 4 port Single Ended S-Parameter file type.

S6P sets S-parameter file type to 6 port S-parameter file type.

Returns S2P

S4SE

S6P

Example CPHY:HSPEed:JITTer:EMBEd:SPARameter:PORT S2P sets S-Parameter file
type to S2P.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:PORT? returns S2P as S-
Parameter file type.
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CPHY:HSPEed:JITTer:EMBEd:SPARameter:STWO:LINEA:INPUt
This command sets or returns the line A input port in 2 port S-Parameter mode.

Condition Embed Channel and S-Parameter File should be selected. S-Parameter file type
should be S2P.

Group High Speed Jitter

Syntax CPHY:HSPEed:JITTer:EMBEd:SPARameter:STWO:LINEA:INPUt {P1|P2}

CPHY:HSPEed:JITTer:EMBEd:SPARameter:STWO:LINEA:INPUt?

Related commands CPHY:HSPEed:JITTer:EMBEd:SPARameter:STWO:LINEA:OUTPut

Arguments P1 sets the Line A input port to Port1 in S2P mode.

P2 sets the Line A input port to Port2 in S2P mode.

Returns P1

P2

Example CPHY:HSPEed:JITTer:EMBEd:SPARameter:STWO:LINEA:INPUt P1 sets the
line A input port to Port1 in S2P mode.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:STWO:LINEA:INPUt? returns P1
as line A input port in S2P mode.
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CPHY:HSPEed:JITTer:EMBEd:SPARameter:STWO:LINEA:OUTPut
This command sets or returns the line A output port in 2 port S-Parameter mode.

Condition Embed Channel and S-Parameter File should be selected. S-Parameter file type
should be S2P.

Group High Speed Jitter

Syntax CPHY:HSPEed:JITTer:EMBEd:SPARameter:STWO:LINEA:OUTPut {P1|P2}

CPHY:HSPEed:JITTer:EMBEd:SPARameter:STWO:LINEA:OUTPut?

Related commands CPHY:HSPEed:JITTer:EMBEd:SPARameter:STWO:LINEA:INPUt

Arguments P1 sets the line A output port to Port1 in S2P mode.

P2 sets the line A output port to Port2 in S2P mode.

Returns P1

P2

Example CPHY:HSPEed:JITTer:EMBEd:SPARameter:STWO:LINEA:OUTPut P1 sets
the line A output port to Port1 in S2P mode.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:STWO:LINEA:OUTPut? returns
P1 as line A output port in S2P mode.
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CPHY:HSPEed:JITTer:EMBEd:SPARameter:STWO:LINEB:INPUt
This command sets or returns the line B input port in 2 port S-Parameter mode.

Condition Embed Channel and S-Parameter File should be selected. S-Parameter file type
should be S2P.

Group High Speed Jitter

Syntax CPHY:HSPEed:JITTer:EMBEd:SPARameter:STWO:LINEB:INPUt {P1|P2}

CPHY:HSPEed:JITTer:EMBEd:SPARameter:STWO:LINEB:INPUt?

Related commands CPHY:HSPEed:JITTer:EMBEd:SPARameter:STWO:LINEB:OUTPut

Arguments P1 sets the line B input port to Port1 in S2P mode.

P2 sets the line B input port to Port2 in S2P mode.

Returns P1

P2

Example CPHY:HSPEed:JITTer:EMBEd:SPARameter:STWO:LINEB:INPUt P1 sets the
line B input port to Port1 in S2P mode.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:STWO:LINEB:INPUt? returns P1
as line B input port.
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CPHY:HSPEed:JITTer:EMBEd:SPARameter:STWO:LINEB:OUTPut
This command sets or returns the line B output port in 2 port S-Parameter mode.

Condition Embed Channel and S-Parameter File should be selected. S-Parameter file type
should be S2P.

Group High Speed Jitter

Syntax CPHY:HSPEed:JITTer:EMBEd:SPARameter:STWO:LINEB:OUTPut {P1|P2}

CPHY:HSPEed:JITTer:EMBEd:SPARameter:STWO:LINEB:OUTPut?

Related commands CPHY:HSPEed:JITTer:EMBEd:SPARameter:STWO:LINEA:INPUt

Arguments P1 sets the line B output port to Port1 in S2P mode.

P2 sets the line B output port to Port2 in S2P mode.

Returns P1

P2

Example CPHY:HSPEed:JITTer:EMBEd:SPARameter:STWO:LINEB:OUTPut P1 sets
the line B output port to Port1 in S2P mode.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:STWO:LINEB:OUTPut? returns
P1 as line B output port.
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CPHY:HSPEed:JITTer:EMBEd:SPARameter:STWO:LINEC:INPut
This command sets or returns the line C input port in 2 port S-Parameter mode.

Condition Embed Channel and S-Parameter File should be selected. S-Parameter file type
should be S2P.

Group High Speed Jitter

Syntax CPHY:HSPEed:JITTer:EMBEd:SPARameter:STWO:LINEC:INPut {P1|P2}

CPHY:HSPEed:JITTer:EMBEd:SPARameter:STWO:LINEC:INPut?

Related commands CPHY:HSPEed:JITTer:EMBEd:SPARameter:STWO:LINEC:OUTPut

Arguments P1 sets the line C input port to Port1 in S2P mode.

P2 sets the line C input port to Port2 in S2P mode.

Returns P1

P2

Example CPHY:HSPEed:JITTer:EMBEd:SPARameter:STWO:LINEC:INPut P1 sets the
line C input port to Port1 in S2P mode.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:STWO:LINEC:INPut? returns P1
as line C input port.
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CPHY:HSPEed:JITTer:EMBEd:SPARameter:STWO:LINEC:OUTPut
This command sets or returns the line C output port in 2 port S-Parameter mode.

Condition Embed Channel and S-Parameter File should be selected. S-Parameter file type
should be S2P.

Group High Speed Jitter

Syntax CPHY:HSPEed:JITTer:EMBEd:SPARameter:STWO:LINEC:OUTPut {P1|P2}

CPHY:HSPEed:JITTer:EMBEd:SPARameter:STWO:LINEC:OUTPut?

Related commands CPHY:HSPEed:JITTer:EMBEd:SPARameter:STWO:LINEC:INPut

Arguments P1 sets the line C output port to Port1 in S2P mode.

P2 sets the line C output port to Port2 in S2P mode.

Returns P1

P2

Example CPHY:HSPEed:JITTer:EMBEd:SPARameter:STWO:LINEC:OUTPut P1 sets
the line C output port to Port1 in S2P mode.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:STWO:LINEC:OUTPut? returns
P1 as line C output port.
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CPHY:HSPEed:JITTer:EMBEd:SPARameter:STWO:LINEA:FILE
This command sets or returns line A S2P file path.

Condition Embed Channel and S-Parameter File should be selected. S-Parameter file type
should be S2P.

Group High Speed Jitter

Syntax CPHY:HSPEed:JITTer:EMBEd:SPARameter:STWO:LINEA:FILE <file_name>

CPHY:HSPEed:JITTer:EMBEd:SPARameter:STWO:LINEA:FILE?

Related commands CPHY:HSPEed:JITTer:EMBEd:SPARameter:STWO:LINEA:INPUt

CPHY:HSPEed:JITTer:EMBEd:SPARameter:STWO:LINEA:OUTPut

Arguments File path

Returns File path.

Example CPHY:HSPEed:JITTer:EMBEd:SPARameter:STWO:LINEA:FILE "C:\Users
\Public\Tektronix\CPHYXpress\DataFiles\S2P_A.flt" sets the file path of Line A
in S2P.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:STWO:LINEA:FILE? returns "C:
\Users\Public\Tektronix\CPHYXpress\DataFiles\S2P_A.flt" as line A S2P file
path.
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CPHY:HSPEed:JITTer:EMBEd:SPARameter:STWO:LINEB:FILE
This command sets or returns line B S2P file path.

Condition Embed Channel and S-Parameter File should be selected. S-Parameter file type
should be S2P.

Group High Speed Jitter

Syntax CPHY:HSPEed:JITTer:EMBEd:SPARameter:STWO:LINEB:FILE<file_name>

CPHY:HSPEed:JITTer:EMBEd:SPARameter:STWO:LINEB:FILE?

Related commands CPHY:HSPEed:JITTer:EMBEd:SPARameter:STWO:LINEB:INPUt?

CPHY:HSPEed:JITTer:EMBEd:SPARameter:STWO:LINEB:OUTPut

Arguments File path

Returns File path.

Example CPHY:HSPEed:JITTer:EMBEd:SPARameter:STWO:LINEB:FILE "C:\Users
\Public\Tektronix\CPHYXpress\DataFiles\S2P_B.flt" sets the file path of line B
S2P.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:STWO:LINEB:FILE? returns "C:
\Users\Public\Tektronix\CPHYXpress\DataFiles\S2P_B.flt" as line B S2P file
path.
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CPHY:HSPEed:JITTer:EMBEd:SPARameter:STWO:LINEC:FILE
This command sets or returns line C S2P file path.

Condition Embed Channel and S-Parameter File should be selected. S-Parameter file type
should be S2P.

Group High Speed Jitter

Syntax CPHY:HSPEed:JITTer:EMBEd:SPARameter:STWO:LINEC:FILE <file_name>

CPHY:HSPEed:JITTer:EMBEd:SPARameter:STWO:LINEC:FILE?

Related commands CPHY:HSPEed:JITTer:EMBEd:SPARameter:STWO:LINEC:INPut

CPHY:HSPEed:JITTer:EMBEd:SPARameter:STWO:LINEC:OUTPut

Arguments File path.

Returns File path.

Example CPHY:HSPEed:JITTer:EMBEd:SPARameter:STWO:LINEC:FILE "C:\Users
\Public\Tektronix\CPHYXpress\DataFiles\S2P_C.s2p" sets the file path of line B
in S2P.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:STWO:LINEC:FILE? returns "C:
\Users\Public\Tektronix\CPHYXpress\DataFiles\S2P_C.s2p" as line C S2P file
path.
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CPHY:HSPEed:JITTer:EMBEd:SPARameter:STWOp:APPLylinebc
This command sets or returns the use of line A S-Parameter file for line B and
line C.

Condition Embed Channel and S-Parameter Files should be selected.

Group High Speed Jitter

Syntax CPHY:HSPEed:JITTer:EMBEd:SPARameter:STWOp:APPLylinebc {0|1}

CPHY:HSPEed:JITTer:EMBEd:SPARameter:STWOp:APPLylinebc?

Related commands CPHY:HSPEed:JITTer:EMBEd:SPARameter:STWOp:APPLylinebc

Arguments {0|1}

1 enables the use of line A S-Parameter file for line B and line C.

0 disables the use of line A S-Parameter file for line B and line C.

Returns A single <Boolean> value, {0|1}.

Example CPHY:HSPEed:JITTer:EMBEd:SPARameter:STWOp:APPLylinebc 1 enables
the use of line A S-Parameter file for line B and line C.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:STWOp:APPLylinebc? returns
1 indicating 'Apply Line A S-Parameter file to Line B and Line C' is enabled.

Command description  

134



CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:AB:INPUt:ONE
This command sets or returns the line AB input one type.

Condition Embed channel and S-Parameter should be selected.

S-Parameter file type should be S4P Single Ended.

Group High Speed Jitter

Syntax CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:AB:INPUt:ONE {P1|P2|P3|
P4}

CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:AB:INPUt:ONE?

Related commands CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:AB:INPUt:TWO

Arguments {P1|P2|P3|P4}

Returns {P1|P2|P3|P4}

Example CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:AB:INPUt:ONE sets the
line AB input one type to Port 1.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:AB:INPUt:ONE returns P1
as the input one type of line AB.
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CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:AB:INPUt:TWO
This command sets or returns the input two type for line AB.

Condition Embed Channel and S-Parameter should be selected.

S-Parameter file type should be S4P Single Ended.

Group High Speed Jitter

Syntax CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:AB:INPUt:TWO {P1|P2|P3|
P4}

CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:AB:INPUt:TWO?

Related commands CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:AB:INPUt:ONE

Arguments {P1|P2|P3|P4}

Returns {P1|P2|P3|P4}

Example CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:AB:INPUt:TWO P2 sets the
line AB input two type to port 2.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:AB:INPUt:TWO? returns
P1 as line AB input two type.
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CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:AB:INPUt:FILE
This command sets or returns the line AB S-Parameter file path.

Condition Embed Channel and S-Parameter should be selected.

S-Parameter file type should be S4P Single Ended.

Group High Speed Jitter

Syntax CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:AB:INPUt:FILE <"file
path">

CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:AB:INPUt:FILE?

Related commands CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:AB:INPUt:ONE

Arguments "file path".

Returns "file path".

Example CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:AB:INPUt:FILE “C:\\1.s4p”
sets the Line AB S-Parameter file path to “c:\\1.s4p”.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:AB:INPUt:FILE? returns
“C:\\1.s4p” as line AB S-Parameter file path.
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CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:AB:OUTPut:ONE
This command sets or returns the output one type of Line AB.

Condition Embed Channel and S-Parameter should be selected.

S-Parameter file type should be S4P Single Ended.

Group High Speed Jitter

Syntax CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:AB:OUTPut:ONE {P1|P2|
P3|P4}

CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:AB:OUTPut:ONE?

Related commands CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:AB:OUTPut:TWO

Arguments {P1|P2|P3|P4}

Returns {P1|P2|P3|P4}

Example CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:AB:OUTPut:ONE sets p1 as
output one type of line AB.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:AB:OUTPut:ONE? returns
P1 as line AB output one type.
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CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:AB:OUTPut:TWO
This command sets or returns the output two type of line AB.

Condition Embed Channel and S-Parameter should be selected.

S-Parameter file type should be S4P Single Ended.

Group High Speed Jitter

Syntax CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:AB:OUTPut:TWO {P1|P2|
P3|P4}

CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:AB:OUTPut:TWO?

Related commands CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:BC:OUTPut:TWO

Arguments {P1|P2|P3|P4}.

Returns {P1|P2|P3|P4}.

Example CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:AB:OUTPut:TWO P2 sets
the line AB as output two type to Port2.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:AB:OUTPut:TWO? returns
P2 as line AB output two type.
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CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:BC:INPUt:ONE
This command sets or returns the input one type of line BC.

Condition Embed Channel and S-Parameter should be selected.

S-Parameter file type should be S4P Single Ended.

Group High Speed Jitter

Syntax CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:BC:INPUt:ONE {P1|P2|P3|
P4}

CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:BC:INPUt:ONE?

Related commands CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:CA:INPUt:ONE

Arguments {P1|P2|P3|P4}.

Returns {P1|P2|P3|P4}.

Example CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:BC:INPUt:ONE P3 sets the
input one type of line BC to Port 3.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:BC:INPUt:ONE? returns P3
as line BC input one type.
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CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:BC:INPUt:TWO
This command sets or returns input two type of line BC.

Condition Embed Channel and S-Parameter should be selected.

S-Parameter file type should be S4P Single Ended.

Group High Speed Jitter

Syntax CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:BC:INPUt:TWO {P1|P2|P3|
P4}

CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:BC:INPUt:TWO?

Related commands CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:CA:INPUt:TWO

Arguments {P1|P2|P3|P4}.

Returns {P1|P2|P3|P4}.

Example CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:BC:INPUt:TWO P1 sets
line BC input two type to Port1.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:BC:INPUt:TWO? returns P1
as line BC input two type.
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CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:BC:INPUt:FILE
This command sets or returns the line BC input file path.

Condition Embed Channel and S-Parameter should be selected.

S-Parameter file type should be S4P Single Ended.

Group High Speed Jitter

Syntax CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:BC:INPUt:FILE <file path>

CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:BC:INPUt:FILE?

Related commands CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:CA:INPUt:FILE

Arguments "file path".

Returns "file path".

Example CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:BC:INPUt:FILE “C:\\1.s4p”
sets the line BC input file path to C:\\1.s4p.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:BC:INPUt:FILE? returns
“C:\\1.s4p” as the line BC input file path.

Command description  

142



CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:BC:OUTPut:ONE
This command sets or returns output one type of line BC.

Condition Embed Channel and S-Parameter should be selected.

S-Parameter file type should be S4P Single Ended.

Group High Speed Jitter

Syntax CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:BC:OUTPut:ONE {P1|P2|
P3|P4}

CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:BC:OUTPut:ONE?

Related commands CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:CA:OUTPut:ONE

Arguments {P1|P2|P3|P4}.

Returns {P1|P2|P3|P4}.

Example CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:BC:OUTPut:ONE P2 sets
the output one type of line BC to Port2.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:BC:OUTPut:ONE? returns
P2 as line BC output one type.
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CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:BC:OUTPut:TWO
This command sets or returns output two type of line BC.

Condition Embed Channel and S-Parameter should be selected.

S-Parameter file type should be S4P Single Ended.

Group High Speed Jitter

Syntax CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:BC:OUTPut:TWO {P1|P2|
P3|P4}

CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:BC:OUTPut:TWO?

Related commands CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:CA:OUTPut:TWO?

Arguments {P1|P2|P3|P4}.

Returns {P1|P2|P3|P4}.

Example CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:BC:OUTPut:TWO P1 sets
the line BC output two type to Port1.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:BC:OUTPut:TWO? returns
P1 as line BC output two type.
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CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:CA:INPUt:ONE
This command sets or returns the input one type of line CA.

Condition Embed Channel and S-Parameter should be selected.

S-Parameter file type should be S4P Single Ended.

Group High Speed Jitter

Syntax CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:CA:INPUt:ONE {P1|P2|P3|
P4}

CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:CA:INPUt:ONE?

Related commands CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:AB:INPUt:ONE

Arguments {P1|P2|P3|P4}.

Returns {P1|P2|P3|P4}.

Example CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:CA:INPUt:ONE P2 sets the
input one type of line CA to port2.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:CA:INPUt:ONE? returns P2
as input one type of line CA.
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CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:CA:INPUt:TWO
This command sets or returns the input two type of line CA.

Condition Embed Channel and S-Parameter should be enabled.

S-Parameter file type should be S4P Single Ended.

Group High Speed Jitter

Syntax CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:CA:INPUt:TWO {P1|P2|P3|
P4}

CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:CA:INPUt:TWO?

Related commands CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:AB:INPUt:TWO

Arguments {P1|P2|P3|P4}.

Returns {P1|P2|P3|P4}.

Example CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:CA:INPUt:TWO P3 sets the
input two type of line CA to port3.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:CA:INPUt:TWO? returns
P3 as line CA input two type.
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CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:CA:INPUt:FILE
This command sets or returns line CA input file path.

Condition Embed Channel and S-Parameter should be selected.

S-Parameter file type should be S4P Single Ended.

Group High Speed Jitter

Syntax CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:CA:INPUt:FILE <file path>

CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:CA:INPUt:FILE?

Related commands CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:AB:INPUt:FILE

Arguments "file path".

Returns "file path".

Example CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:CA:INPUt:FILE “C:\\1.s4p”
sets the line CA input file path to “C:\\1.s4p”.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:CA:INPUt:FILE? returns
“C:\\1.s4p” as line CA input file path.
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CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:CA:OUTPut:ONE
This command sets or returns output one type of line CA.

Condition Embed Channel and S-Parameter should be selected.

S-Parameter file type should be S4P Single Ended.

Group High Speed Jitter

Syntax CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:CA:OUTPut:ONE {P1|P2|
P3|P4}

CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:CA:OUTPut:ONE?

Related commands CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:AB:OUTPut:ONE

Arguments {P1|P2|P3|P4}

Returns {P1|P2|P3|P4}

Example CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:CA:OUTPut:ONE P1 sets
line CA output one type to Port 1.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:CA:OUTPut:ONE? returns
P1 as line CA output one type.
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CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:CA:OUTPut:TWO
This command sets or returns output two type of line CA.

Condition Embed channel and S-Parameter should be selected.

S-Parameter file type should be S4P Single Ended.

Group High Speed Jitter

Syntax CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:CA:OUTPut:TWO {P1|P2|
P3|P4}

CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:CA:OUTPut:TWO?

Related commands CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:AB:OUTPut:TWO

Arguments {P1|P2|P3|P4}.

Returns {P1|P2|P3|P4}.

Example CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:CA:OUTPut:TWO P1 sets
the output two type of line CA to Port1.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:SFSE:CA:OUTPut:TWO? returns
P1 as line CA output two type.
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CPHY:HSPEed:JITTer:EMBEd:SPARameter:SSIX:LINEA:INPUt
This command sets or returns the line A input of 6-port S-Parameter mode.

Condition Embed Channel and S-Parameter file should be enabled. S-Parameter file type
should be S6P Single Ended.

Group High Speed Jitter

Syntax CPHY:HSPEed:JITTer:EMBEd:SPARameter:SSIX:LINEA:INPUt {P1|P2|P3|P4|
P5|P6}

CPHY:HSPEed:JITTer:EMBEd:SPARameter:SSIX:LINEA:INPUt?

Related commands CPHY:HSPEed:JITTer:EMBEd:SPARameter:SSIX:LINEA:OUTPut

Arguments P1 sets the Line A input of 6-port S-Parameter mode to Port1.

P2 sets the Line A input of 6-port S-Parameter mode to Port2.

P3 sets the Line A input of 6-port S-Parameter mode to Port3.

P4 sets the Line A input of 6-port S-Parameter mode to Port4.

P5 sets the Line A input of 6-port S-Parameter mode to Port5.

P6 sets the Line A input of 6-port S-Parameter mode to Port6.

Returns P1

P2

P3

P4

P5

P6
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Example CPHY:HSPEed:JITTer:EMBEd:SPARameter:SSIX:LINEA:INPUt P1 sets the
line A input of 6-port S-Parameter mode to Port1.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:SSIX:LINEA:INPUt? returns P1
as line A input type of 6port S-Parameter.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:SSIX:LINEA:OUTPut
This command sets or returns the line A output of 6-port S-Parameter mode.

Condition Embed Channel and S-Parameter File should be selected. S-Parameter file type
should be S6P Single Ended.

Group High Speed Jitter

Syntax CPHY:HSPEed:JITTer:EMBEd:SPARameter:SSIX:LINEA:OUTPut {P1|P2|P3|
P4|P5|P6}

CPHY:HSPEed:JITTer:EMBEd:SPARameter:SSIX:LINEA:OUTPut?

Related commands CPHY:HSPEed:JITTer:EMBEd:SPARameter:SSIX:LINEA:INPUt

Arguments P1 sets the line A output of 6-port S-Parameter mode to Port1.

P2 sets the line A output of 6-port S-Parameter mode to Port2.

P3 sets the line A output of 6-port S-Parameter mode to Port3.

P4 sets the line A output of 6-port S-Parameter mode to Port4.

P5 sets the line A output of 6-port S-Parameter mode to Port5.

P6 sets the line A output of 6-port S-Parameter mode to Port6.
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Returns P1

P2

P3

P4

P5

P6

Example CPHY:HSPEed:JITTer:EMBEd:SPARameter:SSIX:LINEA:OUTPutP1 sets the
line A output of 6-port S-Parameter mode to Port1.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:SSIX:LINEA:OUTPut? returns P1
as line A output of 6-port S-Parameter.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:SSIX:LINEB:INPUt
This command sets or returns the line B input of 6-port S-Parameter mode.

Condition Embed Channel and S-Parameter File should be enabled. S-Parameter file type
should be S6P Single Ended.

Group High Speed Jitter

Syntax CPHY:HSPEed:JITTer:EMBEd:SPARameter:SSIX:LINEB:INPUt {P1|P2|P3|P4|
P5|P6}

CPHY:HSPEed:JITTer:EMBEd:SPARameter:SSIX:LINEB:INPUt?

Related commands CPHY:HSPEed:JITTer:EMBEd:SPARameter:SSIX:LINEB:OUTPut
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Arguments P1 sets the line B input of 6-port S-Parameter mode to Port1.

P2 sets the line B input of 6-port S-Parameter mode to Port2.

P3 sets the line B input of 6-port S-Parameter mode to Port3.

P4 sets the line B input of 6-port S-Parameter mode to Por4.

P5 sets the line B input of 6-port S-Parameter mode to Port5.

P6 sets the line B input of 6-port S-Parameter mode to Port6.

Returns P1

P2

P3

P4

P5

P6

Example CPHY:HSPEed:JITTer:EMBEd:SPARameter:SSIX:LINEB:INPUt P1 sets the
line B input of 6-port S-Parameter mode to Port1.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:SSIX:LINEB:INPUt? returns P1
as line B of 6-port S-Parameter.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:SSIX:LINEB:OUTPut
This command sets or returns the line B output of 6-port S-Parameter mode.

Condition Embed Channel and S-Parameter File should be selected. S-Parameter file type
should be S6P Single Ended.
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Group High Speed Jitter

Syntax CPHY:HSPEed:JITTer:EMBEd:SPARameter:SSIX:LINEB:OUTPut {P1|P2|P3|
P4|P5|P6}

CPHY:HSPEed:JITTer:EMBEd:SPARameter:SSIX:LINEB:OUTPut?

Related commands CPHY:HSPEed:JITTer:EMBEd:SPARameter:SSIX:LINEB:INPUt

Arguments P1 sets the line B input of 6-port S-Parameter mode to Port1.

P2 sets the line B input of 6-port S-Parameter mode to Port2.

P3 sets the line B input of 6-port S-Parameter mode to Port3.

P4 sets the line B input of 6-port S-Parameter mode to Port4.

P5 sets the line B input of 6-port S-Parameter mode to Port5.

P6 sets the line B input of 6-port S-Parameter mode to Port6.

Returns P1

P2

P3

P4

P5

P6

Example CPHY:HSPEed:JITTer:EMBEd:SPARameter:SSIX:LINEB:OUTPut P1 sets the
line B output of 6-port S-Parameter mode to Port1.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:SSIX:LINEB:OUTPut? returns P1
as line B output of 6-port S-Parameter.
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CPHY:HSPEed:JITTer:EMBEd:SPARameter:SSIX:LINEC:INPUt
This command sets or returns the line C input of 6-port S-Parameter mode.

Condition Embed Channel and S-Parameter File should be selected. S-Parameter file type
should be S6P Single Ended.

Group High Speed Jitter

Syntax CPHY:HSPEed:JITTer:EMBEd:SPARameter:SSIX:LINEC:INPUt {P1|P2|P3|P4|
P5|P6}

CPHY:HSPEed:JITTer:EMBEd:SPARameter:SSIX:LINEC:INPUt?

Related commands CPHY:HSPEed:JITTer:EMBEd:SPARameter:SSIX:LINEC:OUTPut

Arguments P1 sets the line C input of 6-port S-Parameter mode to Port1.

P2 sets the line C input of 6-port S-Parameter mode to Port2.

P3 sets the line C input of 6-port S-Parameter mode to Port3.

P4 sets the line C input of 6-port S-Parameter mode to Port4.

P5 sets the line C input of 6-port S-Parameter mode to Port5.

P6 sets the line C input of 6-port S-Parameter mode to Port6.

Returns P1

P2

P3

P4

P5

P6
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Example CPHY:HSPEed:JITTer:EMBEd:SPARameter:SSIX:LINEC:INPUtP1 sets the
line C input of 6-port S-Parameter mode to Port1.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:SSIX:LINEC:INPUt? returns P1
as line C input of 6-port S-Parameter.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:SSIX:LINEC:OUTPut
This command sets or returns the line C output of 6-port S-Parameter mode.

Condition Embed Channel and S-Parameter File should be selected. S-Parameter file type
should be S6P Single Ended.

Group High Speed Jitter

Syntax CPHY:HSPEed:JITTer:EMBEd:SPARameter:SSIX:LINEC:OUTPut {P1|P2|P3|
P4|P5|P6}

CPHY:HSPEed:JITTer:EMBEd:SPARameter:SSIX:LINEC:OUTPut?

Related commands CPHY:HSPEed:JITTer:EMBEd:SPARameter:SSIX:LINEC:INPUt

Arguments P1 sets the line C output of 6-port S-Parameter mode to Port1.

P2 sets the line C output of 6-port S-Parameter mode to Port2.

P3 sets the line C output of 6-port S-Parameter mode to Port3.

P4 sets the line C output of 6-port S-Parameter mode to Port4.

P5 sets the line C output of 6-port S-Parameter mode to Port5.

P6 sets the line C output of 6-port S-Parameter mode to Port6.
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Returns P1

P2

P3

P4

P5

P6

Example CPHY:HSPEed:JITTer:EMBEd:SPARameter:SSIX:LINEC:OUTPut P1 sets the
line C output of 6-port S-Parameter mode to Port1.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:SSIX:LINEC:OUTPut? returns P1
as line C output of 6-port S-Parameter.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:SSIX:FILE
This command sets or returns the S6P S-Parameter file path.

Condition Embed Channel and S-Parameter file should be selected. S-Parameter file type
should be S6P Single Ended.

Group High Speed Jitter

Syntax CPHY:HSPEed:JITTer:EMBEd:SPARameter:SSIX:FILE <file_name>

CPHY:HSPEed:JITTer:EMBEd:SPARameter:SSIX:FILE?

Related commands CPHY:HSPEed:JITTer:EMBEd:SPARameter:SSIX:LINEA:INPUt
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Arguments File path.

Returns File name with full path of 6 port S-Parameter mode.

Example CPHY:HSPEed:JITTer:EMBEd:SPARameter:SSIX:FILE "C:\Users\Public
\Tektronix\CPHYXpress\DataFiles\S6P_file.s6p" sets the file path of 6 port S-
Parameter mode.

CPHY:HSPEed:JITTer:EMBEd:SPARameter:SSIX:FILE? returns "C:\Users
\Public\Tektronix\CPHYXpress\DataFiles\S6P_file.s6p" as S6P S-Parameter file
path.

CPHY:HSPEed:BURSt:ENABle
This command enables or disables batch waveform creation.

Condition Signal mode should be either High Speed or Low power - High Speed.

Group High Speed Burst

Syntax CPHY:HSPEed:BURSt:ENABle {0|1}

CPHY:HSPEed:BURSt:ENABle?

Related commands CPHY:HSPEed:BURSt:HSDATA:INCLude

Arguments {0|1}

0 disables the burst waveform creation for High Speed.

1 enables the burst waveform creation for High Speed.
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Returns A single <Boolean> value, {0|1}.

Example CPHY:HSPEed:BURSt:ENABle 1 enables burst waveform creation.

CPHY:HSPEed:BURSt:ENABle? returns 1 indicating the burst waveform
creation is enabled.

CPHY:HSPEed:BURSt:HSDATA:INCLude
This command sets or returns to include High Speed data with burst mode.

Condition Create Burst should be selected.

Group High Speed Burst

Syntax CPHY:HSPEed:BURSt:HSDATA:INCLude <bool>

CPHY:HSPEed:BURSt:HSDATA:INCLude?

Related commands CPHY:HSPEed:BURSt:PREBegin:ENABle

Arguments A single Boolean value {0|1}.

Returns A single Boolean value {0|1}.

Example CPHY:HSPEed:BURSt:HSDATA:INCLude 1 enables include High speed data
with burst mode.

CPHY:HSPEed:BURSt:HSDATA:INCLude? returns 1 indicating high speed
data is included with burst mode.
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CPHY:HSPEed:BURSt:PREBegin:ENABle
This command enables or disables Prebegin with burst mode.

Condition Create Burst should be selected.

Group High Speed Burst

Syntax CPHY:HSPEed:BURSt:PREBegin:ENABle <bool>

CPHY:HSPEed:BURSt:PREBegin:ENABle?

Related commands CPHY:HSPEed:BURSt:PREEnd:ENABle

Arguments A single Boolean value {0|1}.

Returns A single Boolean value {0|1}.

Example CPHY:HSPEed:BURSt:PREBegin:ENABle 1 enables prebegin with high speed
burst mode.

CPHY:HSPEed:BURSt:PREBegin:ENABle? returns 1 indicating prebegin is
enabled in high speed burst mode.
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CPHY:HSPEed:BURSt:PREBegin:PATTern
This command sets or returns the PreBegin pattern.

Condition Create Burst should be selected.

Group High Speed Burst

Syntax CPHY:HSPEed:BURSt:PREBegin:PATTern <string>

CPHY:HSPEed:BURSt:PREBegin:PATTern?

Related commands CPHY:HSPEed:BURSt:PREBegin:REPEat

Arguments <value>::= <string>

{"0000000" to "4444444"}

It should contain 7 symbols and each symbol value should be between 0 to 4.

Returns The value is returned in a string format.

{"0000000" to "4444444"}.

Example CPHY:HSPEed:BURSt:PREBegin:PATTern "0123400" sets the PreBegin
pattern to 0123400.

CPHY:HSPEed:BURSt:PREBegin:PATTern? returns "0123400" as PreBegin
pattern.
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CPHY:HSPEed:BURSt:PREBegin:REPEat
This command sets or returns the repeat count for PreBegin.

Condition Create Burst should be selected.

Group High Speed Burst

Syntax CPHY:HSPEed:BURSt:PREBegin:REPEat <NR1>

CPHY:HSPEed:BURSt:PREBegin:REPEat?

Related commands CPHY:HSPEed:BURSt:PREBegin:PATTern

Arguments A single <NR1> value, {0 to 2000}.

Returns A single <NR1> value, {0 to 2000}.

Example CPHY:HSPEed:BURSt:PREBegin:REPEat 1000 sets the PreBegin repeat count
to 1000.

CPHY:HSPEed:BURSt:PREBegin:REPEat? returns 1000 as PreBegin repeat
count.
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CPHY:HSPEed:BURSt:PREAmble:LENGth? (Query only)
This command returns the preamble length in terms of number of symbols.

Condition Create Burst should be selected.

Group High Speed Burst

Syntax CPHY:HSPEed:BURSt:PREAmble:LENGth?

Related commands CPHY:HSPEed:BURSt:PREBegin:REPEat

CPHY:HSPEed:BURSt:PREBegin:PATTern

Returns A single <NR1> value.

Example CPHY:HSPEed:BURSt:PREAmble:LENGth? returns the preamble length.

CPHY:HSPEed:BURSt:PROGseq:ENABle
This command enables or disables programmable sequence.

Condition Create Burst should be selected.

Group High Speed Burst
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Syntax CPHY:HSPEed:BURSt:PROGseq:ENABle {0|1}

CPHY:HSPEed:BURSt:PROGseq:ENABle?

Related commands CPHY:HSPEed:BURSt:PROGseq:PATTern

CPHY:HSPEed:BURSt:PROGseq:REPEat

Arguments {0|1}

1 enables the programmable sequence.

0 disables the programmable sequence.

Returns A single <Boolean> value, {0|1}.

Example CPHY:HSPEed:BURSt:PROGseq:ENABle 1 enables the programmable
sequence.

CPHY:HSPEed:BURSt:PROGseq:ENABle? returns 1 indicating programmable
sequence is enabled.

CPHY:HSPEed:BURSt:PROGseq:PATTern
This command sets or returns the programmable sequence pattern.

Condition Create Burst and Programmable Sequence should be selected.

Group High Speed Burst
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Syntax CPHY:HSPEed:BURSt:PROGseq:PATTern <string>

CPHY:HSPEed:BURSt:PROGseq:PATTern?

Related commands CPHY:HSPEed:BURSt:PREBegin:PATTern

Arguments <value>::= <string>

{"00000000000000" to "44444444444444"}.

It should contain 14 symbols and each symbol value should be between 0 to 4.

Returns The value is returned in a string format.

{"00000000000000" to "44444444444444"}.

Example CPHY:HSPEed:BURSt:PROGseq:PATTern "44444444444444" sets the pattern
for programmable sequence.

CPHY:HSPEed:BURSt:PROGseq:PATTern? returns "44444444444444" as
programmable sequence pattern.

CPHY:HSPEed:BURSt:PROGseq:REPEat
This command sets or returns the repeat count for programmable sequence.

Condition Create Burst and Programmable Sequence should be selected.

Group High Speed Burst
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Syntax CPHY:HSPEed:BURSt:PROGseq:REPEat <NR1>

CPHY:HSPEed:BURSt:PROGseq:REPEat?

Related commands CPHY:HSPEed:BURSt:PROGseq:PATTern

Arguments A single <NR1> value.

Range: {0 to 16}.

Returns A single <NR1> value, {0 to 16}.

Example CPHY:HSPEed:BURSt:PROGseq:REPEat 16 sets the repeat count for
programmable sequence to 16.

CPHY:HSPEed:BURSt:PROGseq:REPEat? returns 16 as the repeat count for
programmable sequence.

CPHY:HSPEed:BURSt:PREEnd:ENABle
This command enables or disables PreEnd with burst mode.

Condition Create Burst should be selected.

Group High Speed Burst

Syntax CPHY:HSPEed:BURSt:PREEnd:ENABle

CPHY:HSPEed:BURSt:PREEnd:ENABle?
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Related commands CPHY:HSPEed:BURSt:SYNC:ENABle

Arguments A single <Boolean> value, {0|1}.

Returns A single <Boolean> value, {0|1}.

Example CPHY:HSPEed:BURSt:PREEnd:ENABle 1 enables PreEnd with high speed
burst mode.

CPHY:HSPEed:BURSt:PREEnd:ENABle? returns 1 indicating PreEnd is
enabled with high speed burst mode.

CPHY:HSPEed:BURSt:PREEnd:PATTern
This command sets or returns the PreEnd pattern.

Condition Create Burst should be selected.

Group High Speed Burst

Syntax CPHY:HSPEed:BURSt:PREEnd:PATTern <string>

CPHY:HSPEed:BURSt:PREEnd:PATTern?

Related commands CPHY:HSPEed:BURSt:PREEnd:REPeat

Arguments <value>::= <string>

{"0000000" to "4444444"}

It should contain 7 symbols and each symbol value should be between 0 to 4.
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Returns The value is returned in a string format.

{"0000000" to "4444444"}.

Example CPHY:HSPEed:BURSt:PREEnd:PATTern "4444444" sets PreEnd pattern.

CPHY:HSPEed:BURSt:PREEnd:PATTern? returns "4444444" as the PreEnd
pattern.

CPHY:HSPEed:BURSt:PREEnd:REPeat
This command sets or returns the repeat count for PreEnd pattern.

Condition Create Burst should be selected.

Group High Speed Burst

Syntax CPHY:HSPEed:BURSt:PREEnd:REPeat <NR1>

CPHY:HSPEed:BURSt:PREEnd:REPeat?

Related commands CPHY:HSPEed:BURSt:PREEnd:PATTern

Arguments A single <NR1> value.

Range: {0 to 10}.

Returns A single <NR1> value, {0 to 10}.
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Example CPHY:HSPEed:BURSt:PREEnd:REPeat 10 sets the PreEnd repeat count to 10.

CPHY:HSPEed:BURSt:PREEnd:REPeat? returns 10 as the PreEnd repeat count.

CPHY:HSPEed:BURSt:SYNC:ENABle
This command enables or disables sync with high speed burst mode.

Condition Create Burst should be enabled.

Group High Speed Burst

Syntax CPHY:HSPEed:BURSt:SYNC:ENABle <bool>

CPHY:HSPEed:BURSt:SYNC:ENABle?

Related commands CPHY:HSPEed:BURSt:SYNC:WORD

Arguments A single <Boolean> value, {0|1}.

Returns A single <Boolean> value, {0|1}.

Example CPHY:HSPEed:BURSt:SYNC:ENABle 1 enables sync with high speed burst
mode.

CPHY:HSPEed:BURSt:SYNC:ENABle? returns 1 indicating sync is enabled
with burst mode.
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CPHY:HSPEed:BURSt:SYNC:WORD
This command sets or returns the sync word.

Condition Create Burst should be selected.

Group High Speed Burst

Syntax CPHY:HSPEed:BURSt:SYNC:WORD <string>

CPHY:HSPEed:BURSt:SYNC:WORD?

Related commands CPHY:HSPEed:BURSt:PREBegin:PATT

CPHY:HSPEed:BURSt:PROGseq:PATT

Arguments <value>::= <string>

{"0000000" to "4444444"}

It should contain 7 symbols and each symbol value should be between 0 to 4.

Returns A string value indication of sync word.

The value is returned in a string format.

{"0000000" to "4444444"}

Example CPHY:HSPEed:BURSt:SYNC:WORD "4444444" sets the sync word.

CPHY:HSPEed:BURSt:SYNC:WORD? returns "4444444" as the sync word.
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CPHY:HSPEed:BURSt:SYNC:REPEat
This command sets or returns the repeat count of sync word.

Condition Create Burst should be selected.

Group High Speed Burst

Syntax CPHY:HSPEed:BURSt:SYNC:REPEat <NR1>

CPHY:HSPEed:BURSt:SYNC:REPEat?

Related commands CPHY:HSPEed:BURSt:PREBegin:REPEat

Arguments A single <NR1> value.

Range: {0 to 10}.

Returns A single <NR1> value, {0 to 10}.

Example CPHY:HSPEed:BURSt:SYNC:REPEat 10 sets the sync word to 10.

CPHY:HSPEed:BURSt:SYNC:REPEat? returns 10 of the sync word.
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CPHY:HSPEed:BURST:SYNC:SYMBols? (Query only)
This command returns the number of symbols for sync word.

Condition Create Burst should be selected.

Group High Speed Burst

Syntax CPHY:HSPEed:BURST:SYNC:SYMBols?

Related commands CPHY:HSPEed:BURSt:SYNC:WORD

CPHY:HSPEed:BURSt:SYNC:REPEat

Returns A single <NR1> value.

Example CPHY:HSPEed:BURST:SYNC:SYMBols? returns sync word in symbols.

CPHY:HSPEed:BURSt:POST:ENABle
This command enables or disables the post pattern in high speed burst mode.

Condition Create Burst should be selected.

Group High Speed Burst
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Syntax CPHY:HSPEed:BURSt:POST:ENABle <bool>

CPHY:HSPEed:BURSt:POST:ENABle?

Related commands CPHY:HSPEed:BURSt:POST:PATTern

Arguments A single <Boolean> value, {0|1}.

Returns A single <Boolean> value, {0|1}.

Example CPHY:HSPEed:BURSt:POST:ENABle 1 enables the post pattern for burst.

CPHY:HSPEed:BURSt:POST:ENABle? returns 1 as post pattern for burst.

CPHY:HSPEed:BURSt:POST:PATTern
This command sets or returns the post pattern.

Condition Create Burst should be selected.

Group High Speed Burst

Syntax CPHY:HSPEed:BURSt:POST:PATTern <value>

CPHY:HSPEed:BURSt:POST:PATTern?

Related commands CPHY:HSPEed:BURSt:POST:REPEat

CPHY:HSPEed:BURSt:POST:SYMBols?
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Arguments <value>::= <string>

{"0000000" to "4444444"}

It should contain 7 symbols and each symbol value should be between 0 to 4.

Returns The value is returned in a string format.

{"0000000" to "4444444"}.

Example CPHY:HSPEed:BURSt:POST:PATTern "4444444" sets the post pattern.

CPHY:HSPEed:BURSt:POST:PATTern? returns "4444444" as the post pattern.

CPHY:HSPEed:BURSt:POST:REPEat
This command sets or returns the repeat count of post pattern.

Condition Create Burst should be selected.

Group High Speed Burst

Syntax CPHY:HSPEed:BURSt:POST:REPEat <NR1>

CPHY:HSPEed:BURSt:POST:REPEat?

Related commands CPHY:HSPEed:BURSt:POST:SYMBols?

CPHY:HSPEed:BURSt:POST:PATT
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Arguments A single <NR1> value.

Range: {0 to 2000}.

Returns A single <NR1> value, {0 to 2000}.

Example CPHY:HSPEed:BURSt:POST:REPEat 64 sets the post pattern repeat count to 64.

CPHY:HSPEed:BURSt:POST:REPEat? returns 64 as post pattern repeat count.

CPHY:HSPEed:BURSt:POST:SYMBols? (Query only)
This command returns the number of symbols of post pattern.

Condition Create Burst should be selected.

Group High Speed Burst

Syntax CPHY:HSPEed:BURSt:POST:SYMBols?

Related commands CPHY:HSPEed:BURSt:POST:REPEat?

Returns A single <NR1> value.

Example CPHY:HSPEed:BURSt:POST:SYMBols? returns the number of symbols for post
pattern.
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CPHY:HSPEed:WIREstate
This command sets or returns the wire state.

Group High Speed

Syntax CPHY:HSPEed:WIREstate {PLUSX|MINUSX|PLUSY|MINUSY|PLUSZ|
MINUSZ}

CPHY:HSPEed:WIREstate?

Related commands CPHY:HSPEed:CUSTom:FILE

Arguments {PLUSX|MINUSX|PLUSY|MINUSY|PLUSZ|MINUSZ}

Returns PLUSX

MINUSX

PLUSY

MINUSY

PLUSZ

MINUS

Example CPHY:HSPEed:WIREstate PLUSX sets the initial wire state as +x for waveform
generation.

CPHY:HSPEed:WIREstate? returns PLUSX initial wire state for waveform
generation.
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CPHY:LPOWer:PATTern
This command sets or returns the low power base pattern.

Condition Applicable for LP and LPHS signal mode.

Group Low Power

Syntax CPHY:LPOWer:PATTern {ULPS|LP|TEXT}

CPHY:LPOWer:PATTern?

Related commands CPHY:LPOWer:CUSTom:FILE

Arguments {ULPS|LP|TEXT}.

Returns ULPS

LP

TEXT

Example CPHY:LPOWer:PATTern ULPS sets ULPS as the low power pattern.

CPHY:LPOWer:PATTern? returns ULPS as the low power pattern.
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CPHY:LPOWer:CUSTom:FILE
This command sets or returns custom base pattern file for low power.

Condition This is applicable when the Base Pattern is set to Custom . Refer 
CPHY:LPOWer:PATTern.The file can be of three types: ULPS, Low power state
file or Text file.

Group Low Power

Syntax CPHY:LPOWer:CUSTom:FILE <path>

CPHY:LPOWer:CUSTom:FILE?

Related commands CPHY:LPOWer:PATTern

Arguments <path of the file>.

Returns <path of the file>.

Example CPHY:LPOWer:CUSTom:FILE "C:\Users\Public\Tektronix\CPHYXpress
\DataFiles\Custom.txt" sets the custom base pattern file.

CPHY:LPOWer:CUSTom:FILE? returns "C:\Users\Public\Tektronix
\CPHYXpress\DataFiles\Custom.txt" as custom base pattern file path.

Command description  

178



CPHY:LPOWer:CONTent:ENABle
This command enables or disables the option to include LP base pattern content
in the LP-HS signal.

Condition This is applicable in LP-HS signal mode. Refer CPHY:SIGNal.

Group Low Power

Syntax CPHY:LPOWer:CONTent:ENABle {0|1}

CPHY:LPOWer:CONTent:ENABle?

Related commands CPHY:LPOWer:CUSTom:FILE

Arguments {0|1}

0 disables include LP base pattern content.

1 enables include LP base pattern content.

Returns A single <Boolean> value, {0|1}.

Example CPHY:LPOWer:CONTent:ENABle 1 enables the low power content to be
included in the waveforms in LP-HS signal mode.

CPHY:LPOWer:CONTent:ENABle? returns 1 indicating low power content is
included in LP-HS signal mode.
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CPHY:LPOWer:SRATe
This command sets or returns the low power symbol rate.

Condition Signal mode should be Low Power or Low Power-High Speed.

Group Low Power

Syntax CPHY:LPOWer:SRATe <NRf>

CPHY:LPOWer:SRATe?

Related commands CPHY:LPOWer:TLPX

Arguments A single <NRf> value.

Range: {10E+6 to 100E+6} Hz. Resolution: 1 Hz.

Returns A single <NRf> value, {10E+6 to 100E+6}.

Example CPHY:LPOWer:SRATe 100E+6 sets the symbol rate for low power to 100 MHz.

CPHY:LPOWer:SRATe? returns 100E+6 as low power symbol rate.
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CPHY:LPOWer:TLPX? (Query only)
This command returns the low power TLPX value.

Condition Signal mode should be Low Power or Low Power-High Speed.

Group Low Power

Syntax CPHY:LPOWer:TLPX?

Related commands CPHY:LPOWer:SRATe

Returns A single <NRf> value.

Example CPHY:LPOWer:TLPX? returns the TLPX value.

CPHY:LPOWer:RTFT:VALUe
This command sets or returns the rise/fall time in UI.

Condition Signal mode should be Low Power or Low Power-High Speed.

Group Low Power

 Command description

181



Syntax CPHY:LPOWer:RTFT:VALUe <NRf>

CPHY:LPOWer:RTFT:VALUe?

Related commands CPHY:LPOWer:RTFT:SECOnds

Arguments A single <NRf> value.

Range: {0.01 to 0.5}.

Returns A single <NRf> value.

Range: {0.01 to 0.5}.

Example CPHY:LPOWer:RTFT:VALUe 0.5 sets the rise/fall time to 0.5 UI.

CPHY:LPOWer:RTFT:VALUe? returns 500E-3 as rise/fall time value.

CPHY:LPOWer:RTFT:SECOnds (Query only)
This command returns the rise/fall time in seconds.

Condition Signal mode should be Low Power or Low Power-High Speed.

Group Low Power

Syntax CPHY:LPOWer:RTFT:SECOnds?
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Related commands CPHY:LPOWer:RTFT:VALUe

Returns A single <NRf> value.

Example CPHY:LPOWer:RTFT:SECOnds? returns the rise/fall time in seconds.

CPHY:LPOWer:LINEA:HIGH
This command sets or returns the high level voltage for line A.

Group Low Power

Syntax CPHY:LPOWer:LINEA:HIGH <NRf>

CPHY:LPOWer:LINEA:HIGH?

Related commands CPHY:LPOWer:LINEA:LOW

Arguments A single <NRf> value.

Range: {500E-03 to 1.3 (dependent on Line A Low value)}.

Returns A single <NRf> value, {500E-03 to 1.3}

Example CPHY:LPOWer:LINEA:HIGH 500E-03 sets the high level voltage for line A to
500 mV.

CPHY:LPOWer:LINEA:HIGH? returns 500E-03 as high level voltage for line A.
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CPHY:LPOWer:LINEA:LOW
This command sets or returns the low level voltage for line A.

Group Low Power

Syntax CPHY:LPOWer:LINEA:LOW <NRf>

CPHY:LPOWer:LINEA:LOW ?

Related commands PHY:LPOWer:LINEA:HIGH

Arguments A single <NRf> value

Range: {-100E-03 to 700E-03 (dependent on Line A High value)}.

Returns A single <NRf> value, {500E-03 to 1.3}.

Example CPHY:LPOWer:LINEA:LOW 100E-03 sets the low level voltage for line A to
100 mV.

CPHY:LPOWer:LINEA:LOW ? returns 100E-03 as low level voltage value for
line A.

Command description  

184



CPHY:LPOWer:LINEB:HIGH
This command sets or returns the high level voltage for line B.

Group Low Power

Syntax CPHY:LPOWer:LINEB:HIGH <NRf>

CPHY:LPOWer:LINEB:HIGH?

Related commands CPHY:LPOWer:LINEB:LOW

Arguments A single <NRf> value.

Range: {500E-03 to 1.3 (dependent on Line B Low value)}.

Returns A single <NRf> value, {500E-03 to 1.3}.

Example CPHY:LPOWer:LINEB:HIGH 500E-03 sets the high level voltage for line B to
500 mV.

CPHY:LPOWer:LINEB:HIGH? return 500E-03 as high level voltage for line B.
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CPHY:LPOWer:LINEB:LOW
This command sets or returns the low level voltage for line B.

Group Low Power

Syntax CPHY:LPOWer:LINEB:LOW <NRf>

CPHY:LPOWer:LINEB:LOW?

Related commands CPHY:LPOWer:LINEB:HIGH

Arguments A single <NRf> value.

Range: {-100E-03 to 700E-03 (dependent on Line B High Value)}.

Returns A single <NRf> value, {500E-03 to 1.3}.

Example CPHY:LPOWer:LINEB:LOW 100E-03 sets the low level voltage for line B.

CPHY:LPOWer:LINEB:LOW ? returns 100E-03 as the low lovel voltage for line
B.
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CPHY:LPOWer:LINEC:HIGH
This command sets or returns the high level voltage for line C.

Group Low Power

Syntax CPHY:LPOWer:LINEC:HIGH <NRf>

CPHY:LPOWer:LINEC:HIGH?

Related commands CPHY:LPOWer:LINEC:LOW

Arguments A single <NRf> value.

Range: {500E-03 to 1.3 (dependent on line C Low value)}.

Returns A single <NRf> value, {500E-03 to 1.3}.

Example CPHY:LPOWer:LINEC:HIGH 500E-03 sets the high level voltage for line C.

CPHY:LPOWer:LINEC:HIGH? returns 500E-03 as high level voltage for line C.
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CPHY:LPOWer:LINEC:LOW
This command sets or returns the low level voltage for line C.

Group Low Power

Syntax CPHY:LPOWer:LINEC:LOW <NRf>

CPHY:LPOWer:LINEC:LOW?

Related commands CPHY:LPOWer:LINEC:HIGH

Arguments A single <NRf> value.

Range: {-100E-03 to 700E-03 (dependent on line C High value)}.

Returns A single <NRf> value, {500E-03 to 1.3}.

Example CPHY:LPOWer:LINEC:LOW 100E-03 sets the low level voltage for line C.

CPHY:LPOWer:LINEC:LOW ? returns 100E-03 as low level voltage for line C.
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CPHY:LPOWer:USELINEA
This command enables or disables the use line level of A to line B and line C.

Group Low Power

Syntax CPHY:LPOWer:USELINEA {0|1}

CPHY:LPOWer:USELINEA?

Related commands CPHY:LPOWer:LINEC:HIGH

CPHY:LPOWer:LINEB:LOW

Arguments {0|1}.

0 disables the use of using line level of line A to line B and C.

1 enables the use of line A to line B and line C.

Returns A single <Boolean> value, {0|1}.

Example CPHY:LPOWer:USELINEA 1 enables the use of line level of line A to line B
and line C.

CPHY:LPOWer:USELINEA? returns 1 indicating 'Use of Line A levels for Line
B and Line C' is enabled .
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CPHY:LPOWer:STARt:DURAtion:VALUe
This command sets or returns the start timing for LP-HS mode.

Condition Signal mode should be Low Power or Low Power-High Speed.

Group Low Power

Syntax CPHY:LPOWer:STARt:DURAtion:VALUe <NR1>

CPHY:LPOWer:STARt:DURAtion:VALUe?

Related commands CPHY:LPOWer:STARt:DURAtion:SYMBols

Arguments A single <NR1> value.

Range: {1 to 100} LP symbols.

Returns A single <NR1> value, {1 to 100}.

Example CPHY:LPOWer:STARt:DURAtion:VALUe 100 sets the start LP-111 duration of
LP-HS mode to 100 LP symbols.

CPHY:LPOWer:STARt:DURAtion:VALUe? returns 100 as start
LP-111 duration value.
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CPHY:LPOWer:STARt:DURAtion:SYMBols? (Query only)
This command returns the start LP-111 duration of the LP-HS mode in seconds.

Condition This is applicable in LP-HS signal mode.

Group Low Power

Syntax CPHY:LPOWer:STARt:DURAtion:SYMBols?

Related commands CPHY:LPOWer:STARt:DURAtion:VALUe

Returns A single <NR2> value.

Example CPHY:LPOWer:STARt:DURAtion:SYMBols? returns the start LP-111 in
seconds.

CPHY:LPOWer:TPREpare:VALUe
This command sets or returns the LP-000 duration in LP symbols.

Condition Signal mode should be Low Power or Low Power-High Speed.

Group Low Power
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Syntax CPHY:LPOWer:TPREpare:VALUe <NR2>

CPHY:LPOWer:TPREpare:VALUe?

Related commands CPHY:LPOWer:TPREpare:SYMBols

Arguments A single <NR2> value.

Range: {0.5 to 100} LP symbols.

Returns A single <NR2> value, {0.5 to 100}.

Example CPHY:LPOWer:TPREpare:VALUe 100 sets the LP-000 duration to 100 LP
symbols.

CPHY:LPOWer:TPREpare:VALUe? returns 100 as LP-000 duration value.

CPHY:LPOWer:TPREpare:SYMBols? (Query only)
This command returns the LP-000 duration in seconds.

Condition Signal mode should be Low Power or Low Power-High Speed.

Group Low Power

Syntax CPHY:LPOWer:TPREpare:SYMBols?

Related commands CPHY:LPOWer:TPREpare:VALUe
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Returns A single <NRf> value.

Example CPHY:LPOWer:TPREpare:SYMB? returns LP-000 duration in seconds.

CPHY:LPOWer:THSExit:ENABle
This command enables or disables the option to include THS Exit in the LP-HS
waveform.

Condition Signal mode should be Low Power or Low Power-High Speed.

Group Low Power

Syntax CPHY:LPOWer:THSExit:ENABle {0|1}

CPHY:LPOWer:THSExit:ENABle?

Related commands CPHY:LPOWer:END:DURAtion:VALUe

Arguments {0|1}

0 does not include THS_Exit in the waveform.

1 includes THS_Exit in the waveform.

Returns A single <Boolean> value, {0|1}.

Example CPHY:LPOWer:THSExit:ENABle 1 enables THS_Exit to be included in the
waveform.

CPHY:LPOWer:THSExit:ENABle? returns 1 indicating THS_Exit is included in
LP-HS waveform.
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CPHY:LPOWer:END:DURAtion:VALUe
This command sets or returns the end duration value in LP symbols.

Condition This is applicable when 'THS_Exit' is selected.

Group Low Power

Syntax CPHY:LPOWer:END:DURAtion:VALUe <NR2>

CPHY:LPOWer:END:DURAtion:VALUe?

Related commands CPHY:LPOWer:THSExit:ENABle

Arguments A single <NR2> value.

Range: {1-100} LP symbols.

Returns A single <NR2> value, {1-100}.

Example CPHY:LPOWer:END:DURAtion:VALUe 100 sets the end duration value as
100 LP symbols.

CPHY:LPOWer:END:DURAtion:VALUe? returns 100 as end duration value.
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CPHY:LPOWer:END:DURAtion:SYMBols? (Query only)
This command returns the end duration value in symbols.

Condition Applicable for LP and LPHS signal mode.

Group Low Power

Syntax CPHY:LPOWer:END:DURAtion:SYMBols?

Related commands CPHY:LPOWer:END:DURAtion:VALUe

Returns A single <NR1> value.

Example CPHY:LPOWer:END:DURAtion:SYMBols? returns the end duration value in
seconds.

CPHY:LPOWer:NOISe:SINE:ENABle
This command enables or disables the low power sine noise.

Condition Sine Noise should be selected.

Group Low Power Noise
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Syntax CPHY:LPOWer:NOISe:SINE:ENABle {0|1}

CPHY:LPOWer:NOISe:SINE:ENABle?

Related commands CPHY:LPOWer:NOISe:SINE:AMPLitude

Arguments {0|1}

0 disables the low power sine noise.

1 enables the low power sine noise.

Returns A single <Boolean> value, {0|1}.

Example CPHY:LPOWer:NOISe:SINE:ENABle 1 enables the low power sine noise.

CPHY:LPOWer:NOISe:SINE:ENABle? returns 1 indicating low power sine
noise is enabled.

CPHY:LPOWer:NOISe:SINE:AMPLitude
This command sets or returns the low power sine noise amplitude.

Condition Sine Noise should be enabled.

Group Low Power Noise

Syntax CPHY:LPOWer:NOISe:SINE:AMPLitude <NRf>

CPHY:LPOWer:NOISe:SINE:AMPLitude?
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Related commands CPHY:LPOWer:NOISe:SINE:FREQuency

Arguments A single <NRf> value

Range: {0 to 300E-3}

Returns A single <NRf> value, {0 to 300E-3}

Example CPHY:LPOWer:NOISe:SINE:AMPLitude 300 sets the low power sine noise
amplitude to 300 mV.

CPHY:LPOWer:NOISe:SINE:AMPLitude? returns 300 E-03 as the low power
sine noise amplitude.

CPHY:LPOWer:NOISe:SINE:FREQuency
This command sets or returns the sine noise frequency.

Condition Sine Noise should be enabled.

Group Low Power Noise

Syntax CPHY:LPOWer:NOISe:SINE:FREQuency <NRf>

CPHY:LPOWer:NOISe:SINE:FREQuency?

Related commands CPHY:LPOWer:NOISe:SINE:AMPLitude
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Arguments A single <NRf> value.

Range: {100E+3 to 100E+6}.

Returns A single <NRf> value, {100E+3 to 100E+6}.

Example CPHY:LPOWer:NOISe:SINE:FREQuency 100E+6 sets the low power sine noise
frequency to 100 MHz.

CPHY:LPOWer:NOISe:SINE:FREQuency? returns 100E+6 as the low power
sine noise frequency.

CPHY:LPOWer:NOISe:ESPIke:ENABle
This command enables or disables the low power noise eSpike.

Condition Signal mode should be Low Power or LP-HS.

Group Low Power Noise

Syntax CPHY:LPOWer:NOISe:ESPIke:ENABle <bool>

CPHY:LPOWer:NOISe:ESPIke:ENABle?

Related commands CPHY:LPOWer:NOISe:ESPIkeAREA

Arguments 0 disables low noise eSpike.

1 enables the low noise eSpike.
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Returns A single <Boolean> value, {0 or 1}.

Example CPHY:LPOWer:NOISe:ESPIke:ENABle 1 enables the low power noise eSpike.

CPHY:LPOWer:NOISe:ESPIke:ENABle? returns 1 indicating eSpike is enabled
for low power noise.

CPHY:LPOWer:NOISe:ESPIke:AREA
This command sets or returns the eSpike area.

Condition eSpike should be enabled.

Group Low Power Noise

Syntax CPHY:LPOWer:NOISe:ESPIke:AREA <NR1>

CPHY:LPOWer:NOISe:ESPIke:AREA?

Related commands CPHY:LPOWer:NOISe:ESPIke:DURAtion

Arguments A single <NR1>.

Range: {100 to 400}.

Returns A single <NR1> value, {100 to 400}.

Example CPHY:LPOWer:NOISe:ESPIke:AREA 400 sets the low power noise eSpike area
to 400 Vps.

CPHY:LPOWer:NOISe:ESPIke:AREA? returns 400 as the low power noise
eSpike area.
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CPHY:LPOWer:NOISe:ESPIke:DURAtion
This command sets or returns the low power noise eSpike duration.

Condition eSpike should be enabled.

Group Low Power Noise

Syntax CPHY:LPOWer:NOISe:ESPIke:DURAtion <NRf>

CPHY:LPOWer:NOISe:ESPIke:DURAtion?

Related commands CPHY:LPOWer:NOISe:ESPIkeAREA

Arguments A single <NRf> value.

Range: {1E-9 to 5E-9}.

Returns A single <NRf> value, {1E-9 to 5E-9}.

Example CPHY:LPOWer:NOISe:ESPIke:DURAtion 5E-9 sets the low power noise
eSpike duration to 5 ns.

CPHY:LPOWer:NOISe:ESPIke:DURAtion? returns 5E-9 as the low power noise
eSpike duration.
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CPHY:LPOWer:NOISe:SINE:LINEA
This command enables or disables the sine noise for line A.

Condition Sine noise should be selected

Group Low Power Noise

Syntax CPHY:LPOWer:NOISe:SINE:LINEA {0|1}

CPHY:LPOWer:NOISe:SINE:LINEA?

Related commands CPHY:LPOWer:NOISe:SINE:LINEB

CPHY:LPOWer:NOISe:SINE:LINEC

Arguments {0|1}.

1 enables the use of Sine Noise for line A.

0 disables the use of Sine Noise for line A.

Returns A single <Boolean> value, {0|1}.

Example CPHY:LPOWer:NOISe:SINE:LINEA 1 enables the use of sine noise for line A.

CPHY:LPOWer:NOISe:SINE:LINEA? returns 1 indicating sine noise is enabled
for line A.
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CPHY:LPOWer:NOISe:SINE:LINEB
This command enables disables the sine noise for Line B.

Condition Sine noise should be selected

Group Low Power Noise

Syntax CPHY:LPOWer:NOISe:SINE:LINEB {0|1}

CPHY:LPOWer:NOISe:SINE:LINEB?

Related commands CPHY:LPOWer:NOISe:SINE:LINEC

Arguments {0|1}

1 enables the use of Sine Noise for line B.

0 disables the use of Sine Noise for line B.

Returns A single <Boolean> value, {0|1}.

Example CPHY:LPOWer:NOISe:SINE:LINEB 1 enables the use of sine noise for line B.

CPHY:LPOWer:NOISe:SINE:LINEB? returns 1 indicating sine noise is enabled
for line B.
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CPHY:LPOWer:NOISe:SINE:LINEC
This command enables or disables the sine noise for line C.

Condition Sine noise should be selected.

Group Low Power Noise

Syntax CPHY:LPOWer:NOISe:SINE:LINEC {0|1}

CPHY:LPOWer:NOISe:SINE:LINEC?

Related commands CPHY:LPOWer:NOISe:SINE:LINEB

Arguments {0|1}.

1 enables the use of Sine Noise for line C.

0 disables the use of Sine Noise for line C.

Returns A single <Boolean> value, {0|1}.

Example CPHY:LPOWer:NOISe:SINE:LINEC 1 enables the use of sine noise for line C.

CPHY:LPOWer:NOISe:SINE:LINEC? returns 1 indicating sine noise is enabled
for line C.
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CPHY:LPOWer:NOISe:ESPIke:LINEA
This command enables or disables the eSpike for line A.

Condition eSpike should be selected.

Group Low Power Noise

Syntax CPHY:LPOWer:NOISe:ESPIke:LINEA {0|1}

CPHY:LPOWer:NOISe:ESPIke:LINEA?

Related commands CPHY:LPOWer:NOISe:SINE:LINEB

Arguments 1 enables the use of eSpike for line A.

0 disables the use of eSpike for line A.

Returns A single <Boolean> value, {0|1}.

Example CPHY:LPOWer:NOISe:ESPIke:LINEA 1 enables the use of eSpike for line A.

CPHY:LPOWer:NOISe: ESPIke:LINEA? returns 1 indicating eSpike is enabled
for line A.
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CPHY:LPOWer:NOISe:ESPIke:LINEB
This command enables or disables eSpike for line B.

Condition eSpike should be enabled.

Group Low Power Noise

Syntax CPHY:LPOWer:NOISe:ESPIke:LINEB {0|1}

CPHY:LPOWer:NOISe:ESPIke:LINEB?

Related commands CPHY:LPOWer:NOISe:SINE:LINEB

CPHY:LPOWer:NOISe:SINE:LINEC

Arguments {0|1}.

1 enables the use of eSpike for line B.

0 disables the use of eSpike for line B.

Returns A single <Boolean> value, {0|1}.

Example CPHY:LPOWer:NOISe:ESPIke:LINEB 1 enables the use of eSpike for line B.

CPHY:LPOWer:NOISe: ESPIke:LINEB? returns 1 indicating eSpike is enabled
for line B.
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CPHY:LPOWer:NOISe:ESPIke:LINEC
This command enables or disables the eSpike for Line C.

Condition eSpike should be selected.

Group Low Power Noise

Syntax CPHY:LPOWer:NOISe:ESPIke:LINEC {0|1}

CPHY:LPOWer:NOISe:ESPIke:LINEC?

Related commands CPHY:LPOWer:NOISe:SINE:LINEB

Arguments {0|1}.

1 enables the use of eSpike for line C.

0 disables the use of eSpike for line C.

Returns A single <Boolean> value, {0|1}.

Example CPHY:LPOWer:NOISe:ESPIke:LINEC 1 enables the use of eSpike for line C.

CPHY:LPOWer:NOISe: ESPIke:LINEC? returns 1 indicating eSpike is enabled
for line C.
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CPHY:LPOWer:NOISe:TMIN:ENABle
This command enables or disables the noise TMin.

Condition Low Power Noise

Group Low Power Noise

Syntax CPHY:LPOWer:NOISe:TMIN:ENABle {0|1}

CPHY:LPOWer:NOISe:TMIN:ENABle?

Related commands CPHY:LPOWer:NOISe:TMIN:VALUe

Arguments {0|1}

1 enables the low power noise TMin.

0 disables the low power noise TMin.

Returns A single <Boolean> value, {0|1}.

Example CPHY:LPOWer:NOISe:TMIN:ENABle 1 enables low power noise TMin.

CPHY:LPOWer:NOISe:TMIN:ENABle? returns 1 indicating TMin is enabled.
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CPHY:LPOWer:NOISe:TMIN:VALUe
This command enables or disables the low power noise TMin value.

Condition In Low Power Noise TMin should be selected.

Group Low Power Noise

Syntax CPHY:LPOWer:NOISe:TMIN:ENABle <NR2>

CPHY:LPOWer:NOISe:TMIN:ENABle?

Related commands CPHY:LPOWer:NOISe:TMIN:ENABle

Arguments A single <NR2> value

Range: {0 to 50}.

Returns A single <NR2> value.

Range: {0 to 50}.

Example CPHY:LPOWer:NOISe:TMIN:ENABle 10E-9 sets the low power noise TMin
value to 10 ns.

CPHY:LPOWer:NOISe:TMIN:ENABle? returns 10E-9 as TMin.

Command description  

208



CPHY:HSPEed:BATCh:ENABle
This command enables or disables the batch waveform creation.

Condition Signal mode should be Low Power or Low Power-High Speed.

Group High Speed Batch

Syntax CPHY:HSPEed:BATCh:ENABle {0|1}

CPHY:HSPEed:BATCh:ENABle?

Related commands CPHY:HSPEed:BATCh:PARAmeter

Arguments {0|1}

0 disables the batch waveform creation.

1 enables the batch waveform creation.

Returns A single <Boolean> value, {0|1}.

Example CPHY:HSPEed:BATCh:ENABle 1 enables the batch waveform creation.

CPHY:HSPEed:BATCh:ENABle? returns 1 indicating overwrite existing
sequence is enabled.
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CPHY:HSPEed:BATCh:PARAmeter
This command sets or returns the batch parameter type.

Condition Batch waveform creation should be selected.

Group High Speed Batch

Syntax CPHY:HSPEed:BATCh:PARAmeter {PJ|PJF|RJ|DCD|PRE|POST}

CPHY:HSPEed:BATCh:PARAmeter?

Related commands CPHY:HSPEed:BATCh:ENABle

Arguments {PJ|PJF|RJ|DCD|PRE|POST}

Returns PJ

PJF

RJ

DCD

PRE

POST

Example CPHY:HSPEed:BATCh:PARAmeter PJ sets the batch parameter to PJ.

CPHY:HSPEed:BATCh:PARAmeter? returns PJ as the batch parameter.
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CPHY:HSPEed:BATCh:STARt
This command sets or returns the start value of the selected batch mode
parameter type.

Condition Batch waveform creation should be enabled.

Group High Speed Batch

Syntax CPHY:HSPEed:BATCh:STARt <NR2>

CPHY:HSPEed:BATCh:STARt?

Related commands CPHY:HSPEed:BATCh:END

Arguments A single <NR2> value.

Returns A single <NR2> value.

Example CPHY:HSPEed:BATCh:STARt 0.99 sets the start value of selected batch mode.

CPHY:HSPEed:BATCh:STARt? returns 0.99 as the start value of selected batch
mode.

The table below shows the default range value for all the parameters:

Parameter Units Range
Min Max

Periodic Jitter UI 0 0.99 
Periodic_Jitter_Freque
ncy

MHz 1 299 

Random Jitter UI 0 0.29 
Duty_Cycle_Distortion % 0 39 
PreBegin_Repeat Words 0 990 
Post_Repeat Words 0 63 
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CPHY:HSPEed:BATCh:END
This command sets or returns the end value of the selected batch mode parameter
type.

Condition End value depends on the start value of corresponding parameter type. Batch
waveform creation should be selected.

Group High Speed Batch

Syntax CPHY:HSPEed:BATCh:END <NR2>

CPHY:HSPEed:BATCh:END?

Related commands CPHY:HSPEed:BATCh:STARt

Arguments A single <NR2> value.

Returns A single <NR2> value.

Example CPHY:HSPEed:BATCh:END 1 sets the end value of the selected batch mode
parameter type to 1.

CPHY:HSPEed:BATCh:END? returns 1 as the end value of the selected batch
mode parameter type.

Range varies depending upon the parameters selected. The table below shows the
range of end value for all the parameters:

Parameter Units Range
Start End

Periodic Jitter UI 0.01 1 
Periodic_Jitter_Freque
ncy

MHz 2 300 

Random_Jitter UI 0.01 0.3 
Duty_Cycle_Distortion % 1 40 
PreBegin_Repeat Words 10 1000 
Post_Repeat Words 1 64 
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CPHY:HSPEed:BATCh:INCRement
This command sets or returns the increment value of the selected batch mode
parameter type.

Condition Increment value depends on the End value of corresponding parameter type.
Batch waveform creation should be selected.

Group High Speed Batch

Syntax CPHY:HSPEed:BATCh:INCRement <NRf>

CPHY:HSPEed:BATCh:INCRement?

Related commands CPHY:HSPEed:BATCh:ENABle

Arguments A single <NRf> value.

Returns A single <NRf> value.

Example CPHY:HSPEed:BATCh:INCRement sets the increment value of the selected
batch mode parameter type

CPHY:HSPEed:BATCh:INCRement? returns the increment value of the selected
batch mode parameter type

The table below shows the default range of increment values for all the
parameters:

Parameter Units Range
Start End

Periodic Jitter UI 0.01 1 
Periodic_Jitter_Freque
ncy

MHz 1 299 

Random_Jitter UI 0.01 0.3 
Duty_Cycle_Distortion % 1 40 
PreBegin_Repeat Words 10 1000 
Post_Repeat Words 1 64 
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CPHY:HSPEed:BATCh:WAVEformNo? (Query only)
This command returns the total number of waveforms that will be generated in
the batch mode.

Condition Batch waveform creation should be selected.

Group High Speed Batch

Syntax CPHY:HSPEed:BATCh:WAVEformNo?

Related commands CPHY:HSPEed:BATCh:ENABle

Returns A single <NR1> value.

Example CPHY:HSPEed:BATCh:WAVEformNo? returns the total number of waveforms
that is generated in the batch mode.

CPHY:PREFerence:SRATe:MODE
This command sets or returns the sample rate mode.

Group Preferences

Syntax CPHY:PREFerence:SRATe:MODE <value>

CPHY:PREFerence:SRATe:MODE?
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Related commands CPHY:PREFerence:SAMPlesperui

Arguments {AUTO|MANUal}

Returns AUTO

MANUal

Example CPHY:PREFerence:SRATe:MODE AUTO sets the sample rate mode to Auto.

CPHY:PREFerence:SRATe:MODE? returns indicating AUTO as the sample rate
mode.

CPHY:PREFerence:SAMPlesperui
This command sets or returns the value of samples per unit interval.

Condition Signal Mode should be High Speed to get Samples per UI for High Speed.

Signal Mode should be Low Power to get Samples per UI for Low Power.

Group Preferences

Syntax CPHY:PREFerence:SAMPlesperui<NR1>

CPHY:PREFerence:SAMPlesperui?

Related commands CPHY:PREFerence:SRATe:MODE
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Arguments A single <NR1> value.

Range: {4 to 500 for High Speed, 4 to 2500 for Low Power}.

Returns A single <NR1> value, {4 to 500 for High Speed, 4 to 2500 for Low Power}.

Example CPHY:PREFerence:SAMPlesperui 4 sets the samples per UI to 4.

CPHY:PREFerence:SAMPlesperui? returns 4 as the sample per UI.

CPHY:PREFerence:SRATe:VALUe? (Query only)
This command returns the sample rate for High Speed and Low Power.

Condition Signal Mode should be High Speed to get Sample rate for High Speed.

Signal Mode should be Low Power to get Sample rate for Low Power.

Group Preferences

Syntax CPHY:PREFerence:SRATe:VALUe?

Related commands CPHY:PREFerence:SAMPlesperui

Returns A single <NR1> value.

Example CPHY:PREFerence:SRATe:VALUe? returns the value of sample rate.
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CPHY:PREFerence:SAMPlesperui:HIGH
This command sets or returns the samples per unit interval of High speed signal.

Condition Signal Mode should be High speed.

Group Preferences

Syntax CPHY:PREFerence:SAMPlesperui:HIGH <NR1>

CPHY:PREFerence:SAMPlesperui:HIGH?

Related commands CPHY:PREFerence:SRATe:MODE

Arguments A single <NR1> value

Range: {4 to 500}

Returns A single <NR1> value

Range: {4 to 500}

Example CPHY:PREFerence:SAMPlesperui:HIGH 4 sets the samples per UI to 4.

CPHY:PREFerence:SAMPlesperui:HIGH? returns 4 as the sample per UI.
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CPHY:PREFerence:SAMPlesperui:LOW
This command sets or returns the samples per unit interval of Low power signal.

Condition Signal Mode should be Low power.

Group Preferences

Syntax CPHY:PREFerence:SAMPlesperui:LOW <NR1>

CPHY:PREFerence:SAMPlesperui:LOW?

Related commands CPHY:PREFerence:SRATe:MODE

Arguments A single <NR1> value

Range: {4 to 2500}

Returns A single <NR1> value

Range: {4 to 2500}

Example CPHY:PREFerence:SAMPlesperui:LOW 4 sets the samples per UI to 4.

CPHY:PREFerence:SAMPlesperui:LOW? returns 4 as the sample per UI.
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CPHY:PREFerence:SRATe:HIGH:VALUe?(Query only)
This command returns the sample rate of High speed signal.

Group Preferences

Syntax CPHY:PREFerence:SRATe:HIGH:VALUe?

Related commands CPHY:PREFerence:SRATe:MODE

Returns A single <NRf> value.

Example CPHY:PREFerence:SRATe:HIGH:VALUe? returns the sample rate of High
speed signal.

CPHY:PREFerence:SRATe:LOW:VALUe (Query only)
This command returns the sample rate of Low power signal.

Group Preferences

Syntax CPHY:PREFerence:SRATe:LOW:VALUe?

Related commands CPHY:PREFerence:SRATe:MODE
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Returns A single <NRf> value

Example CPHY:PREFerence:SRATe:LOW:VALUe? returns the sample rate of Low
power signal.

CPHY:PREFerence:SKEW:ACLIne
This command sets or returns the skew value of line A to line C.

Group Preferences

Syntax CPHY:PREFerence:SKEW:ACLIne <NRf>

CPHY:PREFerence:SKEW:ACLIne?

Related commands CPHY:PREFerence:SKEW:ABLIne

Arguments A single <NRf> value.

Range: {-2E-9 to 2E-9}.

Returns A single <NRf> value, {-2E-9 to 2E-9}.

Example CPHY:PREFerence:SKEW:ACLIne 1.96E09 sets the skew value as 1.96 ns for
line A to line C.

CPHY:PREFerence:SKEW:ACLIne? returns 1.96E09 as the skew value for line
A to line C.
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CPHY:PREFerence:SKEW:ABLIne
This command sets or returns the skew value of line A to line B.

Group Preferences

Syntax CPHY:PREFerence:SKEW:ABLIne <NRf>

CPHY:PREFerence:SKEW:ABLIne?

Related commands CPHY:PREFerence:SKEW:ACLIne

Arguments A single <NRf> value.

Range: {-2E-9 to 2E-9}.

Returns A single <NRf> value, {-2E-9 to 2E-9}.

Example CPHY:PREFerence:SKEW:ABLIne 1.96E09 sets the skew value as 1.96 ns for
line A to line B.

CPHY:PREFerence:SKEW:ABLIne? returns 1.96E09 as the skew value for line
A to line B.
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CPHY:PREFerence:AWGAmplitude:MODE
This command sets or returns the amplitude and offset control mode.

Group Preferences

Syntax CPHY:PREFerence:AWGAmplitude:MODE <value>

CPHY:PREFerence:AWGAmplitude:MODE?

Related commands CPHY:PREFerence:AWGAmplitude:OFFSet:VALUe

Arguments {AUTO|MANUal}

Returns AUTO

MANUal

Example CPHY:PREFerence:AWGAmplitude:MODE AUTO sets the amplitude value to
Auto.

CPHY:PREFerence:AWGAmplitude:MODE? returns AUTO as the amplitude
mode.
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CPHY:PREFerence:AWGAmplitude:OFFSet:VALUe
This command sets or returns the offset.

Group Preferences

Syntax CPHY:PREFerence:AWGAmplitude:OFFSet:VALUe <NRf>

CPHY:PREFerence:AWGAmplitude:OFFSet:VALUe?

Related commands CPHY:PREFerence:AWGAmplitude:AMPLitude:VALUe

Arguments A single <NRf> value.

Range: {-400E-03 to 800E03}

Returns A single <NRf> value, {-400E-03 to 800E03}

Example CPHY:PREFerence:AWGAmplitude:OFFSet:VALUe 500E-03 sets the offset to
500 mV.

CPHY:PREFerence:AWGAmplitude:OFFSet:VALUe? returns 500E-03 as the
offset value.
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CPHY:PREFerence:AWGAmplitude:AMPLitude:VALUe
This command sets or returns the AWG amplitude.

Condition AWG amplitude mode should be Manual.

Group Preferences

Syntax CPHY:PREFerence:AWGAmplitude:AMPLitude:VALUe? <NRf>

CPHY:PREFerence:AWGAmplitude:AMPLitude:VALUe?

Related commands CPHY:PREFerence:AWGAmplitude:OFFSet:VALUe

Arguments A single <NRf> value.

Range: {31E-03 to 1.2}.

Returns A single <NRf> value, {31E-03 to 1.2}.

Example CPHY:PREFerence:AWGAmplitude:AMPLitude:VALUe 32E-03 sets the AWG
amplitude to 32 mV.

CPHY:PREFerence:AWGAmplitude:AMPLitude:VALUe? returns 32E-03 as the
AWG amplitude.

Command description  

224



CPHY:PREFerence:STARtupsignal:ENABle
This command enables or disables the startup signal.

Group Preferences

Syntax CPHY:PREFerence:STARtupsignal:ENABle {0|1}

CPHY:PREFerence:STARtupsignal:ENABle?

Related commands CPHY:PREFerence:STARtupsignal:LINEB

CPHY:PREFerence:STARtupsignal:LINEC

Arguments {0|1}

0 disables startup signal.

1 enables startup signal.

Returns A single <Boolean> value, {0|1}

Example CPHY:PREFerence:STARtupsignal:ENABle 1 enables the startup signal to be
included in the waveform.

CPHY:PREFerence:STARtupsignal:ENABle? returns 1 indicating startup signal
is enabled.
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CPHY:PREFerence:STARtupsignal:LINEA
This command sets or returns the startup signal for line A.

Group Preferences

Syntax CPHY:PREFerence:STARtupsignal:LINEA {LPHIGH|LPLOW}

CPHY:PREFerence:STARtupsignal:LINEA?

Related commands CPHY:PREFerence:STARtupsignal:LINEB

Arguments {LPHIGH|LPLOW}

Returns LPHIGH

LPLOW

Example CPHY:PREFerence:STARtupsignal:LINEA LPHIGH offsets the startup signal of
line A to LPHIGH.

CPHY:PREFerence:STARtupsignal:LINEA? returns LPHIGH as the value of
startup signal for line A.
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CPHY:PREFerence:STARtupsignal:LINEB
This command sets or returns the startup signal for line B.

Group Preferences

Syntax CPHY:PREFerence:STARtupsignal:LINEB {LPHIGH|LPLOW}

CPHY:PREFerence:STARtupsignal:LINEB?

Related commands CPHY:PREFerence:STARtupsignal:LINEC

Arguments {LPHIGH|LPLOW}

Returns LPHIGH

LPLOW

Example CPHY:PREFerence:STARtupsignal:LINEB LPHIGH offsets the startup signal of
line B to LPHIGH.

CPHY:PREFerence:STARtupsignal:LINEB? returns LPHIGH as the value of
startup signal for line B.
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CPHY:PREFerence:STARtupsignal:LINEC
This command sets or returns the startup signal for line C.

Group Preferences

Syntax CPHY:PREFerence:STARtupsignal:LINEC {LPHIGH|LPLOW}

CPHY:PREFerence:STARtupsignal:LINEC?

Related commands CPHY:PREFerence:STARtupsignal:LINEB

Arguments {LPHIGH|LPLOW}

Returns LPHIGH

LPLOW

Example CPHY:PREFerence:STARtupsignal:LINEC LPHIGH offsets the startup signal
for line C to LPHIGH.

CPHY:PREFerence:STARtupsignal:LINEC? returns LPHIGH as the value of
startup signal for line C.
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CPHY:CSETtings:WAVEform:SEQUence
This command sets or returns the name of the sequence.

Condition Compile and assign to option should be selected.

Group Compile Settings

Syntax CPHY:CSETtings:WAVEform:SEQUence "string"

CPHY:CSETtings:WAVEform:SEQUence?

Related commands CPHY:CSETtings:COMPile

Arguments <String>::= <Sequence name entered by user>

<Sequence name>

Returns <Sequence name>

Example CPHY:CSETtings:WAVEform:SEQUence "CPhySequence" sets the waveform
sequence as CPhySequence.

CPHY:CSETtings:WAVEform:SEQUence? returns "CPhySequence" as the
waveform sequence.
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CPHY:CSETtings:WAVEform:NAME
This command sets or returns the name of the waveform.

Group Compile Settings

Syntax CPHY:CSETtings:WAVEform:NAME <string>

CPHY:CSETtings:WAVEform:NAME?

Related commands CPHY:CSETtings:WAVEform:OVERwrite

Arguments <String>::= <Waveform name entered by user>

<Waveform name>

Returns <Waveform name>

Example CPHY:CSETtings:WAVEform:NAME "CPHY-Example" sets the waveform
name as CPHY-Example.

CPHY:CSETtings:WAVEform:NAME? returns "CPHY-Example" as the
waveform name.
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CPHY:SIGNal
This command sets or returns the signal mode.

Group Miscellaneous

Syntax CPHY:SIGNal {LP|HS|LPHS}

CPHY:SIGNal?

Arguments {LP|HS|LPHS}

Returns LP

HS

LPHS

Example CPHY:SIGNal LP sets the signal mode to LP.

CPHY:SIGNal? returns LP as the signal mode.

CPHY:RESEt (No Query form)
This command resets the plugin settings to default settings.

Group Miscellaneous

Syntax CPHY:RESEt
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Example CPHY:RESEt reset plugin.

CPHY:VERSion? (Query only)
This command sets or returns CPHYXPRESS version.

Condition Active waveform plug-in should be CPHYXpress.

Group Miscellaneous

Syntax CPHY:VERSion?

Returns String value

Example CPHY:VERSion? returns the CPHYXPRESS version.

WPLUgin:ACTIve (No Query form)
This command sets or returns the active waveform plugin. Enables to launch the
application.

Condition Plug-in should be installed.

Group Miscellaneous
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Syntax WPLUgin:ACTive "Plugin name"

Arguments String value - It should be a plugin name.

Returns Returns a string value which is a plugin name.

Example WPLUgin:ACTIve "CPHYXpress" sets the active plug-in to CPHYXpress.

WPLUgin:ACTIve? returns "CPHYXpress" as the active plug-in.

CPHY:COMPile (No Query form)
This command initiates to compile the waveform.

Condition Active waveform plug-in should be CPHYXpress.

Group Miscellaneous

Syntax CPHY:COMPile

Example CPHY:COMPile compiles waveform.
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CPHY:COMPile:STATus?
This command initiates to compile status.

Condition Active waveform plug-in should be CPHYXpress.

Group Miscellaneous

Syntax CPHY:COMPile:STATus {0/NONE|1}

Returns A single <Boolean> value, {0/NONE|1}. 0 or NONE value returns when
waveform compilation is in progress. 1 returns when waveform compilation is
completed.

Example CPHY:COMPile:STATus? may return 0 as the compile status.

CPHY:COMPile:CANCel (No Query form)
This command cancels compilation.

Group Miscellaneous

Syntax CPHY:COMPile:CANCel

Example CPHY:COMPile:CANCel cancels compilation.
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CPHY:CSETtings:WAVEform:OVERwrite
This command enables or disables waveform overwrite.

Condition There should be an existing waveform with the same waveform name.

Group Compile Settings

Syntax CPHY:CSETtings:WAVEform:OVERwrite {0|1}

CPHY:CSETtings:WAVEform:OVERwrite?

Related commands CPHY:CSETtings:WAVEform:NAME

Arguments {0|1}

0 disables overwrite waveform.

1 enables overwrite waveform.

Returns A single <Boolean> value {0|1}.

Example CPHY:CSETtings:WAVEform:OVERwrite 1 enables overwrite existing
waveform.

CPHY:CSETtings:WAVEform:OVERwrite? returns 1 indicating overwrite
existing waveform is enabled.
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CPHY:CSETtings:COMPile
This command sets or returns the type of compile option.

Group Compile Settings

Syntax CPHY:CSETtings:COMPile <value>

CPHY:CSETtings:COMPile?

Related commands CPHY:CSETtings:SLAVe:ENABle

Arguments {COMP, CSENd}.

Returns COMP

CSENd

Example CPHY:CSETtings:COMPile COMP sets the compile option to compile.

CPHY:CSETtings:COMPile? returns COMP as the compile option.
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CPHY:CSETtings:SWITchlogview
This command enables/disables switch log view.

Group Compile Settings

Syntax CPHY:CSETtings:SWITchlogview <value>

CPHY:CSETtings:SWITchlogview?

Related commands CPHY:CSETtings:SLAVe:ENABle

Arguments {0|1}

0 disables switch log view

1 enables switch log view

Returns A single <Boolean> value, {0|1}.

Example CPHY:CSETtings:SWITchlogview 1 enables switch log view.

CPHY:CSETtings:SWITchlogview? returns 1 indicating switch log view is
enabled.
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CPHY:CSETtings:MASTer:CHONe
This command sets or returns the line waveform of Master channel one.

Condition Compile and assign to option should be selected. Master should be enabled and
connected.

Group Compile Settings

Syntax CPHY:CSETtings:MASTer:CHONe <value>

CPHY:CSETtings:MASTer:CHONe?

Related commands CPHY:CSETtings:MASTer:CHTWo

Arguments {VA|VB|VC}

Returns VA

VB

VC

Example CPHY:CSETtings:MASTer:CHONe VA sets the master channel one to line
waveform VA.

CPHY:CSETtings:MASTer:CHONe? returns VA as the line waveform of master
channel one.
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CPHY:CSETtings:MASTer:CHTWo
This command sets or returns the line waveform of Master channel two.

Condition Compile and assign to option should be selected. Master should be enabled and
connected.

Group Compile Settings

Syntax CPHY:CSETtings:MASTer:CHTWo <value>

CPHY:CSETtings:MASTer:CHTWo?

Related commands CPHY:CSETtings:MASTer:CHONe

Arguments {VA|VB|VC}

Returns VA

VB

VC

Example CPHY:CSETtings:MASTer:CHTWo VA sets the master channel two to line
waveform VA.

CPHY:CSETtings:MASTer:CHTWo? returns VA as the line waveform of master
channel two.
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CPHY:CSETtings:SLAVe:ENABle
This command enables or disables the value to enable or disable the slave.

Condition This option will be enabled only when compile and assign to option is selected.

Group Compile setting

Syntax CPHY:CSETtings:SLAVe:ENABle {0|1}

CPHY:CSETtings:SLAVe:ENABle?

Arguments {0|1}

0 disables the slave.

1 enables the slave.

Returns A single <boolean> value, {0|1}.

Example CPHY:CSETtings:SLAVe:ENABle 1 enables the slave.

CPHY:CSETtings:SLAVe:ENABle returns 1 indicating slave is enabled.
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CPHY:CSETtings:SLAVe:IPADDress
This command sets or returns the slave IP address.

Condition This option will be enabled only when slave is selected.

Group Compile Settings

Syntax CPHY:CSETtings:SLAVe:IPADDresss <Slave IP address>

CPHY:CSETtings:SLAVe:IPADDress?

Related commands CPHY:CSETtings:SLAVe:ENABle

Arguments A single <"string"> value, should be a valid IPV6/IPV4.

Returns A single <"string"> value.

Example CPHY:CSETtings:SLAVe:IPADDress 134.64.220.21 sets the slave IP address to
134.64.220.21.

CPHY:CSETtings:SLAVe:IPADDress? returns 134.64.220.21 as slave IP
address.
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CPHY:CSETtings:SLAVe:CHONe
This command sets or returns the line waveform of Slave channel one.

Condition Compile and assign to option should be selected. Slave should be enabled and
connected.

Group Compile Settings

Syntax CPHY:CSETtings:SLAVe:CHONe <value>

CPHY:CSETtings:SLAVe:CHONe?

Related commands CPHY:CSETtings:SLAVe:CHTWo

Arguments {VA|VB|VC}

Returns VA

VB

VC

Example CPHY:CSETtings:SLAVe:CHONe VA sets the slave channel one to line
waveform VA.

CPHY:CSETtings:SLAVe:CHONe? returns VA as the line waveform of slave
channel one.
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CPHY:CSETtings:SLAVe:CHTWo
This command sets or returns the line waveform of Slave channel two.

Condition Compile and assign to option should be selected. Slave should be enabled and
connected.

Group Compile Settings

Syntax CPHY:CSETtings:SLAVe:CHTWo <value>

CPHY:CSETtings:SLAVe:CHTWo?

Related commands CPHY:CSETtings:SLAVe:CHONe

Arguments {VA|VB|VC}

Returns VA

VB

VC

Example CPHY:CSETtings:SLAVe:CHTWo VA sets the slave channel two to line
waveform VA.

CPHY:CSETtings:SLAVe:CHTWo? returns VA as the line waveform of slave
channel two.
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CPHY:CSETtings:SLAVe:ISCOnnected
This command sets or returns the value to connect or disconnect the slave.

Condition Compile and assign to option should be selected. Slave should be enabled and
connected with a valid IP address.

Group Compile Settings

Syntax CPHY:CSETtings:SLAVe:ISCOnnected {0|1}

CPHY:CSETtings:SLAVe:ISCOnnected?

Related commands CPHY:CSETtings:SLAVe:ENABle

Arguments {0|1}

0 disconnects the slave connection.

1 establishes slave connection.

Returns A single <NR1> value, {0|1}.

Example CPHY:CSETtings:SLAVe:ISCOnnected 1 establishes slave connection.

CPHY:CSETtings:SLAVe:ISCOnnected? returns 1 indicating the slave is
connected.
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CPHY:CSETtings:WAVEform:APPEND
This command enables or disables the option to append the waveform sequence
in AWG.

Condition Compile and assign to option should be selected.

Group Compile Settings

Syntax CPHY:CSETtings:WAVEform:APPEND {0|1}

CPHY:CSETtings:WAVEform:APPEND?

Related commands CPHY:CSETtings:SEQUence:OVERwrite

Arguments {0|1}

0 disables append waveform to sequence.

1 enables append waveform to sequence.

Returns A single <Boolean> value, {0|1}

Example CPHY:CSETtings:WAVEform:APPEND 1 enables append waveform to
sequence.

CPHY:CSETtings:WAVEform:APPEND? returns 1 indicating append waveform
to sequence is enabled.
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CPHY:PREFerence:CORRection:ENABle
This command enables or disables the application of correction file.

Condition Correction file on any of the channels of master and slave should be selected. A
valid correction file must be given.

Group Preferences

Syntax CPHY:PREFerence:CORRection:ENABle <bool>

CPHY:PREFerence:CORRection:ENABle?

Related commands CPHY:PREFerence:CORRection:GAUSsian

Arguments A single <Boolean> value, {0|1}.

0 disables the application of correction file.

1 enables the application of correction file.

Returns A single <Boolean> value, {0|1}

Example CPHY:PREFerence:CORRection:ENABle 1 enables the application of correction
file.

CPHY:PREFerence:CORRection:ENABle? returns 1 indicating application of
correction file is enabled.
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CPHY:PREFerence:CORRection:MASTer:CHOne:ENABle
This command enables or disables the application of correction file on Master
channel one.

Condition Apply Correction File should be selected.

Group Preferences

Syntax CPHY:PREFerence:CORRection:MASTer:CHOne:ENABle <bool>

CPHY:PREFerence:CORRection:MASTer:CHOne:ENABle?

Related Commands CPHY:PREFerence:CORRection:MASTer:CHTwo:ENABle

Arguments A single <Boolean> value, {0|1}.

0 disables the application of correction file on Master channel one.

1 enables the application of correction file on Master channel one.

Returns A single < Boolean> value, {0|1}.

Example CPHY:PREFerence:CORRection:MASTer:CHOne:ENABle1 applies correction
file on master channel one.

CPHY:PREFerence:CORRection:MASTer:CHOne:ENABle? returns 1 indicating
correction file will be applied on master channel one.
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CPHY:PREFerence:CORRection:MASTer:CHTwo:ENABle
This command enables or disables the application of correction file on Master
channel two.

Condition Apply Correction File should be selected.

Group Preferences

Syntax CPHY:PREFerence:CORRection:MASTer:CHTwo:ENABle {0|1}

CPHY:PREFerence:CORRection:MASTer:CHTwo:ENABle?

Related commands CPHY:PREFerence:CORRection:MASTer:CHOne:ENABle

Arguments A single boolean value, {0|1}.

0 disables the application of correction file on Master channel two.

1 enables the application of correction file on Master channel two.

Returns A single boolean value, {0|1}.

Example CPHY:PREFerence:CORRection:MASTer:CHTwo:ENABle1 applies correction
file on master channel two.

CPHY:PREFerence:CORRection:MASTer:CHTwo:ENABle? returns
1 indicating correction file will be applied on master channel two.
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CPHY:PREFerence:CORRection:MASTer:CHOne:FILE
This command sets or returns the correction file path of Master channel one.

Condition Apply Correction File and Master Channel one should be selected.

Group Preferences

Syntax CPHY:PREFerence:CORRection:MASTer:CHOne:FILE <"file path">

CPHY:PREFerence:CORRection:MASTer:CHOne:FILE?

Related Commands CPHY:PREFerence:CORRection:MASTer:CHTwo:FILE

Arguments <"file path">

Returns <"file path">

Example CPHY:PREFerence:CORRection:MASTer:CHOne:FILE “C:\\sample.corr” sets
the master channel one correction file path to C:\\sample.corr.

CPHY:PREFerence:CORRection:MASTer:CHOne:FILE? returns C:\
\sample.corr as the correction file path of master channel one.
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CPHY:PREFerence:CORRection:MASTer:CHTwo:FILE
This command sets or returns the correction file path of Master channel two.

Condition Apply Correction File and Master Channel one should be selected.

Group Preferences

Syntax CPHY:PREFerence:CORRection:MASTer:CHTwo:FILE "file path"

CPHY:PREFerence:CORRection:MASTer:CHTwo:FILE?

Related Commands CPHY:PREFerence:CORRection:MASTer:CHOne:FILE

Arguments "file path"

Returns "file path"

Example CPHY:PREFerence:CORRection:MASTer:CHTwo:FILE “C:\\sample.corr” sets
correction file path of master channel two.

CPHY:PREFerence:CORRection:MASTer:CHTwo:FILE returns “c:\
\sample.corr” as the correction file path of master channel two.

Command description  

250



CPHY:PREFerence:CORRection:SLAVe:CHOne:ENABle
This command enables or disables the application of correction file on Slave
channel one.

Condition Apply Correction File should be selected.

Group Preferences

Syntax CPHY:PREFerence:CORRection:SLAVe:CHOne:ENABle <bool>

CPHY:PREFerence:CORRection:SLAVe:CHOne:ENABle?

Related Commands CPHY:PREFerence:CORRection:SLAVe:CHTWo:ENABle

Arguments A single <Boolean> value, {0|1}.

0 disables the application of correction file on Slave channel one.

1 enables the application of correction file on Slave channel one.

Returns A single < Boolean> value, {0|1}.

Example CPHY:PREFerence:CORRection:SLAVe:CHOne:ENABle 1 applies correction
file on slave channel one.

CPHY:PREFerence:CORRection:SLAVe:CHOne:ENABle? returns 1 indicating
correction file will be applied on slave channel one.
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CPHY:PREFerence:CORRection:SLAVe:CHTWo:ENABle
This command enables or disables the application of correction file on Master
channel two.

Condition Apply Correction File should be selected.

Group Preferences

Syntax CPHY:PREFerence:CORRection:SLAVe:CHTWo:ENABle {0|1}

CPHY:PREFerence:CORRection:SLAVe:CHTWo:ENABle?

Related commands CPHY:PREFerence:CORRection:SLAVe:CHOne:ENABle

Arguments A single boolean value, {0|1}.

0 disables the application of correction file on Slave channel two.

1 enables the application of correction file on Slave channel two.

Returns A single boolean value, {0|1}.

Example CPHY:PREFerence:CORRection:SLAVe:CHTWo:ENABle 1 applies correction
file on slave channel two.

CPHY:PREFerence:CORRection:SLAVe:CHTWo:ENABle? returns 1 indicating
correction file will be applied on slave channel two.
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CPHY:PREFerence:CORRection:SLAVe:CHOne:FILE
This command sets or returns the correction file path of slave channel one.

Condition Apply Correction File and Slave Channel one should be selected.

Group Preferences

Syntax CPHY:PREFerence:CORRection:SLAVe:CHOne:FILE <"file path">

CPHY:PREFerence:CORRection:SLAVe:CHOne:FILE?

Related Commands CPHY:PREFerence:CORRection:SLAVe:CHTwo:FILE

Arguments <"file path">

Returns <"file path">

Example CPHY:PREFerence:CORRection:SLAVe:CHOne:FILE “C:\\sample.corr” sets
the slave channel one correction file path to C:\\sample.corr.

CPHY:PREFerence:CORRection:SLAVe:CHOne:FILE? returns C:\\sample.corr
as the correction file path of slave channel one.

 Command description

253



CPHY:PREFerence:CORRection:SLAVe:CHTwo:FILE
This command sets or returns the correction file path of slave channel two.

Condition Apply Correction File and Slave Channel two should be selected.

Group Preferences

Syntax CPHY:PREFerence:CORRection:SLAVe:CHTwo:FILE <"file path">

CPHY:PREFerence:CORRection:SLAVe:CHTwo:FILE?

Related Commands CPHY:PREFerence:CORRection:SLAVe:CHOne:FILE

Arguments <"file path">

Returns <"file path">

Example CPHY:PREFerence:CORRection:SLAVe:CHTwo:FILE “C:\\sample.corr” sets
the slave channel two correction file path to C:\\sample.corr.

CPHY:PREFerence:CORRection:SLAVe:CHTwo:FILE? returns C:\\sample.corr
as the correction file path of slave channel two.
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CPHY:PREFerence:CORRection:REMOve
This command enables or disables the removal of Sin(x)/x distortions from
correction file.

Condition Apply Correction File and Master Channel one should be selected.

Group Preferences

Syntax CPHY:PREFerence:CORRection:REMOve <bool>

CPHY:PREFerence:CORRection:REMOve?

Related Commands CPHY:PREFerence:CORRection:GAUSsian

Arguments A single <Boolean> value, {0|1}.

0-disables the removal of Sin(x)/x distortions from correction file.

1-enables the removal of Sin(x)/x distortions from correction file.

Returns A single <Boolean> value, {0|1}

Example CPHY:PREFerence:CORRection:REMOve enables the removal of Sin(x)/x
distortions from correction file.

CPHY:PREFerence:CORRection:REMOve? returns 1 indicating removal of
Sin(x)/x distortions from correction file is enabled.
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CPHY:PREFerence:CORRection:GAUSsian
This command enables or disables application of Gaussian filter.

Condition Apply Correction File should be selected.

Group Preferences

Syntax CPHY:PREFerence:CORRection:GAUSsian <bool>

CPHY:PREFerence:CORRection:GAUSsian?

Related Commands CPHY:PREFerence:CORRection:GAUSsian:BANDwidth

Arguments A single <Boolean> value, {0|1}.

0-disables the application of Gaussian filter.

1-enables the application of Gaussian filter.

Returns A single <Boolean> value, {0|1}.

Example CPHY:PREFerence:CORRection:GAUSsian 1 enables the application of
Gaussian filter.

CPHY:PREFerence:CORRection:GAUSsian? returns 1 indicating Gaussian filter
is enabled.
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CPHY:PREFerence:CORRection:GAUSsian:BANDwidth
This command sets and returns the Gaussian bandwidth.

Condition Apply Correction File should be selected.

Group Preferences

Syntax CPHY:PREFerence:CORRection:GAUSsian:BANDwidth <NRf>

CPHY:PREFerence:CORRection:GAUSsian:BANDwidth?

Related Commands CPHY:PREFerence:CORRection:GAUSsian

Arguments A single <NRF> value.

Range: Sample rate /100 to sample rate/2.

Returns A single <NRF> value.

Range: Sample rate /100 to sample rate/2.

Example CPHY:PREFerence:CORRection:GAUSsian:BANDwidth 340E6 sets the
bandwidth to 340 MHz.

CPHY:PREFerence:CORRection:GAUSsian:BANDwidth? returns 340E6 as
bandwidth value.

 Command description

257



CPHY:PREFerence:CORRection:AALL
This command enables or disables the application of correction file of Master
channel one to all channels.

Condition Apply Correction File should be selected.

Group Preferences

Syntax CPHY:PREFerence:CORRection:AALL <bool>

CPHY:PREFerence:CORRection:AALL

Related Commands CPHY:PREFerence:CORRection:MASTer:CHTwo:FILE

Arguments A single Boolean value, {0|1}.

Returns A single Boolean value, {0|1}.

Example CPHY:PREFerence:CORRection:AALL 1 applies correction file of master
channel one to all the channels.

CPHY:PREFerence:CORRection:AALL returns 1 indicating correction file used
in master channel one will be applied to all channels.
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CPHY:LOGView? (Query only)
This command returns the logview contents.

Condition There is a limitation on number of characters (256 characters)

Syntax CPHY:LOGView?

Returns A string value.

Example CPHY:PREF:OUTPut? returns the logview contents.
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Example code to use PI parameter
Example of PI command to create a waveform and assign them to AWG
channels :

Task PI Command
Set Plug-in Module CPHYXpress WPLUgin:ACTIve "CPHYXpress" (This is AWG

PI Command)
Reset Module CPHY:RESEt
Set the Signal Mode CPHY:SIGNal LPHS
Set the HS Base Pattern CPHY:HSPEed:PATTern PRBS7
Set HS Symbol rate CPHY:HSPEed:SRATe 2 
Enable 'Use Line A levels for B and C' CPHY:HSPEed:USELevels 1 
Set LineA voltage Levels CPHY:HSPEed:LINEA:HIGH 300E-3 

CPHY:HSPEed:LINEA:LOW -100E-3 
LP Pattern CPHY:LPOWer:PATTern ULPS
LP Symbol rate CPHY:LPOWer:SRATe 50E6
LP line levels CPHY:LPOWer:LINEA:HIGH 800E-3 

CPHY:LPOWer:LINEA:LOW 0 
CPHY:LPOWer:USELINEA 1 

Set a waveform name CPHY:CSETtings:WAVEform:Name
"NameOfWfm"

Switch to ‘Compile and Assign to’
Assign waveforms to channels

CPHY:CSETtings:COMPile CSENd
CPHY:CSETtings:MASTer:CHONe VA
CPHY:CSETtings:MASTer:CHTWo VB

Enable Slave and configure IP address CPHY:CSETtings:SLAVe:ENABle 1 
CPHY:CSETtings:SLAVe:IPADDress
"134.64.220.21" e.g. Here IP: 134.64.220.21 

Connect Slave CPHY:CSETtings:SLAVe:ISCOnnected 1 
Assign signal to slave Channels CPHY:CSETtings:SLAVe:CHONe VC

CPHY:CSETtings:SLAVe:CHTWo VA
AWG Channel turn on
(Separate for Master & Slave)

OUTPut1:STATE ON
OUTPut2:STATE ON (AWG PI Command)

Compile CPHY:COMPile

Figure 17: Expected wfm file
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